UNIGYR VISONIK

PC Software

Insight

Version 04.60

Operating Handbook

Order No.: CM2B8523E
Author: A. Gisler, 5542
Translated by J. Merton/E. Gottschalk
To this edition

This edition of the "UNIGYR-VISONIK Insight" Operating Handbook contains pages having two different designations:
- "October 1995" and
- "March 1995"

The "October 1995" designation is only on the pages listed below; all other pages have a "March 1995" designation.
- The title page
- The entire table of contents
- Pages 38a, 39 and 40 of chapter 3
- Pages 161, 162, 162a and 162b of chapter 11
- The entire index
# Table of Contents

1. About this Document 1
   1.1 Icons 2
   1.2 Entries via the keyboard 3
   1.3 OS/2 Operation 5
   1.4 The remaining chapters in brief 9

2. Insight in Brief 11
   2.1 Possibilities 12
   2.3 Toolbars 13
   2.4 Startup and exit 14
   2.5 Communication 15
   2.5.1 Communication status 15
   2.5.2 Setting up a connection 15
   2.5.3 Breaking a connection 16
   2.5.4 Initialising the modem 17
   2.6 Login and logout 18
   2.6.1 Login 18
   2.6.2 Logout 19
   2.7 Software information 20
   2.8 Overview of the functions 21
   2.9 Macro keys 32
   2.10 Printing 33

3. Picture Display 35
   3.1 Picture selection by address 37
   3.2 Picture selection by number 39
   3.3 Scrolling in the picture catalogue 40
   3.4 Downloading locally saved pictures 40
   3.5 Plant description 40a
   3.6 Updating 41
   3.6.1 Unhiding and marking channels 41
   3.6.2 Activating channels 42
   3.6.3 Changing parameter values 43
3.7    Reaction pictures 44
3.7.1  General 44
3.7.2  Calling up reaction pictures 45
3.7.3  Deleting the reaction pictures 47
3.7.4  Printing the reaction pictures 47
3.8    Editing pictures 47
3.9    Zooming pictures 48
3.10   Printing pictures 49

4.    Point Operation 51
4.1    Selecting the address 53
4.2    Free and fixed modes 54
4.3    Operation 54
4.3.1  Pushbuttons 54
4.3.2  Keyboard 56
4.4    Changing parameter values 56
4.5    TRR display 58
4.6    Printing 59
5. Timeswitch Catalogue 61
  5.1 Downloading a catalogue from an SS or a DCS  63
  5.2 Creating a new catalogue 64
  5.3 Downloading from a local drive 65
  5.4 Saving to SS or DCS 66
  5.5 Saving to a local drive 67
  5.6 The "Timeswitch Catalogue..." window 68
  5.7 Weekday Catalogue (WDC) 73
    5.7.1 Calling up WDC 73
    5.7.2 Exiting from WDC 74
    5.7.3 Types of layout 75
    5.7.4 Identifying days 76
    5.7.5 Marking cell pairs 77
    5.7.6 PRV1: Change defaults 78
    5.7.7 PRV1: Entering times and values 79
    5.7.8 PRV1: Modifying times 81
    5.7.9 BPS: Change defaults 82
    5.7.10 BPS: Entering times and values 82
    5.7.11 BPS: Modifying times 84
    5.7.12 Deleting entries 85
    5.7.13 Copying entries 85
  5.8 Override/Exception Catalogue (OVC/EXC) 86
    5.8.1 Calling up OVC/EXC 86
    5.8.2 Exiting from OVC/EXC 88
    5.8.3 Types of layout 88
    5.8.4 Marking cell pairs 90
    5.8.5 PRV1: Change defaults 91
    5.8.6 PRV1: Entering times and values 91
    5.8.7 PRV1: Modifying times 93
    5.8.8 BPS: Change defaults 94
    5.8.9 BPS: Entering times and values 95
    5.8.10 BPS: Modifying times 97
    5.8.11 Deleting entries 98
  5.9 Special Day Catalogue (SDC) 99
  5.10 Printing 100
# Table of Contents

6. Calendar 101
   6.1 Special Day Calendar 103
   6.2 Downloading catalogues 104
   6.3 Saving catalogues 106
   6.4 The "Calendar" window 107
   6.5 Editing the Calendar 108
   6.6 SDC List 109
   6.7 Printing 111

7. Trend Plot 113
   7.1 Loading a Trend Set from the DCS 115
   7.2 Loading a locally saved trend set 115
   7.3 Saving a trend set locally 116
   7.4 Saving a graph locally 117
   7.5 Loading a local graph 117
   7.6 Saving trend plots to export files 118
   7.7 Operations in the trend plot window 120
      7.7.1 Stopping/Activating 121
      7.7.2 Zooming in/Unzooming out 122
      7.7.3 Snapshot 123
   7.8 Settings 124
      7.8.1 Displaying the graph 124
      7.8.2 Point setup 125
   7.9 Printing 128

8. Data Processing 129
   8.1 Downloading graphs from the DCS 131
   8.2 Locally downloaded graphs 134
   8.3 Modifying graphs 134
   8.4 Saving graphs 135
   8.5 Printing graphs 136
   8.6 Tables 136
   8.7 Settings 138
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.</td>
<td>Alarm Operation</td>
<td>141</td>
</tr>
<tr>
<td>9.1</td>
<td>Alarm updating</td>
<td>143</td>
</tr>
<tr>
<td>9.2</td>
<td>Selection</td>
<td>146</td>
</tr>
<tr>
<td>9.3</td>
<td>Sorting</td>
<td>147</td>
</tr>
<tr>
<td>9.4</td>
<td>Acknowledgments</td>
<td>148</td>
</tr>
<tr>
<td>9.5</td>
<td>Printing the alarm list</td>
<td>149</td>
</tr>
<tr>
<td>9.6</td>
<td>Point information</td>
<td>150</td>
</tr>
<tr>
<td>9.7</td>
<td>Alarm statistics</td>
<td>151</td>
</tr>
<tr>
<td>10.</td>
<td>Navigation</td>
<td>153</td>
</tr>
<tr>
<td>10.1</td>
<td>Preparing Navigation</td>
<td>154</td>
</tr>
<tr>
<td>10.2</td>
<td>Initiating Navigation</td>
<td>155</td>
</tr>
<tr>
<td>10.3</td>
<td>Destination Function</td>
<td>155</td>
</tr>
<tr>
<td>11.</td>
<td>Picture Editor</td>
<td>157</td>
</tr>
<tr>
<td>11.1</td>
<td>Overview</td>
<td>158</td>
</tr>
<tr>
<td>11.2</td>
<td>Function keys</td>
<td>160</td>
</tr>
<tr>
<td>11.3</td>
<td>Operations on pictures</td>
<td>163</td>
</tr>
<tr>
<td>11.3.1</td>
<td>Loading the picture from the DCS</td>
<td>163</td>
</tr>
<tr>
<td>11.3.2</td>
<td>Loading the locally saved picture</td>
<td>164</td>
</tr>
<tr>
<td>11.3.3</td>
<td>Saving pictures to the DCS</td>
<td>165</td>
</tr>
<tr>
<td>11.3.4</td>
<td>Saving a picture locally</td>
<td>166</td>
</tr>
<tr>
<td>11.3.5</td>
<td>Copying a picture</td>
<td>167</td>
</tr>
<tr>
<td>11.3.6</td>
<td>Deleting a picture</td>
<td>168</td>
</tr>
<tr>
<td>11.3.7</td>
<td>Printing</td>
<td>168</td>
</tr>
<tr>
<td>11.3.8</td>
<td>Create plant description</td>
<td>168a</td>
</tr>
<tr>
<td>11.4</td>
<td>Drawing</td>
<td>168</td>
</tr>
<tr>
<td>11.4.1</td>
<td>Drawing a straight line</td>
<td>169</td>
</tr>
<tr>
<td>11.4.2</td>
<td>Polyline (&quot;Open polygon&quot;)</td>
<td>170</td>
</tr>
<tr>
<td>11.4.3</td>
<td>Polygon</td>
<td>170</td>
</tr>
<tr>
<td>11.4.4</td>
<td>Rectangle</td>
<td>171</td>
</tr>
<tr>
<td>11.4.5</td>
<td>Rounded rectangle</td>
<td>171</td>
</tr>
<tr>
<td>11.4.6</td>
<td>Circle/Ellipse</td>
<td>172</td>
</tr>
<tr>
<td>11.4.7</td>
<td>Text</td>
<td>172</td>
</tr>
<tr>
<td>11.4.8</td>
<td>Arc/Sector</td>
<td>174</td>
</tr>
<tr>
<td>11.4.9</td>
<td>Clock (conversion from circle)</td>
<td>174</td>
</tr>
<tr>
<td>11.4.10</td>
<td>Bar</td>
<td>175</td>
</tr>
<tr>
<td>11.4.11</td>
<td>Marker</td>
<td>176</td>
</tr>
<tr>
<td>11.4.12</td>
<td>Button</td>
<td>176</td>
</tr>
<tr>
<td>11.5</td>
<td>Operations on figures</td>
<td>177</td>
</tr>
<tr>
<td>11.5.1</td>
<td>Marking a single graphic figure</td>
<td>177</td>
</tr>
<tr>
<td>11.5.2</td>
<td>Marking with the marking box</td>
<td>178</td>
</tr>
</tbody>
</table>
### 11.5.3 Marking with the <Shift> key 180
### 11.5.4 Marking all figures 181
### 11.5.5 Combining figures 181
### 11.5.6 Breaking apart 181
### 11.5.7 Superimposing 182
### 11.5.8 Line width selection 182
### 11.5.9 Colour selection 183
### 11.5.10 Cutting (Deleting) figures 185
### 11.5.11 Copying figures 185
### 11.5.12 Pasting figures 185
### 11.5.13 Moving graphic figures 186
### 11.5.14 Enlarging and shrinking figures 186
### 11.5.15 Compressing and expanding figures 187
### 11.5.16 Hiding and unhiding figures 188
### 11.5.17 Centering and alignment of figures 188
### 11.5.18 Mirror-imaging (Flipping) figures 189
### 11.5.19 Rotating figures 190

### 11.6 Auxiliary Tools 191
### 11.6.1 Sample box 191
### 11.6.2 Zooming in a section of a picture 192
### 11.6.3 Zooming out 193
### 11.6.4 Expansion/Compression/Moving of a picture 193
### 11.6.5 Snap mode 193
### 11.6.6 Grid lines 194
### 11.6.7 Coordinates display 195
### 11.6.8 Clearing the screen 195
### 11.6.9 Indicating the picture size 196
### 11.6.10 Selecting the screen colour 196
### 11.6.11 White - Black inversion 197
### 11.6.12 Redrawing 197
11.7 Symbols 198
11.7.1 Changing to the symbol library 199
11.7.2 Changing libraries 200
11.7.3 Scrolling in a library 200
11.7.4 Exiting from the library 200
11.7.5 Defining a symbol 201
11.7.6 Removing a symbol 202
11.7.7 Assigning a symbol name 203
11.7.8 Using a symbol 204
11.7.9 Multi-symbol 204
11.7.10 Breaking a connection 205
11.7.11 Changing symbols 205
11.7.12 Numbering 206
11.7.13 Loading the library 207
11.7.14 Saving the library 207

11.8 Updating 208
11.8.1 Channel display 208
11.8.2 Assigning channel numbers 209
11.8.3 Updating supplementary texts 210
11.8.4 Language-dependent Text/Operator Name 210
11.8.5 Macro/CB task/Support Picture 211
11.8.6 Bars/Markers 211
11.8.7 Colour 212
11.8.8 Changing symbols 213

12. Additional Functions 215
12.1 Dialogue (Ctrl P) 216
12.2 Messages 217
12.3 DILO 219

13. Appendix: Hardware and Software 221
13.1 Units 222
13.2 The Sentinel 222
13.3 Software 223
13.4 Cabling 224
13.4.1 Direct connection 224
13.4.2 Modem connection 225
<table>
<thead>
<tr>
<th>Section</th>
<th>Subsection</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.</td>
<td>Appendix: Installation</td>
<td>227</td>
</tr>
<tr>
<td>14.1</td>
<td>Software Installation</td>
<td>228</td>
</tr>
<tr>
<td>14.1.1</td>
<td>Prerequisites:</td>
<td>228</td>
</tr>
<tr>
<td>14.1.2</td>
<td>Making a backup copy</td>
<td>228</td>
</tr>
<tr>
<td>14.1.3</td>
<td>Deleting the old Insight version</td>
<td>228</td>
</tr>
<tr>
<td>14.1.4</td>
<td>Installing Insight</td>
<td>229</td>
</tr>
<tr>
<td>14.2</td>
<td>Configuration Data Take Over</td>
<td>230</td>
</tr>
<tr>
<td>14.3</td>
<td>VISONIK network</td>
<td>231</td>
</tr>
<tr>
<td>14.4</td>
<td>Startup</td>
<td>231</td>
</tr>
<tr>
<td>14.5</td>
<td>Choice of language</td>
<td>231</td>
</tr>
<tr>
<td>14.6</td>
<td>Choice of character set</td>
<td>232</td>
</tr>
<tr>
<td>14.7</td>
<td>Warning beep</td>
<td>235</td>
</tr>
<tr>
<td>14.8</td>
<td>Colour conversion</td>
<td>236</td>
</tr>
<tr>
<td>14.9</td>
<td>Background setup</td>
<td>236</td>
</tr>
<tr>
<td>14.10</td>
<td>Automatic loading of a picture when starting Insight</td>
<td>236</td>
</tr>
<tr>
<td>15.</td>
<td>Appendix: Printer Installation and Settings</td>
<td>237</td>
</tr>
<tr>
<td>15.1</td>
<td>Printer installation</td>
<td>238</td>
</tr>
<tr>
<td>15.2</td>
<td>Printer Settings</td>
<td>239</td>
</tr>
<tr>
<td>15.2.1</td>
<td>Changing the default printer</td>
<td>239</td>
</tr>
<tr>
<td>15.2.2</td>
<td>Changing the printer settings</td>
<td>240</td>
</tr>
<tr>
<td>16.</td>
<td>Appendix: Communication Configuration</td>
<td>243</td>
</tr>
<tr>
<td>16.1</td>
<td>Configuring a direct connection</td>
<td>244</td>
</tr>
<tr>
<td>16.2</td>
<td>Configuring a modem connection</td>
<td>248</td>
</tr>
<tr>
<td>16.3</td>
<td>Communications status</td>
<td>252</td>
</tr>
<tr>
<td>17.</td>
<td>Appendix: Translation Tools</td>
<td>255</td>
</tr>
<tr>
<td>17.1</td>
<td>Translation tool &quot;EDIVMC&quot;</td>
<td>256</td>
</tr>
<tr>
<td>17.1.1</td>
<td>Creating new language files</td>
<td>256</td>
</tr>
<tr>
<td>17.1.2</td>
<td>Correcting language files</td>
<td>257</td>
</tr>
<tr>
<td>17.1.3</td>
<td>Starting the translation program</td>
<td>257</td>
</tr>
<tr>
<td>17.1.4</td>
<td>Translating</td>
<td>259</td>
</tr>
<tr>
<td>17.1.5</td>
<td>Commands</td>
<td>259</td>
</tr>
<tr>
<td>17.2</td>
<td>Text comparison tool UPDVMC</td>
<td>261</td>
</tr>
<tr>
<td>17.3</td>
<td>Text output tool OUTTEXT</td>
<td>262</td>
</tr>
<tr>
<td>Chapter</td>
<td>Appendix:</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>18</td>
<td>List of Symbols</td>
<td>263</td>
</tr>
<tr>
<td></td>
<td>DIN Symbols</td>
<td>264</td>
</tr>
<tr>
<td></td>
<td>L&amp;G Symbols</td>
<td>268</td>
</tr>
<tr>
<td></td>
<td>ISC Symbols</td>
<td>269</td>
</tr>
<tr>
<td>19</td>
<td>Insight System Messages</td>
<td>275</td>
</tr>
<tr>
<td></td>
<td>Communication</td>
<td>276</td>
</tr>
<tr>
<td></td>
<td>Status texts</td>
<td>276</td>
</tr>
<tr>
<td></td>
<td>Fault messages</td>
<td>277</td>
</tr>
<tr>
<td></td>
<td>Error messages relating to functions</td>
<td>281</td>
</tr>
<tr>
<td></td>
<td>Picture Editor</td>
<td>281</td>
</tr>
<tr>
<td></td>
<td>Data processing</td>
<td>281</td>
</tr>
<tr>
<td></td>
<td>Dialogue/Messages</td>
<td>282</td>
</tr>
<tr>
<td></td>
<td>Point Operation</td>
<td>283</td>
</tr>
<tr>
<td></td>
<td>Timeswitch Catalogue/Calendar</td>
<td>283</td>
</tr>
<tr>
<td></td>
<td>General error messages</td>
<td>284</td>
</tr>
<tr>
<td>20</td>
<td>Index</td>
<td>285</td>
</tr>
</tbody>
</table>
1. About this Document
1.1 Icons

A short description of the meanings of the icons used in this handbook follows.

**Function or Chapter Icons:**
Function icons pertinent to a chapter, appear maximized on the title page of the chapter, and additionally (minimized) in the headers of the respective pages. See also under "The remaining chapters in brief" at the end of this chapter.

**Indicative icons:**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Important guidelines, the disregard of which can detrimentally affect the configuration data.</td>
</tr>
<tr>
<td>🔄</td>
<td>Information, which furthers the proper and efficient use of &quot;UNIGYR-VISONIK Insight.&quot;</td>
</tr>
<tr>
<td>🤔</td>
<td>A problem could possibly arise at this point; help in solving it is offered here.</td>
</tr>
<tr>
<td>🌐</td>
<td>Additional information which is useful but not obligatory for the correct implementation of an action. (Background information)</td>
</tr>
<tr>
<td>✈</td>
<td>Start of an important operation, start of a function.</td>
</tr>
<tr>
<td>⏽</td>
<td>Exit from a function.</td>
</tr>
<tr>
<td>🍋</td>
<td>A procedure is explained in more detail with the aid of an example.</td>
</tr>
<tr>
<td>🎰</td>
<td>Special attention drawn to operation with the keyboard.</td>
</tr>
</tbody>
</table>
Special attention drawn to operation with the mouse.

**Icons included in the text which symbolize operations:**
(All mouse symbols are based on the OS/2 setup for right-handed users: Left-hand mouse key = mouse key 1, right-hand mouse key = mouse key 2)

Symbol: 

**Directive:**

- Click **once** on the **left** button.
- Click **twice** on the **left** button.
- Press the **left** button and **keep it pressed**.
- **Release** the **left** button.

### 1.2 Entries via the keyboard

**Special keys:** Special keys are signified in their **English-language** versions, viz.

- `<Shift>` = `<Umschalt>`
- `<Enter>` = `<Eingabe>`
- `<Ctrl>` = `<Strg>`
- `<Del>` = `<Lösch>`
- `<Insert>` = `<Einf>`
- `<Space>` = `<Leer>`
- `<Back Space>` = `<Zurück>`

**Keyboard formats:** Keys or key combinations are always placed between pointed brackets: `< >`

Texts or values are always placed between inverted commas: "This is text"
Press key "A":
\(<A>\)

Press keys "Ctrl" and "A" simultaneously:
\(<\text{Ctrl} \text{ A}>\)

Hold down key "Alt" and press key "X":
\(<\text{Alt} \text{ X}>\)

First press keys "Alt" and "P" simultaneously, then press key "X":
\(<\text{Alt} \text{ P} \text{ X}>\)

First type the text "Heat," then confirm with the "Enter" key:
"\text{Heat} \ <\text{Enter}>"

**Path entries:**

Paths are frequently given in explanations or examples in this document. These are always either in the Insight Program Directory or their sub-directories.

The program directory (or main directory) can be selected as desired during installation e.g.:
E:\ZGLT\VISONIK\INS460

In the following documentation you will find for these, depending on the situation, the following notation:
E:\...\UVI or e.g., ...\UVI
E:\...\UVI\PTF or e.g., ...\UVI\PTF
1.3 OS/2 Operation

Preliminary remark: Please note that a working knowledge of version 2.x of the OS/2 workplace shell is a prerequisite for working with the information given here.

OS/2 screen copies: The copies of the screens reproduced in this document are based on the English version of OS/2.

Notes on operation: Some examples below show how operations in OS/2 compatible windows (Version 2.x) will be described.

Later, detailed notes on operation will only be given in exceptional cases.

Actuating a "Pushbutton."

Depiction: [OK]

For mouse operation: Click left at the "OK" pushbutton
For keyboard operation: Mark the OK pushbutton with the arrow keys, then <Enter>

Selecting the "Language 2" element from the list.

Depiction: Select "Language 2"

For mouse operation: Double-click at "Language 2"
For keyboard operation: Mark "Language 2" with the arrow keys, then <Enter>
Starting the "UNIGYR-VISONIK Insight" program after booting the systems.

Depiction:

OS/2 screen
Open "UNIGYR-VISONIK" Insight object
Start "UNIGYR-VISONIK Insight" program
➡ "UNIGYR-VISONIK Insight" window

This means:

Line 1: The point of departure is the OS/2 screen (below is a screen copy of a section):

This means:

Line 2: Open the object "UNIGYR-VISONIK Insight":
- Mouse:
  Double-click at "UNIGYR-VISONIK"
- Keyboard:
  Mark "UNIGYR-VISONIK" with the arrow keys, then <Enter>.

The "UNIGYR-VISONIK Insight" window is opened.

Line 3: Start the "UNIGYR-VISONIK Insight" program:
- Mouse:
  Double-click (left) at "UNIGYR-VISONIK Insight"
- Keyboard:
  Mark "UNIGYR-VISONIK Insight" with the arrow keys, then <Enter>

Line 4: The "UNIGYR-VISONIK Insight" program window is opened.
Starting the Timeswitch Catalogue

Depiction:

"UNIGYR-VISONIK Insight" window
Select "Function"
Start "Timeswitch Catalogue"
⇒ "Timeswitch Catalogue" window

This means:

Line 1: The point of departure is the opened "UNIGYR-VISONIK Insight" window.

Line 2: Select "Function" in the action bar.

- Mouse: Click at "Function."
- Keyboard: <Alt F>

Line 3: In the opened action pull-down menu, start the "Timeswitch Catalogue."

- Mouse: Click at "Timeswitch Catalogue"
- Keyboard: <Z>

Line 4: The function window "Timeswitch Catalogue" is opened.
Make entries in the input window "Time and Value."

Depiction: Make appropriate entries in the input fields "Start Time," "Stop Time" and "Value" (Ex.): "10:00" "18:15" "50" [OK]

Meaning: The desired values must be entered into the three above mentioned input fields, the sequence being unimportant.

Selecting the desired field:
- Mouse: Click (left) at the respective field.
- Keyboard: Place cursor at the desired field <↓ or ↑>

Confirm: Confirm only after both entries have been made:
- Mouse: [OK]
- Keyboard: <Enter>

Break:
- Mouse: [Break]
- Keyboard: Go with <TAB> to [OK], then <→> <Enter>

1.4 The remaining chapters in brief

Below is a brief information about the contents of the remaining chapters and, where necessary, indications as to
whom they would mainly concern.

Chapter 2 --- Insight in brief
- Possibilities offered by "UNIGYR-VISONIK Insight"
- Startup and exit
- Setting up connection to a DCS.
- Login and logout
- Short overview of all functions.

Chapters 3 to 12 --- Function descriptions
Detailed descriptions of all UNIGYR-VISONIK Insight functions.

Chapter 13 --- Appendix: Hardware and Software:
(for the System Manager)
Description of the hardware and software required for "UNIGYR-VISONIK Insight":
- PCs and screens
- RAM and hard disk requirements
- Application-protection plug ("Sentinel")
- Software requirements
- Cable

Chapter 14 --- Appendix: Installation
(For the System Manager)
Installation of "UNIGYR-VISONIK Insight," and additionally:
- Choice of language
- Choice of character set
- Setting the warning beep
- Selecting "Colour Conversion"
- Choice of background colour
- VISONIK in the network

Chapter 15 --- Appendix: Printer installation and setup
(for the System Manager)

Chapter 16 --- Appendix: Communication Configuration
(for the System Manager)
Chapter 17 --- Appendix: Translation Tools
(for the System Manager)
Detailed description of how to use the translation tools to translate the system texts.

Chapter 18 --- Appendix: List of symbols
List of the symbols in the "DIN," "L&G" and "ISC" libraries.

Chapter 19 --- Appendix: Insight System Messages

Chapter 20 --- Appendix: Index
2. Insight in Brief
2.1 Possibilities

The abbreviation **DCS** is used in this handbook in place of the often-used terms "Data Communication Server," Communication Server," "VISONIK Computer," etc..

Many new parameter names were newly defined in version V12 of the DCS software. (Exact information can be found in the "Point Types and Parameters" handbook.) You can still use the old parameter names, however. For simplicity’s sake, we will use the old names exclusively in this handbook.

All functions of the VISONIK system are available on one unit, with full-graph workspace and mouse or keyboard operation under the Multitasking Operating System OS/2:

- Full-graph picture editor for drawing plant layout diagrams.
- Setting up connections (= updating channels) between graphic figures in pictures and plant elements.
- Display of plant pictures.
- Possibility to select support pictures from the plant pictures.
- Displaying current operating values in pictures (switch positions, temperatures, positioning commands, ...).
- Output of commands to plant elements (switching and positioning commands, set values, plant and phase statuses, ...) directly from the pictures.
- Display of messages.
- Convenient display and changing of point parameters with the Point Operation.
- Convenient changing of the times of TRR entries in the Point Operation.
- Display of data processing tables and graphs.
- Dialogue with the DCS (Ctrl/P-Mode).
- Display and processing of the substation timeswitch catalogues (WDC and OVC of EXC).
- Display and processing of the special day catalogues.
- Navigation from function to function: Carrying forward the address currently active in the output function.
Many values to be updated (possibly several Insight PC's in the system) for pictures, point operations and trend plots, as well as high event rates can lead to a temporary overload of the DCS. In such cases, updating of the values can take some time.

In addition, it is also possible that the maximum available number of 400 updating channels per DCS is exhausted. In this case the additional updates cannot executed.

### 2.3 Toolbars

Insight has been furnished with a graphical menu list called a toolbar. You can switch these items on or off. The toolbar allows you to quickly select the most important Insight functions simply by clicking on them.

#### Inserting or removing the toolbar:

- Double click with the right mouse button on the "UNIGYR-VISONIK" window,
- or

```
"UNIGYR-VISONIK Insight" window
Select "Options"
Select "Toolbar"
```

#### Toolbar pushbuttons:

The functions of the pushbutton cover to a great extent the icons listed in the "Overview of the functions" section below.

The following pushbuttons are available (from right to left):

- Logon
- Logout
- Picture Display
- Timeswitch Catalogue
- Calendar
- Point Operation
- Data Processing
- Dialogue
- Alarm Operation
- Trend Plot
- Reaction Pictures
- Messages
- Navigation to Timeswitch Catalogue
- Navigation to Point Operation
- Navigation to Alarm Operation
- Navigation to Trend Plot
- Navigation to Picture Display

### 2.4 Startup and exit

#### OS/2 screen

Open "UNIGYR-VISONIK Insight" object

⇒ "UNIGYR-VISONIK Insight" window

When the connection to the server is completed, the name of the announced user, and the date and time, appear after a short while in the title bar in green, to the right of the window title, e.g.:

17-May-94  14:32

#### "UNIGYR-VISONIK Insight" window

<F3> or

Select "Command"

Select "Exit"
2.5 Communication

The following describes how you can set up or break direct or modem connections with DCS. In case of problems with the communication, the definition of additional connection configurations or the modification of existing connection configurations, please refer to the "Communication Configuration" chapter.

2.5.1 Communication status

To find out the status of the communication, open the relevant icon. A detailed description of the information contained therein is also given in the "Communication Configuration" chapter.

2.5.2 Setting up a connection

A connection with a DCS is set up as follows:

"UNIGYR-VISONIK Insight" window
Select "Communication"
Select "Connect"
➡ "VISONIK Communication Setup" window
Mark the desired computer, then [OK]

A message window gives information about the current status of the connection setup.

As soon as there is connection with the DCS, the date and the time indications in the title bar of the window change from red to green. At the same time, the name of the announced user is displayed.

In the case of a modem connection:
If you do not log in within one minute, the DCS breaks the connection again.

Exiting from and starting "Insight":

Direct connection: If a direct connection existed when the exit was made, it will be set up again automatically at startup.

Modem connection: If a modem connection existed or if a modem had been initialized when exit was made, the associated modem will be initialized again automatically, in both cases, at startup. The original modem connection, however, will not be set up automatically.

2.5.3 Breaking a connection

"UNIGYR-VISONIK Insight" window
Select "Communication"
Select "Cancel"

Caution in case of a modem connection:
If you are not going to work with "Insight" for a long period of time, (but without leaving the program), it is advisable to break a modem connection or else the telephone bill will be unnecessarily taxed (up to the time that the max. connection time has elapsed).

The associated modem will remain initialized, that is, it will be capable of accepting incoming calls.
2.5.4 Initialising the modem

If "Insight" is to be able to accept incoming calls, the modem in question must be initialized without a connection being simultaneously set up:

"UNIGYR-VISONIK Insight" window
Select "Communication"
Select "Setup"
ß "Port" window

Mark the port in question, then
[OK]

➡ "Communication Parameter: COMn" window
[OK]
2.6 Login and logout

2.6.1 Login

"UNIGYR-VISONIK Insight" window
Select "Command"
Select "Login"
➡ "Login" pop-up window

Fill in the two input fields "User Code" and "Password" (the password typed-in characters are not visible), then [OK]

Do not press <Enter> after typing in the user code. This would complete the entry and the unentered password would be interpreted as " ". The changeover from "User Code" to "Password" must therefore be made with <Tab>.

After successful login the name of the user appears in the title bar of the window.

The contents could also be:
"Invalid Password"
"Invalid User Code"
"No Connection with DCS"

Before proceeding further, each of these messages must be confirmed with [OK].
2.6.2 Logout

"UNIGYR-VISONIK Insight" window
Select "Command"
Select "Logout"
⇒ "Logout" pop-up window

If logout must really be made, then:
[OK]

"UNIGYR-VISONIK Insight" functions which do not access to the communication DCS can continue to be used, e.g.:

- Processing locally saved pictures.
- Viewing locally saved data processing graphs or tables.
2.7 Software information

You can obtain information about the "Insight" software version (V 04.60.nn) and the number of the Sentinel which is used as follows:

"UNIGYR-VISONIK Insight" window
Select "Command"
Select "About this Version ..."
⇒ "UNIGYR-VISONIK Insight" information window:

<table>
<thead>
<tr>
<th>UNIGYR-VISONIK Insight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Version: V 04.43.00 Feb 14 1995</td>
</tr>
<tr>
<td>Key serial number: @-1-1311 (4.0/0/0/0)</td>
</tr>
<tr>
<td>Key prog. date: 29-Mar-1993 13:17</td>
</tr>
</tbody>
</table>

Copyright c by Landis & Gyr (Europe) Corp.

8523009

To collapse the field:

anywhere in the information window
2.8 Overview of the functions

Alarm operation

Maximum Number of windows: 2

- Display of the alarm points, with colour coding for the various alarm statuses (active, inactive, unacknowledged, acknowledged).
- Selection and sorting of the alarm points according to different criteria.
- Acknowledgment of the ongoing alarms.
- Output of detailed alarm information and alarm statistics.

"UNIGYR-VISONIK Insight" window
Select "Function"
Start "Alarm Operation"
➡ "Alarm Operation" window

Icon:

"Alarm Operation" window
<F3> or
Select "Command"
Select "Exit"

See detailed description under "Alarm Operation."
Picture Display/Reaction Pictures

Maximum number of windows:
3 for picture display
1 for reaction pictures

- Calling up plant pictures using picture numbers, user addresses or file names.
- Calling up support pictures.
- Scrolling the picture catalogue by number.
- Displaying refreshed parameters.
- Changing parameter values.
- Viewing reaction pictures.
- Printing pictures

"UNIGYR-VISONIK Insight" window
Select "Function"
Start "Picture Display" or "Reaction Pictures"
⇒ "Picture Display" or "Reaction Pictures" window

Icons:

- Picture
- Reaction Picture

"Picture Display" or "Reaction Pictures" window
<F3> or
Select "Command"
Select "Exit"

See detailed description under "Picture Display."
Picture Editor

Maximum number of windows: 2

- Operations with pictures (loading, saving, deleting, copying).
- Editing pictures (redrawing, modifying).
- Entering or updating channels.
- Printing pictures.

"UNIGYR-VISONIK Insight" window
Select "Tool"
Start "Picture Editor"
⇒ "Picture Editor" window

Icon:

"Picture Editor" window
<F3> or
Select "Command"
Select "Exit"

See detailed description under "Picture Editor."
Data processing

Maximum number of windows: 1

- Displaying and printing of graphs defined or locally saved in the communication DCS (DAPP function).
- Saving of called up graphs.
- Listing the value log based on the graphs.

"UNIGYR-VISONIK Insight" window
Select "Function"
Start "Data Processing"
➡ "Data Processing" window

Icon:

See detailed description under "Data Processing."
Dialogue

Maximum number of windows: 1

With a few exceptions, one can work in the Dialogue mode in the same way as on a terminal.

The following functions cannot be carried out in Dialogue mode:
- Data processing (display of graphs)
- Trendplot
- Ctrl/V mode (the Point Operation has a somewhat similar function).

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Dialogue"
⇒ "Dialogue" window

Icon:

"Dialogue" window
<F3> or
Select "Command"
Select "Exit"

See detailed description under "Additional Functions."
Calendar

Maximum number of windows: 2

The "Calendar" function is used to operate the Special Day calendar of the DCS.

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Calendar"
⇒ "Calendar" window

Icon:

"Calendar" window
<F3> or
Select "Command"
Select "Exit"

See detailed description under "Calendar."
Messages

Maximum number of windows: 1

Each message which arrives while the "Messages" window is closed initiates an acoustic warning beep.

The lines in the "Messages" window have different colours:

Red: Incoming error messages with error levels (parameter MPR) higher than or equal to the selected beep threshold.

Green:Acknowledged active error messages.

Blue:
- Incoming error messages with error levels (parameter MPR) lower than the selected beep threshold.
- Outgoing error messages.
- All other messages.

Icon:

The "Messages" function is always active; the corresponding icon is always on the screen.

"UNIGYR-VISONIK Insight" window
Open the "Messages" window (double-click at the icon)
→ "Messages" window

Minimize the "Messages" window

See detailed description under "Additional Functions."
Navigation
One of the following functions can be replaced by another function from the same list, taking with it the currently selected address:

- Picture display
- Reaction pictures (only source function)
- Point operation
- Timeswitch catalogue (only destination function)
- Trendplot
- Alarm operation

See detailed description under "Navigation."
Point Operation

Maximum number of windows: 2

The Point Operation allows for convenient operation of individual VISONIK points. It can also be used to change time entries in the TRR register. The procedure is analogous to the Ctrl/V mode.

"UNIGYR-VISONIK Insight" window
Select "Function"
Start "Point Operation"
➡ "Point Operation" window

Icon:

"Point Operation"
<F3> or
Select Command"
Select "Exit"

If the pop-up window "Select" is open, close it with "Cancel" before exiting.

See detailed description under "Point Operation."
Trend Plot

Maximum number of windows: 3

The Trend Plot function displays process values in on-line operation in graphical form. It is possible to call up locally defined trend sets in the DCS.

Associated export files can be created for further processing in table-calculation or data-bank programs.

Icon:

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Trend Plot"
→ "Trend Plot" window

"Trend Plot" window
<F3> or
Select "File"
Select "Exit"

See detailed description under "Trend Plot."
Timeswitch Catalogue

Maximum number of windows: 2

The "Timeswitch Catalogue" function is used to operate the WDC and OVC or EXC timeswitch catalogues of substations.

New catalogues can be created and existing ones changed. In addition, special days can be displayed. Editing, however, is not possible here; it is only possible in the "Calendar" function.

Icon:

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Timeswitch Catalogue"
⇒ "Timeswitch Catalogue" window

See detailed description under "Timeswitch Catalogue."
2.9 Macro keys

The keys of the numeric key pad listed below can be used to start macros from the TXCM catalogue of the DCS.

The macro keys operate only in the "Dialogue" function.

In addition, two conditions must be fulfilled:
- The parameter TERX in the terminal point $Tn must be set to "ITER&MaKB."
- The "NumLock" key must be pressed.

<table>
<thead>
<tr>
<th>Key</th>
<th>Macro number in the TXCM Catalogue</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;F2&gt;</td>
<td>300</td>
</tr>
<tr>
<td>&lt;F4&gt;</td>
<td>301</td>
</tr>
<tr>
<td>&lt;F5&gt;</td>
<td>302</td>
</tr>
<tr>
<td>&lt;F6&gt;</td>
<td>303</td>
</tr>
<tr>
<td>&lt;F7&gt;</td>
<td>304</td>
</tr>
<tr>
<td>&lt;F8&gt;</td>
<td>305</td>
</tr>
<tr>
<td>&lt;F9&gt;</td>
<td>306</td>
</tr>
<tr>
<td>&lt;F11&gt;</td>
<td>307</td>
</tr>
<tr>
<td>&lt;F12&gt;</td>
<td>308</td>
</tr>
<tr>
<td>&lt;Alt Shift F2&gt;</td>
<td>309</td>
</tr>
<tr>
<td>&lt;Alt Shift F4&gt;</td>
<td>310</td>
</tr>
<tr>
<td>&lt;Alt Shift F5&gt;</td>
<td>311</td>
</tr>
<tr>
<td>&lt;Alt Shift F6&gt;</td>
<td>312</td>
</tr>
<tr>
<td>&lt;Alt Shift F7&gt;</td>
<td>313</td>
</tr>
<tr>
<td>&lt;Alt Shift F8&gt;</td>
<td>314</td>
</tr>
<tr>
<td>&lt;Alt Shift F9&gt;</td>
<td>315</td>
</tr>
<tr>
<td>&lt;Alt Shift F10&gt;</td>
<td>316</td>
</tr>
<tr>
<td>&lt;Alt Shift F11&gt;</td>
<td>317</td>
</tr>
<tr>
<td>&lt;Alt Shift F12&gt;</td>
<td>318</td>
</tr>
</tbody>
</table>
2.10 Printing

In the various "Insight" functions, the possibility often exists of printing out the contents of a window (without frame, title bar, etc.) via an appropriate command.

In addition, you can also use the <Print Screen> button to print out the active window (including frame, title bar, etc.) or the whole "Insight" window.

Print of the currently active window:

- anywhere in the window to be printed

Then <Print Screen>

Print of the whole "Insight" window:

- Button for maximum window size
- Button for restore

Then <Print Screen>
3. Picture Display
The function "Picture Display" is divided into two sub-functions which differ only in the selection of the pictures:

- "Picture Display" window
- "Reaction Pictures" window

The following activities are possible with the "Picture Display" function:

- Calling up pictures according to picture numbers and scrolling the picture catalogue forwards or backwards (only possible in the "Picture Display" windows).
- Calling up pictures according to addresses, with the possibility of searching for a particular plant picture by stepwise entry of addresses (only possible in the "Picture Display" windows).
- Viewing parameter values.
- Changing parameter values (without leaving the picture).
- Calling up support pictures.
- Viewing reaction pictures (only possible in the "Reaction Pictures" windows)

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Picture Display" or "Reaction Pictures"
⇒ "Picture Display" or "Reaction Pictures" window

Icons:
The maximum number of opened windows is:
For Picture Display: 3
For Reaction Pictures: 1

"Picture Display" or "Reaction Pictures" window
<F3> or
Select "Command"
Select "Exit"

Changing the screen colour:
<Ctrl B>
changes the screen colour from white to black and vice versa.

3.1 Picture selection by address

This operation is used to select pictures according to user addresses.

"Picture Display" window
Choose "Select"
Select "Address"
⇒ "Address" input window

Enter a picture address or a part address. (Use the
<BackSpace> and <Delete> keys to edit your entry as required.)

When the desired picture appears:
[Cancel]

The system name, the DCS port and the picture number
appear to the right of the window title, e.g.:
Man: T2 25
Picture selection by "Address" makes it possible to edit an address and thus find a picture with an unknown address:

The picture corresponding to the address currently displayed in the entry field always appears. (An address prompt appears every two seconds.)

After the entry in the input field has been changed, some seconds elapse before the called up picture appears. If the new picture appears immediately, press <Enter>.

**Examples:**

<table>
<thead>
<tr>
<th>Entry</th>
<th>Address of the picture to be displayed (if available)</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>* * * * * * * * * *</td>
</tr>
<tr>
<td>E</td>
<td>e * * * * * * * * *</td>
</tr>
<tr>
<td>E1</td>
<td>e 1 * * * * * * * *</td>
</tr>
<tr>
<td>E1K</td>
<td>e 1 k * * * * * * *</td>
</tr>
<tr>
<td>E1K7</td>
<td>e 1 k 7 * * * * * *</td>
</tr>
</tbody>
</table>

If you do not know the picture address, and you cannot find the picture by using the above "Search Procedure," then listing the picture catalogue in the dialogue window may help:

- **COS, PICT, LADR:** Lists the entire picture catalogue sorted by addresses.
- **COS, PICT, LPIC:** Listout of a section of the picture catalogue, sorted according to picture numbers.
- **COS, UTIC, DIR:** Listout of a section of the picture contents, sorted according to picture numbers.
3.2 Picture selection by number

"Picture Display" window
Choose "Select"
Select "Number"
➡ "Number" input window

Enter picture number:
"45"
Enter the system in case the picture must be fetched from an alien system, e.g.:
"MAN"
[OK]

After the picture has been selected, the system name, the DCS port and the picture number appear to the right of the window title, e.g.:
Man: T2 25

If the picture number is unknown:
[Cancel]
then open the Dialogue window (<Ctrl P>) and list out the picture catalogues.

COS, PICT, LADR: Listout of the entire picture catalogue, sorted according to addresses.
COS, PICT, LPIC: Listout of a section of the picture catalogue, sorted according to picture numbers.
COS, UTIC, DIR: Listout of a section of the picture contents, sorted according to picture numbers.
3.3 Scrolling in the picture catalogue

You can scroll through the picture catalogue of the DCS by number:

Scrolling by one number forwards or backwards:

"Picture Display" window
Choose "Select"
Select "Higher" or "Lower"
or
"Picture Display" window
<Shift →> or <Shift ←>

Example:
The picture currently displayed has the number 27
<Shift →>
⇒ The picture now displayed has the number 28.

Note:
the two aforementioned buttons have a different meaning in the "Reaction Pictures" window.

3.4 Downloading locally saved pictures

Locally saved pictures can be downloaded as follows (only static pictures):

"Picture Display" window
Choose "Select"
Select "Load Local Picture"
"Load Picture" input window

Select drive, directory and file or enter file name, [OK]

The directory and the filename appear next to the window title. E.g.:
"...\UV\PTF\Plant17.PTF"
Default is \"\UVI\PTF\*.PTF.\"

When starting up the function "Load Local Picture," only files with the extension .PTF are displayed. A double click on the drive will display files with other extensions.

### 3.5 Plant Description

You can call up a plant description to system pictures or to local pictures (assuming one exists).

```
"Picture Display" or "Reaction Pictures window
Select "Plant Description"
Select "Load File"
```

A window of the EPM text editor opens along with the relevant picture.

The description cannot be changed in the picture display" or in the "Reaction Pictures" function. You can, however, make changes in the picture editor anytime.
3.6 Updating

The following information also holds for reaction pictures. (See under "Reaction Pictures")

3.6.1 Unhiding and marking channels

**Unhiding channels**

View of all updating channels contained in one picture, with their numbers:

<Ctrl A>

To clear the screen again:

<Ctrl A>

**Marking channels**

Updating channels having the channel type "Fix E/A" in the COS, ACT dialogue, can be marked with a rectangle:

➡ The updating channel concerned is now framed with a marking rectangle.

**Directional keys (← ↑ → ↓):**

The updating channel next in proximity in the appropriate direction is framed with a marking rectangle.

**Initial marking according to picture selection:**

If, in the COS, ACT dialogue, an updating channel under "Cursor Point" has an instruction (right, left, below, above, home, all), the marking jumps to the updating channel concerned when one of these keys is pressed for the first time.
### 3.6.2 Activating channels

When updating channels are activated, the actions provided for in the COS, ACT dialogue are initiated, e.g.:
- Selection of a support picture.
- Changing (or only viewing) parameter values.
- Starting or stopping a DCS task.

#### Updating channel

Mark the updating channel, then

<Enter>

In case, with the selection of a next picture, you have changed to the pictures of a partner system, you cannot change back to the pictures of the initial system using the channel types "Previous Picture" or "Select Picture."

If you make changes in the dialogue window (FSG,AKT) or if an operator on another operating device makes changes on the updating channel, these will become effective in a currently displayed picture in a short time.

The picture has to be newly called up, however, if newly entered channels are to be displayed.
3.6.3 Changing parameter values

Activate the appropriate updating channel ➡ Entry window

![Image of input field]

Enter the desired parameter value in the input field:
"21"
[OK]

The entry window shown above is valid for parameters with value ranges (e.g. ME, PS) and for Bitset parameters (e.g. TERX, INF1).

In the case of parameters with discrete values (e.g. SC, OPMO), a list of possible values is displayed instead of the range information.

It is also possible to enter a new value via this list.

For parameters which cannot be described (e.g. ST), a window appears with the title "Parameter only readable."
3.7 Reaction pictures

3.7.1 General

Icon:

- Reaction pictures are initiated by reactions of the DCS (PRR, TRR, DRR, etc.).

- "Insight" saves all the numbers of the incoming pictures in a picture list. If "Insight" is not switched on, the DCS saves the first ten incoming picture numbers; these are appended to the existing picture list when "Insight" is switched on. In this case, however, further incoming pictures are lost.

- The arrival of additional reaction pictures is signalled acoustically.

- When the "Reaction Pictures" window is open but empty, the first incoming picture is automatically displayed.

- In all other cases the icon shows the number of reaction pictures currently available in the picture list in the bottom part of the "Insight" window.
3.7.2 Calling up reaction pictures

Note that "Insight" saves only the numbers of the reaction pictures.

This means that:
When a reaction picture is displayed, the current status is shown, and not the one existing when the reaction was initiated.

Opening the "Reaction Pictures" window

The "Reaction Pictures" window can be opened as follows:

- "Reaction Pictures" icon
- "UNIGYR VISONIK Insight" window
  Select "Function"
  ➡ Start "Reaction Pictures"

If you open the "Reaction Pictures" window when the picture list is empty, the message "No Pending Picture Available!" appears.

Information in the title bar:
The title bar contains the following information:

- Number of entries in the list:
  Left, e.g.:
  Reaction pictures: 17

- Position of the displayed picture in the list:
  Middle, e.g.:
  6/17

- System, DCS port, picture number:
  Right, e.g.:
  T10 12 (no system network)
  Man: T6 23 (system network, own system)
  PS2: 18 (system network, partner system)

First displayed picture after the "Reaction Pictures" window is opened:

There are two different cases:
- You have already viewed reaction pictures and have not yet canceled the list:
  The reaction picture last displayed is displayed again.
- You have not viewed any more reaction pictures since the last cancel:
  The first incoming reaction picture is displayed.
Displaying the next-in-line reaction picture:

"Reaction Pictures" window
<Shift> or
Choose "Select"
Select "Next Reaction Picture"

If there is no next picture in the list, the following message appears:
"No next picture available."

Displaying the previous (last but one) reaction picture:

"Reaction Pictures" window
<Shift> or
Choose "Select"
Select "Previous Reaction Picture"

With this function you can recall already-viewed reaction pictures.

If there is no older picture in the list, the following message appears:
"No previous picture available."

Viewing the first reaction picture:

"Reaction Pictures" window
<Shift> or
Choose "Select"
Select "First Reaction Picture"

With this function you always proceed to the oldest reaction picture.

If the list is empty, the following message appears:
"No first picture available."

Viewing the last reaction picture:

"Reaction Pictures" window
<Shift →> or
Choose "Select"
Select "Last Reaction Picture"

This function takes you to the newest picture in the list of reaction pictures.

If the list is empty, the message "No last picture available" appears.
3.7.3 Deleting the reaction pictures

"Reaction Pictures" window
<Shift Del> or
Choose "Select"
Select "Delete Picture Reactions"

⇒ "Delete all picture reactions?" window
[OK]

This function deletes the complete list of reaction pictures, both the ones already viewed, as well as the outstanding ones.

3.7.4 Printing the reaction pictures

You can print reaction pictures in the same way as described later (under "Printing Pictures").

In addition, there is the possibility to download incoming picture reactions to the printer automatically.

For this the following condition must be fulfilled in the terminal point $Tn.$

Copy = On

3.8 Editing pictures

The Picture Editor is used to change pictures, copy them, save them on the hard disk of the PC, delete them in the DCS, etc.:

"UNIGYR-VISONIK Insight" window
Select "Tool"
Select "Picture Editor"
⇒ "Picture Editor" window

A detailed description is given under "Picture Editor."
3.9 Zooming pictures

The following information also applies to reaction pictures.

You can zoom in a picture as follows:

<table>
<thead>
<tr>
<th>&quot;Picture Display&quot; or &quot;Reaction Pictures&quot; window</th>
<th>Select &quot;Function&quot;</th>
<th>Select &quot;Zoom&quot;</th>
</tr>
</thead>
</table>

The cursor arrow now appears in the form of crossed double-arrows.

- **Anchor point of the box to be zoomed in**
- **Second corner of the box to be zoomed in**

The selected box section is now expanded in both directions, each independently of the other, such that the whole window is filled.

Several zooming in operations can be carried out consecutively.

A message appears if the zoom in factor is too great.

**Zooming out**

With this function, the original condition is established in one step:

<table>
<thead>
<tr>
<th>&quot;Picture Display&quot; or &quot;Reaction Pictures&quot; window</th>
<th>Select &quot;Function&quot;</th>
<th>Select &quot;Original Size&quot;</th>
</tr>
</thead>
</table>
3.10 Printing pictures

The following information also holds for reaction pictures.

To print the displayed picture, proceed as follows:

"Picture Display" or "Reaction Pictures" window
Select "Function"
Select "Print"

With <Print Screen>, you can download the entire currently active window to the printer.
4. Point Operation
"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Point Operation"
⇒ "Point Operation" window

Icon:

For Point Operation, the maximum number of opened windows is 2

"Point Operation" window
<F3> or
Select "Command"
Select "Exit"

Before exiting, close all open windows such as the "Address" window, for example, or windows with error messages.

The Point Operation offers the following possibilities:
- Viewing and, if permitted, changing the parameter values of any points.
- Viewing and changing the times in the TRR registers.
4.1 Selecting the address

"Point Operation" window
Select "Command"
Select "Address"
⇒ "Address" entry window

When the "Point Operation" mode is entered, the "Address" pop-up window appears automatically.

Enter a technical or user address, e.g.: "E03L301" or "$12'030"

[OK]

If the entered address does not exist, or if the user has no access to the address, the following error message appears:
"Invalid Address"

When an existing address is selected, a window with preliminary information about the chosen point appears.

... ST E01'H3'L0

---

**ST**

**SS**

Air Cond. Congress Hall

<table>
<thead>
<tr>
<th>4</th>
<th>ST</th>
<th>ST Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ALST/Alarm Ackn.Stat.</td>
<td>2=Last Alarm still unacknowledged</td>
</tr>
</tbody>
</table>
4.2 Free and fixed modes

Point operations offers two display modes.

Free Mode: After a point has been selected, Point Operation is in Free mode: Only the main parameters are displayed. The parameter list can be extended by a maximum of 13 parameters with [GOTO].

Fixed mode: Switchover to the Fixed mode is carried out as follows:
- Actuate [Forward] or [Backward]
- [GOTO] "Parameter Group"
- [PAR] within the TRR display

A switchback to the Free mode is only possible after the point has been reselected. In the Fixed mode one page of successive parameters is displayed. It is not possible to group parameters together at will.

4.3 Operation

4.3.1 Pushbuttons

[GOTO] - Appending a particular parameter (only in Free mode) or
- Switching to a parameter group.
- Switching to a page of successive parameters.

[GOTO] ➭ Entry window

8522OC1E
Enter a parameter name, e.g.:
"OSV"
[OK]

or a parameter group:
"MAIN" (Main parameters)
"OPER" (Operating parameters)
"SERV" (Service parameters)
"CONF" (Configuration parameters).
[OK]

If the entered parameter or the group does not exist, the following error message appears:
"Invalid Input"

<table>
<thead>
<tr>
<th>Entering a parameter in Free mode:</th>
<th>The parameter is appended at the end of the list. If the list already contains 13 parameters, the parameter at the very bottom of the list is replaced by the newly selected one.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entering a parameter in Fixed mode:</td>
<td>A jump is made to the page of successive parameters, which then begins with the selected parameter.</td>
</tr>
<tr>
<td></td>
<td>If the parameter is already available on the screen, only the marking jumps there.</td>
</tr>
<tr>
<td>Entering a parameter group:</td>
<td>A jump is made to the start of the entered parameter group and a change is made to the Fixed mode.</td>
</tr>
<tr>
<td>[Forward]</td>
<td>Parameter display: One parameter page forward and change to Fixed mode.</td>
</tr>
<tr>
<td></td>
<td>TRR display: One page of TRR entries forward.</td>
</tr>
<tr>
<td>[Backward]</td>
<td>Parameter display: To the start of the group of main parameters and change to Fixed mode.</td>
</tr>
<tr>
<td></td>
<td>TRR display: Back to the first page of the TRR entries.</td>
</tr>
<tr>
<td>[TRR]</td>
<td>Display of the Time Reaction Register.</td>
</tr>
<tr>
<td>[PAR]</td>
<td>Jump from the display of the Time Reaction Register back to the start of the parameter group &quot;Main Parameters,&quot; and change to Fixed mode.</td>
</tr>
</tbody>
</table>
4.3.2 Keyboard

<Tab>      Switches from one pushbutton to another (e.g. from [Forward] to [Backward] etc.)

<↔>, <↑>, <→>, <↓>  Switches from one parameter to another, or from one TRR line to another.

<Enter>    
- Actuation of a pushbutton.  
- Selection of a parameter in order to change its value.  
- Selection of a TRR entry in order to change the time.

4.4 Changing parameter values

Condition:  
The parameter is in the currently displayed parameter list.

Select the parameter:

With the mouse:          
Parameter

With the keyboard:          
Mark the parameter with <↑> or <↓>, then <Enter>

Differently configured windows now appear, depending on the type of parameter selected.

Undefinable parameters:

Parameter cannot be changed

ALST: (Un,Ac,La,?)

OK

The Undefinable Parameters window shows the possible values which the parameter in question can accept.
Parameters with value ranges, and bitset parameters:

```
PS = 79.7 (-9.22E+18..9.22E+18)
```

Input: 79.7

[OK] [Cancel]

The title bar of the entry window shows the possible entries in brackets after the current value.

Changing the values:

"50"

[OK]

Parameters with discrete values:

```
OPM0 = SS
```

C
Cf
Cfr
Cb
SS
SSE
SSF

[OK] [Cancel]

The selection list shows all possible values. The current value appears in the title bar.

Changing the value Mark the value, then

[OK]
4.5 TRR display

The Time Reaction Register of a parameter of the current point is obtained as follows:

First mark a parameter, then [TRR >]

→ The layout of the Time Reaction Register of the marked parameter is displayed.

If the marked parameter has no entries in the TRR, the register of the parameter with the time first found is automatically displayed.

Changing times: To change the times entered in the TRR (other changes are not possible), proceed as follows:

With the keyboard: Mark the desired lines with the directional keys (colour highlighted), then <Enter>

With the mouse: Desired line

→ Entry window "Time = ...".
Enter new time, e.g.:
"13:30"
[OK]

If an error is made when entering the time, the following error message is displayed:
"Invalid Input (Name, Value)"
[OK]

If you change times in the point operation, the affected line is not automatically chronologically set correctly, rather only when the next callup of the TRR display for this parameter occurs.

If changes are made to a displayed line either by you in another window (point operation or dialogue) or by an operator at another operating device, then updating will occur only upon the next callup of the TRR display.

4.6 Printing

In order to print the contents of the "Point Operation" window (parameters or TRR display), proceed as follows:

"Point Operation" window
Select "Command"
Select "Print"

With <Print Screen> you can download the complete currently active window to the printer.
5. Timeswitch Catalogue
Using the timeswitch catalogue you can edit the Weekday Catalogue (WDC), the PRV1 Override Catalogue (OVC) and the BPS Exception Catalogue (EXC).

It is also possible to view the Special Day Catalogue (SDC), but not to make any changes in it.

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Timeswitch Catalogue"
➡ "Timeswitch Catalogue" window

Icon:

Maximum number of windows for the "Timeswitch Catalogue": 2

"Timeswitch Catalogue" window
<F3> or
Select "Command"
Select "Exit"

If changes had been made in the time program since the last save operation, the following safeguard prompt is displayed:

"Changes will not be saved"

In order to be able to edit the timeswitch catalogue (parameter FILE in the SS point), a file must be defined in the DCS for the substation in question.
5.1 Downloading a catalogue from an SS or a DCS

"Timeswitch Catalogue" window
Select "Command"
Select "Load from SS" or "Load from DCS"
⇒ "Load Timeswitch Catalogue from DCS/SS"
window

The same window appears for both commands.

Address
Technical or user address of a substation, or a point, e.g. "$12" or "$33'040"
System
System name, e.g.: MAN
(No entry must be made here for an in-house system.)

DCS or substation
Regardless of the aforementioned command, there is once more the possibility to decide whether the catalogue should be downloaded from the DCS or from the substation.

Note the following when entering the address:

The whole timeswitch program is always loaded with all the destinations of a substation. However, the display and the possibility of editing depend on the entered address:
Entry of a substation address: The timeswitch catalogue of all the destinations of the substation in question is available for editing.

Entry of a point address: Only the timeswitch catalogue of the destinations of the selected point are available for editing. Substation destinations which are not required are filtered out.

### Meaning of the two loading possibilities "... from DCS" and "... from SS":

**Downloading from the DCS:**
Weekday Catalogues (WDC) and Override Catalogues (OVC) or Exception Catalogues (EXC) are taken from the allocated DCS file of the selected substation and transmitted to "Insight."

**Downloading from a SS:**
Weekday Catalogues (WDC) and Override Catalogues (OVC) or Exception Catalogues (EXC) are first copied from the selected substation into the allocated DCS file, and then transmitted to "Insight."

---

### 5.2 Creating a new catalogue

To create a timeswitch catalogue for a point or a substation for which there is not yet an entry, proceed as follows:

1. **Load the appropriate (empty) catalogue**
   For further information see "Downloading a Catalogue from a SS or DCS"

2. **Enter the necessary destination in the "Timeswitch Catalogue ..." window.**
   For further information see "The Timeswitch Catalogue..." window.

3. **Make the necessary entries in the "Weekday Catalogue" or the "Override/Exception Catalogue"**
   For further information see "PRV1: Enter times and value"
   "BPS: Enter times and value"

4. **Save the Timeswitch Catalogue**
   For further information see "Saving to SS or DCS."
5.3 Downloading from a local drive

"Timeswitch Catalogue" window
Select "Command"
Select "Load from File ..."
➡ "Load Timeswitch Catalogue from File" window

Enter drive, directory and file or enter file name, [OK]

The display in the title bar changes, for example to:
"Timeswitch Catalogue ...\UVI\TSCDAT\PROG12.DAT"

The default is ...\UVI\TSCDAT\*.DAT

When starting the function "Load from File ..." only files with the extension .DAT are displayed at first. A double click on the drive will cause files with other extensions to be displayed.
5.4 Saving to SS or DCS

"Timeswitch Catalogue" window
Select "Command"
Select "Save to SS..." or "Save to Server..."
➡ "Save Timeswitch Catalogue to Server/SS" window

The same window appears for both commands.

Address: Technical or user address of a substation with suitable configuration.

System: System name, e.g.: MAN
(No entry must be made for the in-house system.)

DCS or substation: Regardless of the aforementioned command, there is once more the possibility to decide whether the catalogue should be saved to the DCS or to the substation.
Meaning of the two saving possibilities "... to Server ..." and "... to SS ...":

"... to Server ...":
The catalogues are only copied to the allocated DCS file.

"... to SS ...":
The catalogues are first also copied to the allocated DCS file. Transfer to the substation depends on the type of connection:

SS in the ring: The catalogues are copied immediately to the substation.

SS via modem: The catalogues are copied to the substation with the next connection setup.

5.5 Saving to a local drive

Saving to a local drive enables you to make backup copies of the timeswitch programs of the substations, and to load these if required.

"Timeswitch Catalogue" window
Select "Command"
Select "Save to File ..."
⇒ "Save Timeswitch Catalogue to File" window

Select drive, directory and file or enter file name, [OK]

The default is ...\UVI\TSCDAT\*.DAT

When starting the function "Save to File ...," only files with the extension .DAT are displayed at first. A double click at the drive will cause files with other extensions to be displayed.

When loading a timeswitch program (substation or point address), all destinations of a substation are saved when making a local save, regardless of the address entry.
5.6 The "Timeswitch Catalogue..." window

The central part of the window (in the above example for BPS) constitutes the graphic display of the catalogue entries for the momentarily represented destination.

If the abbreviations "OVC/EXC," "WDC" or "SDC" appear at the left hand border, it means that corresponding entries are available for the currently marked lines in the selection list, or that Special Days have been defined for this substation.

Displaying the Entries: The various entries of a destination are displayed as follows:

- Occupied times (from ... to) in the OVC and in the EXC: filled black bars.
- Single entries (switching indents, from ...) in the EXC: black symbols "♦"
- Bridging times in the EXC: two thin black connecting lines.
- Occupied times (from ... to) in the WDC: filled gray bars.
- Single entries (switching indents, from ...) in the WDC (only for BPS): gray symbols "♦"
- Defined special days: filled gray bars.

The shifting bars below the graph allow shifting the time.
window.

**Time-overlapping entries:**

In the case of conflicting entries in OVC, EXC or WDC, the overlapping parts of the bars and the display of "OVC/EXC" or "WDC" at the left hand edge of the graph are shown in red.

To solve such conflicts, see under "WDC," "OVC" or "EXC."

**Zooming in/zooming out:**

With this function, the length of the time axis can be selected.

"Timeswitch Catalogue ..." window
[ > < ] or [ < > ] or:
Select "Function"
Select "Zoom" or "Unzoom"

**Selecting another destination:**

Select the desired destination in the selection list. The momentarily represented destination is displayed inversely.

**Entering a new PRV1 destination:**

Timeswitch Catalogue ..." window
Select "Function"
Select "New Destination ..."
⇒ "Enter Destination" window

Enter **technical address** in the substation (user addresses are not permitted); if necessary enter with parameter and verify with [OK]:

"$030" for the TSP main parameter
"$030.HIL" for a parameter other than the TSP main parameter.

After a new destination has been entered, the window for the Weekday Catalogue opens automatically.
If you have loaded the timeswitch program by means of a point address (e.g. $12'032), you may only enter additional destinations of this point:

$032.LOL is permitted
$033.LOL is not permitted

Entering a new destination:

"Timeswitch Catalogue ..." window
Select "Function"
Select "New Destination ..."
➡ "Load Destination" window

Enter technical address in the substation (user addresses are not permitted):

"$030" [OK]

After the address has been entered, the "Configuration" window opens automatically.

If you have loaded the time switch program by means of a point address (e.g. $12,032), you may only enter additional destinations of this point:

$032 is permitted
$033 is not permitted

Configure BPS Destination

"Timeswitch Catalogue ..." window
Mark desired destination
Select "Function"
Select "Configuration"
➡ "Configuration" window:
Address: The address of the destination and the associated parameters can be seen here.

Entry type: Select the type of destination here: the default is "compressed" and is valid for operation with Popcards.

Parameters: If you have set the type "freely selectable," then you can enter the desired parameters here.

Default value: Enter the default values here.

The following entries are allowable:
- a numerical value
- DFV
- PDFV
- ADFV
- RDFV
- ZDFV
- VDFV
- .("Don't care")

Cyclic output: Selecting this option causes a value output every minute. Otherwise, the output occurs at the start or stop time (switching indent function).

Destination active: This selects whether the destination should be taken into account or not during the processing of the timeswitch program.
Caution is recommended when changing the configuration of BPS destinations to ensure that no contradictions are generated to existing Popcards. If so, they will become unusable.
Be especially sure not to change the entry type.

**BPS Operating Time Change**

"Timeswitch Catalogue ..." window
Mark the desired destination
[BZV] or
Activate "Functions"
Select "BZV"
⇒ "BZV Operating Time Change" window:

End of operating time: This is the operating time end defined in the relevant entry.

Note:
The current time is only displayed if:
- The timeswitch catalogue was loaded from the substation
- The timeswitch catalogue was in operation during loading

New end of operating time: This is the new operating time end changed by your entry.

8523OM5E
Entry: Enter here the desired lengthening or shortening of the operating time in hours and minutes.

"Active" or "inactive" determines whether the change should be taken into account for the current editing of this entry or for the one following.

Printing the window:

"Timeswitch Catalogue ..." window
Select "Command"
Select "Print"

Selecting the catalogue: The function "Timeswitch Catalogue" permits only the WDC and the OVC or EXC catalogues to be edited. The SDC catalogue can only be viewed.

"Timeswitch Catalogue ..." window
Mark desired destination [WDC], [OVC/EXC] [SDC] or
Select "Function"
Select "WDC," "OVC/EXC" or "SDC"
⇒ Corresponding window

5.7 Weekday Catalogue (WDC)

Icon:

5.7.1 Calling up WDC

"Timeswitch Catalogue ..." window
Mark desired destination [WDC] or
Select "Function"
Select "WDC"
⇒ "WDC: DST...." window

The description of this window follows below under "Types of layout."
Conflicting entries:
If there are conflicting entries in the WDC, a window appears with the information: (Example)
"WDC: $030
Conflict in line 60. Correct with the System Editor."
After confirmation, an OS/2 System Editor window opens automatically.

Title bar (example):
"E.EXE - tscdat\2.tsc"

The conflicting lines are identified by a question mark on the left hand side. Correct the conflict in the file, delete the question mark, and then proceed as follows:

```
"E.EXE - tscdat\2.tsc" window
Select "File"
Select "Save"
Information window "Save under ..."
```

[Type...] Select "Text File" in the selection window which now appears, then

[Set]

Close the "E.EXE - tmpdat\2.tsc" window and call up "WDC" again.

At this point at the latest, the window mentioned further above appears.

The changes are inserted into the graph only after a change of destination.

5.7.2 Exiting from WDC

```
"WDC:DST..." window
<F3> or
Select "Command"
Select "Exit"
```

On exiting, all the changes made in the WDC are inserted into the graphic layout of the catalogue entries.
5.7.3 Types of layout

There are two types of layout; it is possible to change from one to the other at any time.

- "Time layout"
- "Entry layout"
  This is the default layout which appears automatically when "WDC" is called up.

"WDC:DST..." window
Select "Layout"
Select "Entry Layout" or "Time Layout"

Entry layout:
In the entry layout it is possible to enter new WDC entries, to copy, or to delete.

Note that a maximum of 30 lines is possible.

<table>
<thead>
<tr>
<th></th>
<th>File</th>
<th>Entry</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>all</td>
<td>MO</td>
<td>TU</td>
<td>WE</td>
</tr>
<tr>
<td>1</td>
<td>06:30</td>
<td>06:30</td>
<td>06:30</td>
</tr>
</tbody>
</table>

The column at the far left (under "All") contains the numbers of the entries in serial order.

The cells under the weekdays and special days (scroll to the right) contain the time entries with the pertinent values (for BPS, the value of the first parameter).
Time layout: No new WDC values can be entered in the time layout. On the other hand it is possible to change existing entries, to copy, or to delete.

The column at the far left (under "All") contains all times in the table in chronological order.

The cells under the weekdays and special days (scroll to the right) contain the pertinent values (for BPS, the value of the first parameter).

Notation
- default values are displayed in brackets.
- A red exclamation point (only for BPS) indicates that the affected line in the process station has the "OutOfService" mark.
  Do not confuse this with an inactive destination.

5.7.4 Identifying days

In case a particular combination of days is needed frequently (e.g. Monday to Friday, or Saturday, Sunday and Special Day 1), these days can be "identified":

When an entry or time field (under "All") is clicked, all the identified days will, henceforth, always be marked together.
Procedure: For the first identified day:

EDURE: at the box in the field with the day title.

For the remaining days:

<Shift> and simultaneously:

at the box in the field with the day title.

➡ The boxes for the identified days now become blue.

Removing the identification:

<Shift> and simultaneously click in the box.

5.7.5 Marking cell pairs

It is only possible to mark cell pairs (always one cell for the beginning and one for the end of an entry). Markings are necessary in order to:

- Generate new entries.
- Copy contents.
- Delete contents.
- Change entries.

Single cell pair: at a cell of the pair

or with the keyboard:
Use the directional keys to move the thin marking box to a cell of the pair, then <Space>

➡ The cell background becomes grey.

The cell pairs of all identified days of a line:

at the time or entry number (under "All")

or with the keyboard:
Use the directional keys to move the thin marking box to a "Time" or "Entry number" field, then <Space>

➡ The backgrounds of all cell pairs of the momentarily identified days of the pertinent lines become grey.
All the cell pairs of a column:

at the Day and Special Day titles

or with the keyboard:
Use the directional keys to move the thin marking box to a field with a Day or Special Day title, then <Space>
⇒ The whole column background becomes grey.

Complete table:

at "All"

or with the keyboard:
Use the directional keys to move the thin marking box to the field "All," then <Space>
⇒ The whole table background becomes grey.

Any combination of cell pairs:

- Mark the first cell pair or the first cell area as described above.
- Press <Shift> and mark other cell pairs or cell areas as described above.

Removing the marking from individual cell pairs:

Press <Shift> and proceed exactly as for marking a cell pair.
The colour(s) of the cell(s) involved become white again.

5.7.6 PRV1: Change defaults

Only one default value can be used for each destination (for WDC and OVC).

This can be changed as follows:

"WDC: DST..." window
Select "Entry"
Select "Default Value"
⇒ "Enter default value" window
The following entries are permitted:
- One numerical value
- DFV
- PDFV
- ADFV
- RDFV
- ZDFV
- VDFV
- . ("Don't care")

Further details are given in the "Operation Handbook PRV1."

5.7.7 PRV1: Entering times and values

No new entries can be made in the time layout; only editing of existing entries is possible.

There are two ways of editing cell pairs:
- Enter the times (start and stop) and values. This option is necessary especially upon the input of new entries.
- Change the time only.

The option “Times and Values” does not function if more than one cell pair is selected simultaneously for the same day.

Procedure:

Method 1: Mark the cell pairs to be edited, then

at any of the marked cells

or with the keyboard:
Use the directional keys to move the thin marking box to a marked cell, then <Enter>

Single cell pair:
The entry window can be opened even faster for a single cell pair:

one cell of the pair
Method 2: Mark the cell pairs to be edited, then

"WDC: DST..." window
Select "Entry"
Select "Times and Values"
➡ "Enter Times and Values" window

Entering a start and stop time as well as a value, e.g.:
"07:15"
"18:30"
"22"

[OK]

A newly-entered value is automatically arranged in
chronologically correct order in the table.

Valid entries for the time parameter:

8     becomes 08:00
8:4    becomes 08:04

For values, only numerical entries and the point for the
default value are allowed.

Appropriate messages appear in the case of incorrect or
conflicting entries.
5.7.8 PRV1: Modifying times

This option does not function if, among the selected cell pairs, there are some belonging to the same day.

The option has no effect on cells without entries.

Mark the cell pairs to be edited, then

"WDC:DST..." window
Select "Entry"
Select "Time Difference ..."
⇒ "Enter Time Difference" window

Enter the time difference(s) in hours and minutes for the start and/or stop time.

Negative values can also be entered.

"1:15" or "+1:15":
08:00 hrs. is changed to 09:15 hrs.

"-0:5":
12:35 hrs. is changed to 12:30 hrs.

"-3":
14:15 hrs. is changed to 11:15 hrs.

The cells with changed times will automatically be arranged in the correct chronological order.

Appropriate messages appear in the case of incorrect or conflicting entries.
5.7.9 BPS: Change defaults

Only one use of a single default value per parameter is possible (for WDC and EXC).

To change this value, proceed as follows:

"Timeswitch Catalogue ..." window
Select "Functions"
Select "Configuration"
➡ "Configuration" window

You can find a more detailed description of this window under "The 'Timeswitch Catalogue... window.'"

The following entries are allowed for default values:
- a numerical value
- DFV
- PDFV
- ADFV
- RDFV
- ZDFV
- VDFV
- . ("Don't care")

You can find more information in the " Operation Handbook BPS".

5.7.10 BPS: Entering times and values

You cannot make any new entries in the "Time" layout; only editing of existing entries is possible.

There are two possibilities available for editing cell pairs:
- Enter times (start and stop) and values. This option is especially needed for the input of new entries.
- Only modify the time.

The times and values option does not function if, for the same day, simultaneously more that one cell pair is selected.
Procedure:

Method 1:
Mark the cell pair to be edited, then

- on one of the selected cells

or with the keyboard:
Use the directional keys to move the thin marking box to a selected cell, then <Enter>

Single cell pair:
The entry window can be opened more quickly for a single cell pair:

- one cell of the pair

Method 2
Mark the cell pair to be edited, then

"WDC:DST..." window
Select "Entry"
Select "Times and Values"
➡ "Enter Times and Values" window:

```
<table>
<thead>
<tr>
<th>Entry</th>
<th>Start time</th>
<th>Stop time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>12:30</td>
<td>19:30</td>
</tr>
</tbody>
</table>
```

Parameter name  | LCM1 | PAR1 | PAR2 | PAR3 | PAR4 |
---|---|---|---|---|---|
Default value   | 3 | 20 | 2 | 1 | 2 |
Value           | 3 | . | . | . | . |

Enter the start and stop times as well as the values for the parameters for this destination, e.g.:

"07:15"
"18:30"
"22" "1" ...

[OK]

A new entry will be automatically chronologically assigned in the table.
Valid entries for the time

8     is changed to 08:00
8:4   is changed to 08:04

Only numerical values and a period are allowed for default values.

Appropriate messages appear in the case of incorrect or conflicting entries.

5.7.11 BPS: Modifying times

This option does not function if, among the selected cell pairs, there are some belonging to the same day.

This option does not affect cells not having an entry.

Mark the cell pairs to be edited and then,

"WDC: DST..." window
Select "Entry"
Select "Time Difference ..."
➡ "Enter Time Difference" window:

Enter the time difference(s) in hours and minutes for the start and/or stop time.

Negative values can also be entered.
"1:15" or "+1:15":
08:00 hrs. is changed to 09:15 hrs.

"-0:5":
12:35 hrs. is changed to 12:30 hrs.

"-3":
14:15 hrs. is changed to 11:15 hrs.

The cells with changed times will automatically be arranged in chronological order.

Appropriate messages appear in the case of incorrect or conflicting entries.

5.7.12 Deleting entries

Select the cells whose contents are to be deleted, then

"WDC: DST ..." window
Select "Entry"
Select "Delete"

After the delete procedure, the table is automatically re-sorted.

5.7.13 Copying entries

There can only be one cell pair source for the copying procedure, i.e. it is not possible to copy whole cell areas.

Variation 1:

Mark the source pair and all cell pairs, then

生态圈 at the Source Pair

⇒ "Enter Time and Value" window

[Enter] (without making changes)
Variation 2: Mark the source pair and all cell pairs, then

"WDC: DST..." window
Select "Entry"
Select "Times and values"
⇒ "Enter Times and values" window

[Enter] (without making changes)

With the keyboard:
Mark the source pair and all destination pairs

Use the directional keys to move the thin marking box to a cell of the source pair, then <Enter>
⇒ “Enter Times and values" window
<Enter> (without making changes)

5.8 **Override/Exception Catalogue (OVC/EXC)**

**Icon:**

![](image)

5.8.1 **Calling up OVC/EXC**

"Timeswitch Catalogue ..." window
Mark the desired destination
[OVC/EXC] or
Select "Function"
Select "OVC/EXC"
⇒ "OVC/EXC: DST..." window

The description of this window follows below under "Types of Layout."
Conflicting entries:
If there are conflicting entries in the OVC, a window appears with the information: (Example)
"OVC: $030
Conflict in line 20. Correct with the
System Editor."

After confirmation, an OS/2 System Editor window opens automatically.
Title bar (example):
"E.EXE - tmpdat\4.tsc"
The conflicting lines are identified by a question mark on the left hand side. Correct the conflict in the file, delete the question mark, and then proceed as follows:

"E.EXE -..." window
Select "File"
Select "Save"
➡ "Save Under" information window:

[Type...] Select "Text File" in the selection window which now appears, then

[Set]
Close the "E.EXE - tmpdat\2.tsc" window and call up "OVC" again.

At this point at the latest, the window mentioned further above appears.

The changes are inserted into the graph only after a change of destination.
5.8.2 Exiting from OVC/EXC

"OVC/EXC: DST..." window
<F3> or
Select "Command"
Select "Exit"

On exiting, all the changes made in the OVC or EXC are inserted into the graphic layout of the catalogue entries.

5.8.3 Types of layout

There are two types of layout, and it is possible to change from one to the other at any time.

- "Time layout"
- "Entry layout"

This is the default layout which appears automatically when "OVC" or "EXC" is called up.

"OVC/EXC: DST..." window
Select "Layout"
Select "Entry Layout" or "Time Layout"

Entry layout:

In the entry layout it is possible to enter new OVC or EXC entries, or to change, copy or delete existing ones.

<table>
<thead>
<tr>
<th>File</th>
<th>Entry</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>all</td>
<td>01.05.1995</td>
<td>28.02.1995</td>
</tr>
<tr>
<td></td>
<td></td>
<td>02.03.1995</td>
</tr>
<tr>
<td></td>
<td></td>
<td>06.04.1995</td>
</tr>
<tr>
<td></td>
<td></td>
<td>04.08.1995</td>
</tr>
</tbody>
</table>

| 1 | 11:00 | 12:00 | 07:00 | 14:00 |
| 2 |      | 2     | 4     | 2     |

| 2 | 16:00 | 20:30 | 20:30 | 18:30 |
| 2 | [3]   | [3]   | [3]   | [3]   |

The column at the far left (under "All") contains the numbers of the entries in serial order.

Note that the maximum number of lines is 30.
PRV1 (OVC): The topmost lines contain, at any given time, a start or a stop date; the lines following hold the associated start or stop times and pertinent values.

BPS (EXC): The topmost lines contain a start or a stop date; the lines following hold the associated start or stop times and pertinent values.

A small black triangle in the right lower field corner indicates that this entry is provided with the "annual" attribute.

Time layout: No new OVC values can be entered in the time layout. On the other hand it is possible to change, copy, or delete existing entries.

<table>
<thead>
<tr>
<th>File</th>
<th>Entry</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>OVC/EXC: DST148</td>
<td>Ground Floor, Meeting Rooms</td>
<td>PLT30.LCM1</td>
</tr>
<tr>
<td>all</td>
<td>01.05.1995</td>
<td>28.02.1995</td>
</tr>
<tr>
<td>07:00</td>
<td>02.03.1995</td>
<td>06.04.1995</td>
</tr>
<tr>
<td>11:00</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>12:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14:00</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

The column at the far left (under "All") contains all times in the table in chronological order.

The topmost lines contain a start and/or a stop date for the cells following with the pertinent values.

Note:
- Default values are displayed in brackets.
- A red exclamation point before a time (only for BPS) indicates that the affected line in the process station has been provided with the "OutOfService" mark. Do not confuse this with an inactive destination.
5.8.4 Marking cell pairs

It is only possible to mark cell pairs (always one cell for the beginning and one for the end of an entry). Markings are necessary in order to:

- Generate new entries.
- Copy contents.
- Delete contents.
- Change entries.

**Single cell pair:**

![at desired cell pair](image)

or with the keyboard:

Use the directional keys to move the thin marking box to a cell of the pair, then `<Space>`

⇒ The cell background becomes grey.

**All the cell pairs of a line:**

![at entry number or time](image)

or with the keyboard:

Use the directional keys to move the thin marking box to a "Time" or "Entry number" field, then `<Space>`

⇒ All the pertinent cell pairs are marked.

**All the cell pairs of a column:**

![at the date](image)

or with the keyboard:

Use the directional keys to move the thin marking box to a date field, then `<Space>`

⇒ The backgrounds of all cells concerned become grey.

**Complete table:**

![at "All"](image)

or with the keyboard:

Use the directional keys to move the thin marking box to the field "All," then `<Space>`

⇒ The whole table background becomes grey.
Any combination of cell pairs:
- Mark the first cell pair or the first cell area as described above.
- Press <Shift> and mark other cell pairs or cell areas as described above.

Removing the marking from individual cell pairs:
Press <Shift> and proceed exactly as for marking.
The colour(s) of the cell(s) involved become white again.

5.8.5 PRV1: Change defaults

Only one default value can be used for each destination (for WDC and OVC).
You can change these as follows:

"OVC/EXE: DST..." window
Select "Entry"
Select "Default Value"
⇒ "Enter default value" window

The following entries are permitted:
- One numerical value
- DFV
- PDFV
- ADFV
- RDFV
- ZDFV
- VDFV
- . ("Don't care")

Further details are given in the "Operation Handbook PRV1"

5.8.6 PRV1: Entering times and values

You cannot make new entries in the "Time" layout; you can only edit existing entries.

There are two possibilities available for editing cell pairs:
- Enter times (Start and Stop) and values. This option is especially necessary when entering new cell pairs.
- Change the time only.

The times and values option does not function if more than one cell pair is simultaneously selected for the same day.
Procedure:
Method 1:
Mark the cell pair to be edited, then

\[\text{on one of the marked cells}\]

or with the keyboard:
Use the directional keys to move the thin marking box to a marked cell, then <Enter>

**Individual cell pairs:**
The entry window can be opened even faster for single cell pairs:

\[\text{at a cell of the pair}\]

Method 2
Mark the cell pair to be edited, then

"OVC/EXC: DST..." window
Select "Entry"
Select "Times and Values"
➡ "Enter Times and Values" window:

```
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Start date</th>
<th>Start time</th>
<th>Stop date</th>
<th>Stop time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default value</td>
<td>23.02.1995</td>
<td>17:40</td>
<td>26.02.1995</td>
<td>21:00</td>
</tr>
<tr>
<td>Value</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Enter a start and a stop time as well as a value, e.g.:
"07:15"
"18:30"
"22"
[OK]

A newly entered value is automatically positioned at its
chronological location within the table.

Valid entries for the time:
8 is changed to 08:00
8:4 is changed to 08:04
For values, only numerical entries and the point for the default value are allowed.
Appropriate messages appear in the case of incorrect or conflicting entries.

5.8.7 PRV1: Modifying times

This option does not function if, among the selected cell pairs, there are some belonging to the same day.
The option has no effect on cells without entries.

Mark the cell pairs to be edited, then

"OVC/EXC: DST..." window
Select "Entry"
Select "Time Difference ..."

⇒ "Enter Time Difference" window:

Enter the time difference(s) in hours and minutes for the start and/or stop times.

Negative values can also be entered.
"1:15" or "+1:15":
08:00 hrs. is changed to 09:15 hrs.

"-0:5":
12:35 hrs. is changed to 12:30 hrs.

"-3":
14:15 hrs. is changed to 11:15 hrs.

The cells with changed times will automatically be arranged in chronological order.

Appropriate messages appear in the case of incorrect or conflicting entries.

5.8.8 BPS: Change defaults

Only one single default value can be used per parameter and per destination (for WDC and EXC).

Do the following to change the default values:

"Timeswitch Catalogue ..." window
Select "Functions"
Select "Configuration"
➡ "Configuration" window

You can find a more detailed description of this window in the chapter, "The Timeswitch Catalogue... window."

The following entries are allowed for default values:
- a numerical value
- DFV
- PDFV
- ADFV
- RDFV
- ZDFV
- VDFV
- . ("Don't care")

You can find more information in the "BPS Operation Handbook".
5.8.9  BPS: Entering times and values

You cannot make any new entries in the "Time" layout; only editing of existing entries is possible.

There are two possibilities available for editing cell pairs:
- Enter times (start and stop) and values. This option is especially needed for the input of new entries.
- Only modify the time.

The times and values option does not function if, for the same day, simultaneously more than one cell pair is selected.

Procedure:
Method 1: Mark the cell pair to be edited, then

on one of the selected cells

or with the keyboard:
Use the directional keys to move the thin marking box to a selected cell, then <Enter>

Single cell pair:
The entry window can be opened more quickly for a single cell pair:

one cell of the pair
Method 2

Mark the cell pair to be edited, then

"OVC/EXC; DST..."
Select "Entry"
Select "Times and Values"
➞ "Enter Times and Values" window:

![Enter Time and Value Window]

Enter the start and stop times as well as the values for the parameters for this destination, e.g.,:
"07:15"
"18:30"
"22" "1" ...
[OK]

A new entry will be automatically chronologically assigned in the table.
Valid entries for the time
8       wird zu 08:00
8:4     wird zu 08:04

Only numerical values and a period are allowed for default values.

Appropriate messages appear in the case of incorrect or conflicting entries.

Annually
You can specify here whether the entry should be executed in the current year only or repeated annually.

5.8.10 BPS: Modifying times

This option does not function if, among the selected cell pairs, there are some belonging to the same day.

This option does not affect cells not having an entry.

Mark the cell pairs to be edited and then,

"WDC/OVC: DST..." window
Select "Entry"
Select "Time Difference ..."
➡ "Enter Time Difference" window:

Enter the time difference(s) in hours and minutes for the start and/or stop time.

Negative values can also be entered.
"1:15" or "+1:15":
08:00 hrs. is changed to 09:15 hrs.

"-0:5":
12:35 hrs. is changed to 12:30 hrs.

"-3":
14:15 hrs. is changed to 11:15 hrs.

The cells with changed times will automatically be arranged in chronological order.

Appropriate messages appear in the case of incorrect or conflicting entries.

5.8.11 Deleting entries

Mark the cells, then

"OVC/EXC: DST..." window
Select "Entry"
Select "Delete"

After the delete procedure, the table is automatically re-sorted.
5.9 Special Day Catalogue (SDC)

Icon:

In the "Timeswitch Catalogue" you will also be able to observe the currently valid Special Days for the selected substation. Contrary to the "Calendar" function, it is not possible here to make changes in the SDC.

On the other hand, all the defined Special Days appear in a single window:

- Special Days which are individually allocated to the substation.
- Special Days belonging to a particular group which has been allocated to this substation. (SS parameter "SDCL")

**"Timeswitch Catalogue" window**

[SDC] or
Select "Function"
Select "SDC"
⇒ "SDC (Changes Via Calendar Function)" window

**"SDC (read only)" window**

<F3> or
Select "Command"
Select "Exit"

Movements, List

Movements within the "SDC..." window, the command "Print" and the function "List" are the same as those for the "Calendar" function. As such, these actions are not described here; for detailed descriptions see under "Calendar."

Other action than those mentioned above (e.g. "Paste," "Delete") are not possible.
5.10 Printing

In the "Timeswitch Program" function, you can print the contents of the following windows:

- "Timeswitch Catalogue ...
- "WDC ..." (in both layouts)
- "OVC/EXC ..." (in both layouts)
- "SDC ...

Check that the part of the window which is not currently visible is also printed out. For example, in the "WDC ..." window, all the days from Monday till SD7 should be printed.

**Appropriate window**

Select "Command"
Select "Print"

With <Print Screen> you can download the complete currently active window to the printer.
6. Calendar
With the Calendar function, the Special Day Catalogue of the DCS can be edited and distributed for the substations.

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Calendar"
⇒ "Calendar" window

Icon:

The maximum number of windows for the "Calendar" function is 2.

"Calendar" window
<F3> or
Select "Command"
Select "Exit"

If changes had been made in the calendar concerned since the last save, the following safety message appears:
"Changes will not be saved"

In order to define calendars for the substations and to save them in the DCS, a file must be defined (FILE parameter in the SS point) in the DCS for the substation in question.

In addition, it must be decided to which group of Special Day the substation should belong (SDCL parameter in the SS point).
6.1 Special Day Calendar

The Special Day Calendar of the DCS consists of 7 Standard Calendars and Individual or Exceptional Calendars:

**Standard Calendars** (Calendar Groups). Each substation can take into account the Special Days of one of the 7 Standard Calendars. (Determination based on the SDCL parameter of the SS.)

Example:
SDCL Parameter of SS 12 = 5
This means:
SS 12 takes over the Special Days of Calendar Group 5.

**Individual Calendars** (Exceptional Calendars). They are valid only for particular substations.

Example:
The Individual Calendar $12 is reserved exclusively for SS 12.

**Distributing the calendars:** The distribution of the Special Days to DCS files allocated to the substations, and simultaneously to the substations, is undertaken by the DCS operation "CAL,SDC,SEND."

There are two different situations:

**Distributing a combination of calendar groups:**
Example for SS 12 with SDCL=5:
Calendar groups 2 and 5 are distributed.
In this case SS 12 receives the Special Days of the Group 2 and additionally those of its individual catalogue $12.

**Distributing an individual catalogue.**
Example for SS 12 with SDCL=5.
The individual catalogue $12 is distributed.
In this case, SS 12 receives the Special Days of its individual catalogue and additionally those of the Standard Group 5.
6.2 Downloading catalogues

Loading from the DCS:

"Calendar" window
Select "Command"
Select "Load from DCS"
⇒ "Load Calendar from DCS/SS" window

Inputs:
Substation or Calendar Group
For calendar type = Exception (see below), a technical or user address of a substation, e.g. "$12" must be entered.
For calendar type = Standard (see below), a Calendar Group, e.g. "6" must be entered.
System
Systemname, e.g.: MAN
(For the in-house system, no entry must be made here.)
Type of calendar
See above, under "Substation" or "Calendar Group."

Change the window title to:
"Calendar 2" or "Calendar $12"
Loading the local calendar:

"Calendar" window
Select "Command"
Select "Load from File"
→ "Load Calendar from File" window

Select drive, directory and file or enter filename, [OK]

The display in the title bar changes, for example, to:
"Calendar ...\\UVI\CALDAT\PROG12.DAT"

The default is ...\\UVI\CALDAT\*.DAT.

When the function "Load from File" is started, at first only files with the extension .DAT are shown. A double click on the drive causes files with other extensions also to be plotted.

Creating a new (empty) catalogue

"Calendar" window
Select "Command"
Select "New"

The window title changes to:
"Calendar ...\\UVI\CALDAT\Neu.dat" and the window now contains an empty calendar which can be processed.
6.3 Saving catalogues

Saving to the DCS:

"Calendar" window
Select "Command"
Select "Save to DCS"
➡ "Save Calendar .... to DCS/SS" window

Entries:

Substation or calendar group
For calendar type = Exception (see below) a technical or user address of a substation, e.g. "$12" must be entered.
For calendar type = Standard (see below) a Calendar Group, e.g. "6" must be entered.

System
Systemname, e.g.: MAN
(For the in-house system, no entry must be made here.)

Type of calendar
See above, under "Substation" or "Calendar Group."

Distribution
This option must be selected if an immediate distribution of the catalogues to the substation(s) concerned is desired.
6.4 The "Calendar" window

The central part of the window comprises the "Calendar Pages" of three successive months.
Special Days are entered in colour below the dates:
Green for MO, TUES, WED, etc.
Blue for SD1, SD@, etc.

Elapsed Special Days are marked with an asterisk below the date; annually occurring Special Days are marked at the bottom right hand side with a triangle.

Scrolling by month:  [ > ] or [ < ]
turns pages one month forwards or backwards.

Jumping:
You can use the following procedure to jump forwards or backwards to a particular month.

There is an input field beneath the pushbutton for monthly scrolling. In order to jump to September, 1995, enter:
"7.9.95" (any one date in September 1995)
<Enter>

Another method of jumping is described in the "List" function.

6.5 Editing the Calendar

Defining a new Special Day:
First mark the date for the Special Day:


 at the date in question

⇒ The field background becomes grey.
Select or unselect the option "Annual."

[SD5]  [SA]  ....

Redefining Special Days:
Mark the Special Day in question and then proceed exactly as for "Defining a new Special Day."

Deleting Special Days:
Mark the date for the Special Day to be deleted:


 at the date in question

⇒ The field background becomes grey.
[Default]
It is also possible to edit several Special Days simultaneously. The additional days are also marked by clicking the left key of the mouse while keeping <Shift> pressed. The markings of individual days can be revoked in the same way.

### 6.6 SDC List

The SDC list offers a second option for carrying out the following functions: Jumping within the calendar, and defining, redefining or deleting Special Days.

"Calendar" window
Select "Function"
Select "List ..."
➡ "SDC List" window

The list on the left hand side of the window shows the currently defined Special Days. Above this is an input field for editing and jumping.
Jumping: You can jump forwards or backwards to any month in the calendar.

Bring an existing Special day into the input field, or enter a date (any day within the desired month).

Example
In order to jump to May, 1995, proceed as follows:

"7.5.95"

[Jump]

Defining new Special Days:

Enter the following into the input field:

- Date of the Special Day
- Special Day
- 0 or 1 for non-recurring or recurring Special Days respectively

Then:

[Insert]

Example
It is important to ensure that an empty space is entered between the date and the Special Days, and between the Special Days and the "Annual" code (use only capital letters):

SD2 0
Special Day 2, non-recurring.

SO 1
Sunday 1, recurring annually.

Redefining Special Days:

Bring the Special Day in question into the input field and change it there

Then:

[Insert]

Deleting Special Days:

Bring the Special Day to be deleted into the input field.

Then:

[Delete]

All the changes made in the SDC list become effective and are shown in the calendar display when the window is exited with [OK].

If an exit is made via [Cancel], the changes remain ineffective.
6.7 Printing

You can print the contents of the "Calendar ..." window as follows:

"Calendar" window
Select "Command"
Select "Print"

With <Print Screen> you can download the complete currently active window to the printer.
7. Trend Plot
The Trend Plot function offers numerous possibilities for plotting and manipulating process values:

- Up-to-date plots of process values in online operation (the Trend Plot function)
- Callup of local trend sets or of those saved in the DCS.
- Redefining trend sets or changing DCS trend sets and saving them locally.
- Zooming function and displacing the time window to the past.
- Saving the data of a trend in a graph for later use.
- Saving the data to export files for later use in table calculation programs or data bank programs.

"UNIGYR-VISONIK Insight window
Select "Function"
Start "Trend Plot"
⇒ "Trend Plot (Undefined) without Name" window

Icon:

A maximum of 3 "Trendplot" windows can be opened simultaneously.

"Trend Plot" window
<F3> or
Select "File"
Select "Exit"
7.1 Loading a Trend Set from the DCS

The trend sets defined in the DCS dialogue with the function "TRD", can be downloaded as follows:

"Trend Plot" window
Select "File"
Select "Load DCS Trend Set"
Select "Trend Set n"

The trend set number (1 to 16) must be entered at n.

The indication in the window title changes, for example to:
"Trend Plot 1 Trend Set 7 E01'L4'122MW"

At the same time, plotting of the values defined in the loaded trend set starts in the graph section.

7.2 Loading a locally saved trend set

Locally saved trend sets are downloaded as follows:

"Trend Plot" window
Select "File"
Select "Load Trend Set from File ..."
"Load Trend Set from File" window

Select drive, directory and file or enter filename, [OK]

The default is ...

When the function "Load Trend Set from File" is started, at first only files with the extension .TRD are shown. A double click on the drive causes files with other extensions to be displayed also.

The indication in the window title changes, for example, to:
"Trend Plot 1 ...

At the same time, plotting of the values defined in the loaded trend set starts in the graph section.
7.3 Saving a trend set locally

With this function, the presently loaded trend set can be saved locally.

"Trend Plot" window
Select "File"
Select "Save Trend Set to File ..."
"Save Trend Set to file" window

Select drive, directory and file or enter filename, [OK]

The default is Above the two selection lists is the current directory with the currently valid choice of files.

The default is ...
When the function "Save Trend Set to File" is started, at first only files with the extension .TRD are shown. A double click the drive causes files with other extensions to be plotted also.

The indication in the window title changes in accordance with the save, for example, to:
"Trend Plot (active)
...\UVI\TREN\USERSET\OSTBAU.TRD C12'H2'100 ST"

Plotting of the trend set defined values in the graph section continues.
7.4 Saving a graph locally

This function saves the current plot (all values from the start of the trend set up to the time that the save is made).

```
"Trend Plot" window
Select "File"
Select "Save Trend Graph to File ..."
"Save Trend Graph to File" window

Select drive, directory and file or enter filename, [OK]
```

The default is ...\UVI\TREND\USERLOG\*.LOG

When the function "Save Trend Graph to File" is started, at first only files with the extension .LOG are shown. A double click on the drive causes files with other extensions to be displayed also.

7.5 Loading a local graph

Locally saved graphs can be loaded again at any time.

```
"Trend Plot" window
Select "File"
Select "Load Trend Graph from File ..."
"Load Trend Graph from File" window

Select drive, directory and file or enter filename, [OK]
```

The default is ...\UVI\TREND\USERLOG\*.LOG

When the function "Load Trend Graph from File" is started, at first only files with the extension .LOG are shown. A double click on the drive causes files with other extensions to be displayed also.
This is the information in the window title for the plot of a locally loaded graph (example):
Trend Plot (local data offline)
...\UVI\TREND\USERLOG\WESTBAU.LOG B07'L4'003 SB

System graphs

The system saves the momentary plot of an active trend plot every 5 minutes to the directory
...\UVI\TREND\SYSLOG, under the name "TRENDn.LOG"
The corresponding graph contains all values from the start of the trend plot up to time that the save is made.

System graphs can be loaded in the same way as "normally" saved local graphs.

7.6 Saving trend plots to export files

With this function you can save the values of a trend plot from its start up to the time at which it is saved to an export file.

Export files can be processed further by table calculation programs or data bank programs.

"Trend Plot" window
Select "File"
Select "Save Export File ..."
"Save Export File" window

Select drive, directory and file or enter filename, [OK]

The default is ...\UVI\TREND\EXPORT\*.TXT

When the function "Save Export File ..." is started, at first only files with the extension .TXT are shown. A double click on the drive causes files with other extensions also to be displayed.

After confirmation, the window for the "Export Settings" appears.
**Time limitation:**
Here, the time span for the data export is defined.

**WCON:**
Selecting this option causes the respective WCON to be saved to the export file.

**Delimiter:**
In this field, enter the delimiter between the individual data required by the respective program.

**Time interval:**
This defines the time interval for saving values to the export file.
7.7 Operations in the trend plot window

The ten pushbuttons below the graph are allocated to the associated channels. They are characterised by associated colours.

The characters on the pushbuttons have the following meanings:
-! The datapoint exists but there are no values available at present.
-? The datapoint exists, but delivers questionable values.
-. Valid values are available.
7.7.1 Stopping/Activating

The display of a trend plot can be stopped for an indefinite period of time and then reactivated again without values being lost.

Stopping:

"Trend Plot" window
[Stop] or
Select "Function"
Select "Stop"

In the window title, the indication changes from "[active]" to "(stopped)." The plot continues up to the right hand edge of the graph and stops there.

Activating:

"Trend Plot" window
[Activate] or
Select "Function"
Select "Activate"

In the window title, the indication changes to "[active]" again and the plot continues uninterruptedly.

The activating function cancels the displays generated by the functions "Zoom In" and "Zoom Out" and sets the current time in the middle of the graph section.

Automatic stopping: The operations listed below in the trend plot window stop the display automatically for two minutes. However, reactivating is possible earlier by actuating [Activate]:
- Zooming in or zooming out
- Placing marks
- Choice of "Snapshot"
- Moving the displayed range with the scroll bar.
7.7.2 Zooming in/Unzooming out

Zooming in

The zooming in function is initiated in different ways:

"Trend Plot" window
[ ] or:
Select "Function"
Select "Zoom In"

Zooming in any section to the whole graph width:

Above the first limiting time

Above the second limiting time

The selected section now occupies the whole width of the graph.

After a zoom-in, the trend plot assumes the "Stopped" status for 2 minutes. Thereafter, it changes back automatically to "Active."

Zooming out

Zooming out can be carried out until the displayed period in the graph section reaches the maximum of 99 hours.

The "Zooming out" function is initiated as follows:

"Trend Plot" window
[ ] or:
Select "Function"
Select "Zoom Out"

After a "Zoom out," the trend plot assumes the "Stopped" status for 2 minutes. Thereafter, it changes back automatically to "Active."
7.7.3 Snapshot

Icon:

This function shows the graphically displayed values at a particular time, numerically.

Ten "Snapshot" windows can be opened in each Trend Plot window (max. 3).

Current values

"Trend Plot" [Snapshot] or
Select "Function"
Select "Snapshot"
➡ "Snapshot" window

![Trend Plot 1 Snapshot 1]

Values at a particular earlier point in time: ☁ above the corresponding time
then proceed as described above.

Indicating scales for the trend channels:
Each trend channel has a pushbutton below the graph, which has the colour of the displayed channel.

☁ at any pushbutton

The pushbutton in question is now surrounded by a marking box, and the pertinent range is displayed on the vertical axis of the graph.

The address of the point for the marked Trend Channel appears simultaneously in the title bar.
7.8 Settings

7.8.1 Displaying the graph

To change the graph settings for displaying graphs, proceed as follows:

"Trend Plot" window
Select "Settings"
Select "Display"
➡ "Display" window

**Period:** Insert here the period in the graph which should be displayed.

Entries ranging from one minute to 99 hours are permitted.

**Time scale:** Entries ranging from two seconds to 99 hours are permitted.

If the display period is not divisible by the time scale, "UNIGYR-VISONIK Insight" automatically selects a suitable scale.

However, the time scale must be chosen such that it is greater than the thirtieth part of the display period.

**Displaying the time scale:** Here one has the option of displaying the time scale.

A line is displayed at each change of day, regardless of this setting.
The changes made under "Display" are valid only for the momentary display. Should the new settings also be effective for a later call up, the Trend Set in question must be filed locally.

The display period mentioned above determines the time span of the display, but not the buffer size of the plotted channels. These are changed under "Point Settings."

### 7.8.2 Point setup

The following is a description of how you can change the channel definitions and enter in new channels.

To make changes in the setting of channel n, proceed as follows:

Method a:

"Trend Plot" window  
Select "Settings"  
Choose "Select Channel"  
Select "Channel n"  
⇒ "Point Setup" window

Method b:  

 vais at pushbutton for channel n  
⇒ Window “Point Setup”
The changes to an active trend plot described below are displayed immediately. However, trend set definitions in the DCS cannot be overwritten in this way.

In order to be able to use changed or newly defined trend set in "UNIGYR-VISONIK Insight" at a later date, you must file this locally.

For network systems, all displayed points of a Trend Set must belong to the same DCS.

**Address:**
Entry of a valid technical address or user address.

**Parameter:**
Entry of the parameters to be displayed. In the absence of an entry, "Insight" automatically displays the main value.

**Graphic depiction:**
- **Point:** Depiction of each value by a point.
- **Step:** Interpolation by means of a stepped curve.
- **Line:** Interpolation by means of connecting lines.

For points with discrete values (e.g. ST, SC) the stepped form must always be chosen.

**The acquisition and depiction of values:**
The DCS automatically supplies the Event values of the points to be depicted.

In the meantime, the trend plot function continues to plot the curves about every 10 seconds horizontally. As soon as actual values are available, it makes the appropriate corrections.

**Buffer size**
The time taken to save and display the acquired values.

For Trend Sets which were loaded from the DCS, the default for this value is always one hour.
Selection

Activate [Selection]

"Selection" window:

Select the desired colour.
Select the desired line sample.

The lowest line type draws a bright line in the selected colour.
7.9 Printing

In the Trend Plot function, you can print out the displayed graph or the contents of the "Snapshot" window.

Printing the displayed graph:

"Trend Plot" window
Select "File"
Select "Print Trend Plot"

Printing the snapshot:

"Trend Plot" window
Select "Command"
Select "Print"

With <Print Screen> you can download the complete currently active window to the printer.
8. Data Processing
The "Data Processing" function comprises the following operations:
- Display of data processing graphs from the VISONIK DCS.
- Display of locally filed data processing graphs.
- Local filing of data processing graphs.
- Display and filing of data processing tables.
- Printing of data processing graphs and tables.

"UNIGRY-VISONIK Insight" window
Select "Function"
Start "Data Processing"
⇒ "Data Processing" window

Icon:

Within the "Dataprocessing" function, only one window at a time can be opened.

"Data Processing" window
<F3> or
Select "Command"
Select "Exit"
8.1 Downloading graphs from the DCS

Loading a graph from the DCS requires a certain amount of time.

<F9> A graph already displayed on the screen can be redrawn very quickly with <F9>.

"Data Processing" window
<F5> or
Choose "Select"
Select "DCS"
⇒ "Load graph from Server" window

Enter graph number and system designation (only necessary if the graph is called up from another system):
"8"
"MAN"
[OK]
The pop-up window "Data Processing Transport" informs about the active loading procedure.

If [STOP] is chosen, the following safety prompt is displayed:

"Data Transfer is active
Do you really want to stop?"

If a stop is not chosen, the desired graph is displayed.

<F8> Switches the "Dataprocessing Transport" window on and off.

During the loading process, a copy of the graph is filed in the directory "...\UVI\DP_SYS."

Various information appears in the title bar of the "Data Processing" window.

Middle: ...
\UVI\DP_SYS\DPG0015.BIN
This is the filename and directory under which "Insight" files the data of the called up graph. This data is overwritten each time that graph No. 15 is called up anew.

Right: MAN: T10 = 15 (Graph No. 15 from the in-house system)  
PS1: - = 15 (Graph No. 15 from the foreign system)
The number of values per displayed curve is limited to 5000.
8.2 Locally downloaded graphs

Loading a graph requires a certain amount of time. A graph already displayed on the screen can be redrawn very quickly with <F9>.

"Data Processing" window
<F6> or
Choose "Select"
Select "Local"
⇒ "Select Local File" pop-up window

Select drive, directory and file or enter filename, [OK]

The default is ...\UVI\DP_USR\*. *

The directory and the filename appear in the title bar; the word "Local" is displayed on the right hand side.

8.3 Modifying graphs

It is possible to make certain modifications to the graphs on the screen, which can partly be defined also in the "Setup" window.
The changes have no effect on the definitions of the graphs in the DCS (DPP, GCH function).
On the other hand, the choice of the foreground and background, as well as the horizontal and/or vertical grid lines can only be made in the "Setup" window.

Scale lengths: <F11>
Switches over between dynamic and metric scales.

Dynamic Scale:
The scales are displayed on the screen for as long as the available space allows.
This depends on if and where the legends are displayed.

Metric Scale:
The scale lengths correspond to definition in the DCS dialogue DPP, GCH.
The output to the printer is not influenced by the change in the setup; the scale lengths always correspond to the definition in the DCS.

Positioning the legends:

- `<F7>`
  - Selects one of four options:
    - "Off" No legends
    - "Right" Legends to the right of the graph.
    - "Below" Legends below the graph.
    - "Button" For each curve, a pushbutton appears below the graph. When this is clicked, the appropriate legend is displayed.

The option "Button" is not available for output to the printer. Instead, the legends are printed below the graph.

If the X-axis exceeds 150mm, the legends are printed below the graph (even if the option "Right" is selected).

### 8.4 Saving graphs

<table>
<thead>
<tr>
<th>&quot;Data Processing&quot; window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select &quot;Command&quot;</td>
</tr>
<tr>
<td>Select &quot;Save&quot;</td>
</tr>
<tr>
<td>➡ &quot;Save File&quot; superimpose window</td>
</tr>
</tbody>
</table>

Select drive, directory and file or enter filename, [OK]
The default is `...
VI\DP_USR\*.`
8.5 Printing graphs

In order to print the displayed graph, proceed as follows:

"Data Processing" window
Select "Function"
Select "Print"

Selecting the scale of the axis as "dynamic" has no influence on the graph printout: The printout corresponds to the scale in the DCS.

If "Button" has been selected for the legends, all the legends are printed below the graph.

With <Print Screen> you can download the complete currently active window to the printer.

8.6 Tables

The value table pertinent to the graph displayed on the screen can be called up. This is identical to the one which, for example, can be listed out with the DCS dialogue PRO, DAP (TAB format):

"Data Processing" window
Select "Function"
Select "Table"
⇒ "dp_tab - F:\DATA\INSIGHT\WESTBAU.TAB"

At the same time a copy of the table, under the present filename and the new extension .TAB, is filed in the directory ...\UVI\DP_TAB:

DPG0007.BIN becomes DPG0007.TAB
WESTBAU.NOV becomes WESTBAU.TAB

The directory and the filename are displayed in the title bar of the "Table" window.
Settings: The following information must be entered in the "Settings" window for the format of the table:
- Number of digits for rounding off.
- Delimiters between values.
- Specifying whether or not the quality attribute should be shown.

The table can be displayed with the OS/2 program "System-Editor."

All the functions of this program are available, but only two will be described here.

Saving: Saving tables under a name of one's own choice.

You can establish the directory and filename in this window.

Establishing the font: In order to make a "professional-looking" table display, use a proportional typeset.

The type and size of font (e.g. "System Monospaced") are selected in this window.

Graphs are always read from a file having the extension "BIN." Changes in values made "by hand" in a table thus have no influence on the subsequent layout of this graph.
8.7 Settings

The following procedure opens the "Settings" window:

"Data Processing" window
Select "File"
Select "Settings"
⇒ "Settings" pop-up window

You can make the following settings here.

**Table:**

**Digits:**
Entering the number of digits before or after the decimal point to which a round-off is to be made.

Example:
Round off the value 945.567:
Number of digits = -2  945.57
Number of digits = 0  946
Number of digits = 1  950
Delimiters:
Entering a delimiter between the individual values allows using the table in other programs as e. g., "MS Excel."

Quality attribute:
Option as to whether or not the quality attribute should be displayed in brackets after the values.

Legends:
One of four options can be selected for arranging the legends:
- Legends to the right of the graph
- Legends below the graph
- No legends
- Button:
  When this option is selected, pushbuttons appear below the graph instead of legends. They can be used to display a selected legend.

For outputs to the printer, the "Keys" option causes printout of the legend below the graph.

If the X-axis exceeds 150mm, the legends are also printed below the graph (even if the option "Right" is selected).

Grid:
Four options are available for displaying the grid lines:
- No grid lines
- Horizontal grid lines
- Vertical grid lines
- Horizontal and vertical grid lines

Colours:
"Background colour" determines the screen background.
"Foreground colour" determines the colour of the axis system (x- and y-axes, grid, scales) and all texts (with the exception of legends).

On the other hand, the colour of the graphs to be displayed, and their legends, must be established in the DCS dialogue DPP, GCH.
9. Alarm Operation
The alarm operation function offers a simple method of handling configured points:

- Arrangement of the alarm points in a clearly understandable table.
- Possibility of choosing an option (according to priorities and alarm statuses such as active, inactive, acknowledged and unacknowledged).
- Possibility to sort according to different criteria.
- Output of detailed information about selected points and alarm statistics.

"Alarm Operation (alarm bell) Icon

or:

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Alarm Operation"
➡ "Alarm Operation" window

Icon:

A maximum of 2 alarm operation windows can be opened simultaneously.

"Alarm Operation" window
<F3> or
Select "Command"
Select "Exit"
9.1 Alarm updating

The function "Alarm Operation" only takes into account the points which have been configured appropriately in the DCS:

- The point must have a user address (parameter ADR)
- The parameter STZk must be set to "Alarm."

For purposes of simplification, such points are henceforth often referred to as "Alarm points."

When the "Alarm Operation" function is started, the "Alarm Operation" window appears empty.

Even later, changes in the alarm statuses of alarm points are not automatically updated in the "Alarm Operation" window.

"UNIGYR-VISONIK Insight" must continually be commanded to fetch the updated alarm data corresponding to the currently set option (see title bar of window) from the DCS:

```
"Alarm Operation" window
Select "Command"
Select "Update"
```

or

```
"Alarm Operation" window
Select "Command"
Choose "Select"
```

Now change the selection criteria as required, then [OK]

The "Alarm Operation" window now contains the information conforming to the currently set option and sort criteria.

The new incoming point information is sorted continuously according to the selected sort criteria. For this reason, the alarm list is set up anew several times.
**Background colours**

The background colours have the following meanings:
- Red: Active alarm, unacknowledged
- Green: Inactive alarm, unacknowledged
- Yellow: Active alarm, acknowledged
- Grey: Inactive alarm, acknowledged

**Coloured space in the headline** (behind "Select")

Information window which gives you the meaning of the colour in question

**Creating a file**

You can use the following procedure to create a text file from the contents of the "Alarm Operation" window, which you can load to and edit in any kind of word processing program.

```
"Alarm Operation" window
Select "Command"
Select "Create File"
⇒ "E.EXE - ALARM/ALMLIST.TXT" window
```

This concerns a window in the OS/2 program "System-Editor."

The filename is:

**ALMLIST.TXT**

It can be found in the directory:

```
...\UVI\ALARM
```

Whenever a new file of this type is created, the last one which was created is overwritten. To prevent this, it must first be given a new name.

The "System Editor window, allows, among other things:

- Editing and saving of the current file under any name in any directory.
- Call-up of other text files, especially of alarm files which have been saved earlier.

**Saving:**

```
"E.EXE ..." window
Select "File"
Select "Save as ..."
```
Selecting the font:

```
"E.EXE ..." window
Select "Option"
Select "Font"
```

Normal/extended display:
Two types of display are available:
The default when starting the alarm operation is on "normal." The switchover to extended display and back proceeds as follows:

```
"Alarm Operation" window
Select "Command"
Select "Extended Display"
```

The columns in the two displays have the following meanings:

- **WCON:** Parameter WCON (Window Condition)
- **Prio:** Parameter MPR (Error Order or Message Priority)
- **Address:** User address ADR
- **Text:** Point designation (texts TXI and TXI)
- **Status:** Main value of the point
- **Number:** Number of alarms which have arrived for the point in question since the last acknowledgement. (Parameter FCCH)
- ***Alarm:** Date and time of the last arrival of an alarm. (Parameter FCBT)
- **.Normal:** Date and time of the last cessation of an alarm. (Parameter FCET)
- **=Acknowledged:** Date and time of the alarm acknowledgment. (Parameter FCAT)
- **Code:** Code of the user who had acknowledged the alarm. (Parameter FCAU)
9.2 Selection

Here one can determine which points (alarm points), configured for the alarm operation, are to be displayed in the alarm window.

"Alarm Operation" window
Select "Command"
Choose "Select"
⇒ "Make Selection" window

Active
Unacknowledged/
Inactive
Unacknowledged/...:

Choice of which of the four possible alarm statuses (or combinations thereof) should be displayed. At least one option must be marked.
Priority n: At least one of the four message priorities must be marked.

Address: Here an address or an address range must be entered. The VISONIK deputy signs (* and %) are also accepted.

[Default]: Insight notes the last-used option (confirmed with [OK]) and uses it as the default if there is new callup. [Default] switches back again to this option after any changes are made.

When the "Select" window is closed with [OK], the alarm list is updated.

9.3 Sorting

Here, the sequence of the alarm points in the "Alarm Operation" window is defined.

When the alarm operation is started, the points are sorted according to "Date/Time."

If the sort sequence is changed to "Address" or "Priority," "Date/Time" acts as the second sort key.

[Default]: Insight notes the last-used sort (confirmed with [OK]) and uses it as the default if there is new callup. [Default] switches back again to this sort after any changes are made.
9.4 Acknowledgments

Acknowledging only one alarm:
In the "Alarm Operation" window:

"at the line to be acknowledged"

➡ Prompt:
"Do you really wish to acknowledge E1'H8'Z04?"

Acknowledging several alarms:
When several alarms must be acknowledged, you can make a selection according to priority, time span or by marking.

Marking alarms:
Mark the alarms to be acknowledged:
Press the <Shift> key while clicking at additional lines. If the click is repeated at the same line (with pressed <Shift>), the mark is removed again.

"Alarm Operation" window
Select "Command"
Select "Acknowledge"
➡ "Acknowledge Alarms" window

Making a selection:
Now select one of the six possibilities on the left hand side of the window "Acknowledge Alarms"
... if desired, enter new time limits...
... and mark "Confirm."
With confirmation
If you have decided on the option "Confirm," a prompt always appears before the alarm point is acknowledged:
"Do you really wish to acknowledge E01'P3'L7?"

Faster possibilities for acknowledging the marked alarms:
Mark the alarms as described above

at any one of the marked alarms

If you acknowledge in this manner, the confirmation prompt mentioned above appears at each point.

9.5 Printing the alarm list

You can print out the alarm list (without list head) as follows:

"Alarm Operation" window
Select "Command"
Select "Print"

With <Print Screen> you can download the complete currently active window to the printer.
9.6 Point information

Icon:

For a single marked cell, you can open a window with detailed information about the alarm behaviour of this point.

"Alarm Operation" window
Select "Command"
Select "Point Information"

Creating a file
You can create a text file from the contents of the "Point Information" window in the following manner, and then download it to a word processing program.

"Point Information" window
Select "Command"
Select "Create File"

"E.EXE ..." window
This is a window of the OS/2 System Editor.

The filename is:
\texttt{ALMHIST.TXT}

It is in the following directory:
\texttt{..\UVI\ALARM}

Whenever a new file of this type is created, the last one which was created is overwritten. To prevent this, it must be given a new name.

\begin{itemize}
\item E.EXE \ldots\ window
\item Select "File"
\item Select "Save as \ldots"
\end{itemize}

### 9.7 Alarm statistics

The alarm statistics give a clear overview of all alarm points for the selected option after the last update, categorized according to priorities and alarm statuses.

\begin{itemize}
\item E:\EXE \ldots\ window
\item Select "Command"
\item Select "Statistics"
\item ≫ Alarm Statistics window
\end{itemize}

\begin{table}[h]
\centering
\begin{tabular}{|c|c|c|c|c|c|}
\hline
Selection: \texttt{(\*) (AUA|UA)(Prio1&2&3)} & \texttt{Prio0} & \texttt{Prio1} & \texttt{Prio2} & \texttt{Prio3} & \texttt{Total} \\
\hline
Active unacknowledged & -- & 0 & 0 & 0 & 0 \\
Active acknowledged & -- & -- & -- & -- & -- \\
Inactive unacknowledged & -- & 0 & 0 & 0 & 0 \\
Inactive acknowledged & -- & -- & -- & -- & -- \\
\hline
Total & -- & 0 & 0 & 0 & 0 \\
\hline
\end{tabular}
\end{table}
10. Navigation
The "Insight" Navigation function permits an elegant change among various functions, as well as the use of the currently active address.

The following functions support Navigation.
- Picture Display
- Reaction Pictures (as the basic function)
- Point Operation
- Alarm Operation
- Trend Plot
- Timeswitch Catalogue (as the destination function)

## 10.1 Preparing Navigation

**"Picture Display"** or **"Reaction Pictures"**

Select the channel which is connected with the Navigation Point:

![at the update channel]

Close the window which appears after entering a new value:

[Cancel] or [OK]

Start Navigation (see below)

**Trend Plot:**

Mark the pushbutton which is connected with the Navigation Point:

![at the pushbutton]

Start Navigation (see below)

**Point Operation:**

No additional preparation is necessary here. After the point has been selected ...

... Start Navigation (see below)

**Alarm Operation:**

Mark the Navigation Point or a maximum of 10 Navigation Points from the Alarm List:

![at the first point]

<Shift> and simultaneously

![at other points]
If, when Navigation is initiated, there are several points marked in the Alarm function, the Navigation proceeds to the last point which was marked.

The destination function "Trend Plot" is the exception. It displays a maximum of the last ten marked points.

### 10.2 Initiating Navigation

```
"UNIGYR-VISONIK Insight" window
Select "Navigation"
Select "Destination Function"
⇒ Window of the Destination Function
```

### 10.3 Destination Function

The results of the Navigation function in the various destination functions are described below.

**Point Operation:** A "Point Operation" window opens with the display of the Navigation Point.

**Alarm Operation:** An "Alarm Operation" window opens. The selection is set as follows:
- Address range limited to the Navigation Address
- All alarm statuses
- All priorities

Thus, after "Updating," the lines of the Navigation Point are the only ones to appear in the alarm list.

**Timeswitch Catalogue:**
A "Timeswitch Catalogue" window immediately opens with the pop-up window "Load Timeswitch Catalogue from DCS/SS."

The Navigation Address is the default in the input field "Substation."
Trend Plot: Several Navigation Points can be selected in the function "Alarm Operation." The destination function "Trend Plot" profits from this:

It simultaneously displays the values of up to ten Navigation Points.

Procedure in the case of a single Navigation Point: If a Trend containing this point is active in the background:
The Trend window moves to the foreground and the push-button of the associated channel is marked.
If a Trend not containing this point is active in the background, but still has a free channel:
The Trend window moves to the foreground, the pertinent point is displayed on the first free channel, and its push-button is marked.

Procedure in the case of several Navigation Points: In each case, Insight opens a new Trend Plot window. This displays the ten last selected points. (Last-marked point on channel 1, etc.) If you have marked more than 10 points, a message draws your attention to this. The first marked points do not appear in the Trend.

Picture display The navigation proceeds exactly as if the navigation address had been entered for the Picture Selection, according to address.

Examples: The navigation point is E01'L2'Z01
There exist, among others, pictures with the following "similar" addresses:

<table>
<thead>
<tr>
<th>Picture</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Address *</td>
</tr>
<tr>
<td>2</td>
<td>Address E*</td>
</tr>
<tr>
<td>20</td>
<td>Address E01**</td>
</tr>
<tr>
<td>47</td>
<td>Address E01'L*</td>
</tr>
<tr>
<td>101</td>
<td>Address E01'L2*</td>
</tr>
</tbody>
</table>

In this case, the picture with the number 101 is navigated.
11. Picture Editor
11.1 Overview

The Picture Editor comprises the following functional groups:

- **Operations on pictures:**
  - Loading
  - Deleting
  - Saving
  - Copying
  - Printing

- **Drawing:**
  - Straight line
  - Polyline
  - Polygon
  - Rectangle/Rounded rectangle
  - Circle/Ellipse
  - Text
  - Arc/Sector
  - Bar
  - Clock
  - Button

- **Operations on figures:**
  - Marking
  - Colour selection
  - Line width selection
  - Moving
  - Enlarging/Shrinking
  - Compression/Expansion
  - Mirror-imaging (Flipping)
  - Rotation
  - Superimposing (overlaying the foreground/background)
  - Combining/Breaking apart
  - Hiding/Unhiding
  - Alignment/Centering
  - Cutting
  - Insertion
  - Copying
o Auxiliary Tools:
  - Zooming in/Zooming out
  - Grid
  - Snap
  - Coordinate display
  - Clear screen
  - Screen colour
  - Picture expansion

o Symbols:
  - Defining a symbol
  - Inserting symbols
  - Saving or loading the library
  - Breaking up a symbol

o Updating:
  - Defining channel numbers

"UNIGYR-VISONIK Insight" window
Select "Tool"
Start "Picture Editor"
⇒ "Picture Editor" window

Icon:

The maximum number of opened windows for the Picture Editor is 2.

"Picture Editor" window
<F3> or
Select "Command"
Select "Exit"

If the current picture had been changed since the last save operation, the following safeguard prompt is displayed:
"Changes will not be saved!"
[OK]
Since the actuation of the mouse buttons becomes very important when drawing or carrying out operations on graphic figures, the meanings of the symbols are repeated below (again assuming that the OS/2 has been set up for right-handed users):

- Click once on the left button.
- Click twice on the left button.
- Keep the left button pressed. (Drag function and fine positioning for drawing or moving.)
- Release the left mouse button.

### 11.2 Function keys

Various actions in the Picture Editor (drawing figures, operations on figures, auxiliary tools) can also be initiated by commands from the keyboard. Wherever applicable, these keyboard commands are always indicated in brackets.

Example:

- Icon: "Rectangle" (Keyboard: <R>)
Below is a list of all keyboard commands for the Picture Editor:

**Important: <Caps Lock> must not be activated.**

**Drawing:**
- `<L>`: Straight line
- `<P>`: Polyline
- `<P>`: Polygon
- `<R>`: Rectangle
- `<O>`: Rounded rectangle
- `<C>`: Circle or Ellipse
- `<5>`: Arc or sector
- `<9>`: Bar
- `<t>`: Text
- `<$>`: Change circle into clock
- `<4>`: Button

**Operations on figures**
- `<H>`: Mark
- `<A>`: Mark all
- `<Alt>`: Enable marking box
- `<G>`: Combine
- `<U>`: Break apart
- `<F>`: Place in foreground
- `<B>`: Place in background
- `<Del>`: Cut or delete
- `<->`: Hide
- `<+>`: Unhide
- `<X>`: Make mirror image (Flip) (x-axis)
- `<Y>`: Make mirror image (Flip) (y-axis)
- `<Z>`: Rotate (by 90 degrees)
- `<Shift X>`: Centre horizontally
- `<Shift Y>`: Centre vertically
- `<<> <> <> <>>`: Fine positioning for drawing, shifting, enlarging, etc.
  (with simultaneously pressed left mouse button)
**Auxiliary Tools**

- `<%>` Invert colour (from white to black and vice versa)
- `<Ctrl B>` Change screen background colour
  (from white to black and vice versa)
- `<Ctrl X>` Expand picture horizontally
- `<Ctrl Y>` Expand picture vertically
- `<Ctrl Shift X>` Shrink picture horizontally
- `<Ctrl Shift Y>` Shrink picture vertically
- `<Ctrl >` Move picture to the left
- `<Ctrl >` Move picture to the right
- `<Ctrl >` Move picture upwards
- `<Ctrl >` Move picture downwards
- `< < >` Zoom in
- `< > >` Zoom out
- `<Shift ← ->>` Zoom: Half a screen side to the left
- `<Shift ↑ ->>` Zoom: Half a screen side upwards
- `<Shift → ->>` Zoom: Half a screen side to the right
- `<Shift ↓ ->>` Zoom: Half a screen side downwards
- `< . >` Snap on/off
- `<V>` Grid on/off
- `< , >` Coordinate display on/off
- `<Space>` Redraw

**Symbols**

- `<S>` Symbol library
- `<M>` Multi-Symbol
- `<#>` Number the library
- `<Shift S>` Rescue current library

**Updating:**

- `<Ctrl A>` Channel display on/off
- `<I>` Define channel number
11.3 Operations on pictures

Here you will find a description of the following operations with pictures:

- Loading (local or from DCS)
- Saving (local or to DCS)
- Copying
- Deleting
- Printing

11.3.1 Loading the picture from the DCS

"Picture Editor" window
Select "Command"
Select "Load from DCS"
➡ "Load Picture" Pop-up window

Input of a picture number:
"35"
Enter the system if the picture does not have to be fetched by its own system:
"MAN"
[OK]

The DCS port and the picture number are displayed next to the window title, e.g. "T2 15."
When a picture is loaded from the DCS, "Insight" immediately makes a backup copy. The file name contains the system prompt as well as the picture number.

**MAN 35.PTF**
Directory: ...\UVI\PTF
The old DCS picture is therefore always locally available.

If the picture being worked on had been changed since the last save operation, the following safeguard prompt is displayed immediately after the function "Load from DCS" has been selected:
"Changes will not be saved!"

### 11.3.2 Loading the locally saved picture

<table>
<thead>
<tr>
<th>&quot;Picture Editor&quot; window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select &quot;Command&quot;</td>
</tr>
<tr>
<td>Select &quot;Load from File&quot;</td>
</tr>
</tbody>
</table>

➡ "Load Picture from File" window

Enter drive, directory and file or filename, [OK]

The directory and the filename are displayed next to the window title:
"...\UVI\PTF\Anlage17.PTF"

The default is ...\UVI\PTF\*.PTF

When the function "Load Picture from File" is started, at first only files with the extension .PTF are shown. A double click the drive causes files with other extensions to be shown also.

If the picture being worked on had been changed since the last save operation, the following safeguard prompt is displayed immediately after the function "Load Locally" has been selected:
"Changes will not be saved!"
11.3.3 Saving pictures to the DCS

"Picture Editor" window
Select "Command"
Select "Save to DCS"
➡ "Save picture" window

Enter the picture number:
"25"
Enter the system if the picture does not have to be saved
to its own system:
"MAN"
[OK]

Important note:
An ISC picture which had been changed and saved back
to the DCS, can no longer be displayed on the Colour
Operating Stations (COS).

If a picture is saved to any number of the DCS which had
never been loaded, "Insight" has no backup copy of the
original picture.
The picture in question is lost.

Changes to a currently displayed picture (on your or
another Insight) become active only following a new
callup.
11.3.4 Saving a picture locally

"Picture Editor" window
Select "Command"
Select "Save locally"
⇒ "Save Picture Locally" window

Enter drive, directory and file or filename, [OK]

The new data are displayed next to the window title, e.g.:
"F:\DATA\PICT\Anlage10.PTF"

The default is ...

If no filename extension is specified, "UNIGYR-VISONIK Insight" automatically uses the extension .PTF

When a previously loaded picture is saved, the complete old name will be proposed.

If a save is made to an already existing picture file, the following safeguard question appears:
"Picture File Exists!
Overwrite?"

Backup file
If a save is made on an already existing file name, "UNIGYR-VISONIK Insight" creates, in the same directory, a copy of the overwritten picture, with the same name but with the extension .BAK
11.3.5 Copying a picture

Copying pictures is carried out in two steps:
- Loading the source picture (local or DCS) in the Picture Editor.
- Saving the picture to the destination point (local or DCS).

The DCS picture number 15 is to be copied locally as GARAGE.NEW in the directory F:\VISONIK\LAYOUT:

"Picture Editor" window
Select "Command"
Select "Load from DCS"
➡ "Load Picture" pop-up window

“15”
[OK]
➡ Desired picture is displayed.

"Picture Editor" window
Select "Command"
Select "Save locally"
➡ "Save Picture" pop-up window

In the "Directory:" list, choose "F:\VISONIK\LAYOUT"
In the input field "Filename:" , write GARAGE.NEW, [OK]
11.3.6 Deleting a picture

Clear the screen in Editor:

```
"Picture Editor" window
Select "Edit"
Select "Clear Screen"
```

If the picture had been changed since the last save operation, the following safeguard prompt is displayed:

"Are you sure?"

The "empty" picture is now saved to the desired point as described above.

**Physical deletion of a DCS picture**

In order to physically delete a picture on the DCS, the Dialogue window must be opened and the function COS,COS, DEL must be called up.

11.3.7 Printing

To print the picture currently displayed in the "Picture Editor" window, proceed as follows:

```
"Picture Editor" window
Select "Command"
Select "Print"
```

Use the <Print Screen> to download the entire currently active window to the printer.
If nothing appears on the screen when a figure is drawn, the reason lies with the choice of colour:

Both the foreground and the background colours are set to "transparent", or correspond to the currently selected background colour (window colour or the colour of a figure in the background).

To change the colours of a figure, see "Operations with Graphic Figures - Choice of Colours."

Recovery files:

In certain situations, "Insight" automatically creates backup copies:
- When opening a new Editor window
- Always after 50 drawing operations
- With the "Clear Screen" operation.

Name of the backup copy: RECOVERY.PTF
Directory: ...\UVI\PTF

Before creating a new backup copy, Insight always changes the old RECOVERY.PTF into RECOVERY.OLD.

Thus, not all the changes to a picture are lost in the following cases:
- Ignoring the warning "Changes will not be saved" with [OK]. (when exiting the Picture Editor or when loading a new picture.)
- Direct exit from "UNIGYR-VISONIK Insight."
- Power failure
- Program crash

### 11.4.1 Drawing a straight line

![Icon for "Straight line" (Keyboard: <L>)]

- ![Start of line]
- ![End of line]

The directional keys can be used for fine positioning the end of the straight line.
11.4.2 Polyline ("Open polygon")

Condition:
Filling colour must be "transparent."

Icon for "Polygon" (Keyboard: <P>)
All corners (with the exception of the last)
Last corner

The directional keys can be used for fine positioning from the second corner.

The Polyline can have a maximum of 30 corners.

11.4.3 Polygon

With filling colour
Icon for "Polygon" (Keyboard: <P>)
All corners (with the exception of the last)
Last corner

"Transparent" colour
Icon for "Polygon"
All corners
Exactly at the first corner

The directional keys can be used for fine positioning from the second corner.
The Polygon can have a maximum of 30 corners.

An alternative way of drawing a "transparent" polygon:
- First draw a polygon with any filling colour.
- Change the filling colour to "transparent" (see under "Choice of colour").

11.4.4 Rectangle

Icon for "Rectangle" (Keyboard: <R>)
- First corner
- Diagonally opposite corner

The directional keys can be used for fine positioning at the second corner.

11.4.5 Rounded rectangle

Icon for "Rounded rectangle" (Keyboard: <O>)
- First corner
- Diagonally opposite corner

The directional keys can be used for fine positioning at the second corner.
11.4.6 Circle/Ellipse

Circles and ellipses are drawn with the same tool. If the icon is clicked several times or <C> is actuated several times, the form of the icon and the drawing function changes from a circle to an ellipse and vice versa.

Icon for "Circle/Ellipse" (Keyboard: <C>)

Repeat if a change is to be made from a circle to an ellipse and vice versa.

Circle/Ellipse centre

If shape and size are OK

The directional keys can be used for fine adjusting the shape and size.

11.4.7 Text

Five fonts are available. With repeated clicking at the icon or repeated actuation of <T>, the icon changes, and thus also the selected font, in the following sequence:

T1 - T2 - T3 - T4 - T0 - T1 etc.

T0: Courier font, size 14 point
T1: Helvetica font, size 14 point
T2: Helvetica font, size 18 point
T3: Helvetica font, size 22 point
T4: Helvetica font, size 26 point

Icon for "Tn" (Keyboard: <T>)

Repeat to change the font type.

Start of text

"Picture Editor" window: Text input
Write text

[OK]

The directional keys can be used for fine positioning the location of the start of the text.

During the writing process the keys <Home>, <End>, <Back Space> and <Delete> can be used to edit the already written text.

<Insert> switches from the default insert modus to the overwrite modus.

For the "Helvetica" font:
With maximum line thickness, bold type is produced, otherwise thin type.

Editing an existing text

Icon: "Hand" (keyboard: <H>)

anywhere in the existing text

The "Editor: Text Entry" window with the selected text, is opened for editing.

The font and line thickness currently selected in the tool bar determine the script after the text input window is closed.
11.4.8 Arc/Sector

When the filling colour is "transparent," an arc is produced; any other colour produces a sector.

"Picture Editor" window
<5> or
Select "Draw"
Select "Arc/Sector"

Centre of arc or sector
If size and first limiting radius OK
Second limiting radius

The directional keys can be used for fine adjustment of the circle size and the first limiting radius

The arc and sector are always drawn in the clockwise direction from the first to the second limiting radius (regardless of the direction of movement when drawing).

The drawings below illustrate this:

(Sector) (Arc)

11.4.9 Clock (conversion from circle)

With this function a circle or an ellipse can be converted into a clock, the time on which is automatically registered in the "Picture" window.

Condition: The circle (or ellipse) to be converted must be highlighted.

"Picture Editor" window
<$> or
Select "Draw"
Select "Clock (analogue)"
11.4.10 Bar

In the display, a bar is used for the graphical representation of updated analogue values (measurements, positioning commands, etc.).

As such, bars must always be connected to an updating channel. (See under "Updating").

"Picture Editor" window

Select "Draw"
Select "Bar"

Starting corner
Diagonally opposite corner
The directional keys can be used for fine positioning at the second corner

The selected foreground colour occupies the lower or the left third of the bar drawn in the Picture Editor.

In the picture layout, the colour defined in the COS, ACT dialogue represents the updated proportion of this part.

If the updated part should appear in the upper or right hand part, the drawn bar can be rotated 90° (see under "Object operations").
11.4.11 Marker

A marker in the Picture window is also used to display an updated analog value (measured value, positioning command, etc.)

Here, any type of mark (short dash, arrow, triangle) runs along a (possibly invisible) straight line.

Markers must always be connected to an updating channel of the "bar" type (COS, ACT dialogue).

Drawing a marker:
- Draw a straight line. The beginning of the line defines the starting value.
- Draw the mark at the desired position anywhere, or on the straight line.
- Mark the marker and straight line.
- Combine the two figures.

Important:
If the mark and the straight line intersect, the mark must always lie in front of the straight line. (See the operations "Allocation to Foreground/Background")

For combined marker elements, the element used first may not be a straight line. You can draw a triangle, for example, with the "Polyline" function. For a half circle, begin with an arc.

11.4.12 Button

Produces a square grey button which, when connected to an updating channel, can be used, for example, to select a support picture or to start a COLBAS task.

The colour of the button is not influenced by the definition in the COS, ACT dialogue. It always remains grey, even in the Picture window.
11.5 Operations on figures

These are understood to be operations on graphic figures:

- Marking
- Colour selection
- Line width selection
- Moving
- Enlarging/Shrinking
- Compression/Expansion
- Mirror-imaging (Flipping)
- Rotation
- Allocation to foreground/background
- Combining/Breaking apart
- Hiding/Unhiding
- Alignment
- Cutting
- Deletion
- Insertion
- Copying

Before operations on graphic figures can be carried out, the figures must generally be "marked."

Marked figures are framed by a thin dotted line box, which has a "handle" (a small square) at each of the four corners and at the middle of each of the four sides.

The same operations can be carried out on several commonly marked figures as on a single marked figure.

11.5.1 Marking a single graphic figure

Icon: "Hand" (Keyboard: <H>)

The last drawn graphic figure is marked, i.e. it is now framed by a marking box with 8 handles (four in the corners and four on the middle of the sides).

(For straight lines there are only two handles, at the two ends.)

On the figure to be marked
When a figure is marked or a click is made in "thin air," all previous markings are automatically removed.

If several figures are marked simultaneously when a click is made, it means that these figures are "combined" with each other. (See under "Combining figures").

### 11.5.2 Marking with the marking box

This method (it is also referred to as the rubber-band or lasso method) is suitable for marking several figures, if the following condition is fulfilled:

All the figures to be marked are situated such that they (and only they) can be framed by a box.

Counter examples can be found under "Marking with the <Shift> key".

**Case 1:** The figures to be marked are not situated on a common background surface.

- **Icon:** "Hand" (Keyboard: <H>)
- The last graphic figure drawn is marked.
- **Anchor point of a marking box for all figures to be marked.**

Starting from this anchor point, a movement of the mouse will produce a "rubber band" which will be stretched to encompass the figures to be marked.

- **Second corner of the marking box**

The directional keys can be used for fine positioning at the second corner

- All marked figures are now framed together within a single marking box with 8 handles (four in the corners and four on the middle of the sides).
  In addition, each separate figure is framed by a dotted-line rectangle (without handles).
Case 2: The figures to be marked are situated on a common background surface.

The method described in case 1 cannot be used here, since the background figure will be marked as soon as the left button of the mouse is pressed.

Procedure:

Icon: "Hand" (Keyboard: <H>)

⇒ The last graphic figure drawn is marked.

Keep <Alt> pressed

Anchor point of a marking box for all figures to be marked.

Starting from this anchor point, a movement of the mouse will produce a "rubber band," which will be stretched to encompass the figures to be marked.

Second corner of the marking box

The directional keys can be used for fine positioning at the second corner

⇒ All marked figures are now framed together within a single marking box with 8 handles (four in the corners and four on the middle of the sides).

In addition, each separate figure is framed by a dotted-line rectangle (without handles).
11.5.3 Marking with the <Shift> key

The figures to be marked are not situated such that they, and they alone, can be framed by a single marking box.

- Figures A and B should be marked together: Figure C will always be marked with them.
- Figures D, E and F should be marked together: When any anchor point is clicked, other figures are also marked together with F (G, H, I, J).

Icon: "Hand" (Keyboard: <H>)

➡ The last drawn graphic figure is marked.
➡ First figure to be marked

Press <Shift>, then
➡ on all figures to be marked

Repeated clicking at a figure removes it again from the common marking. (This works even for the method with the marking box.)

➡ All marked figures are now framed together within a single marking box with 8 handles (four in the corners and four on the middle of the sides). In addition, each separate figure is framed by a dotted-line rectangle (without handles).

Alternative method: Unwanted figures are temporarily hidden for the marking process, and then unhidden again (see under "Hide/Unhide").
11.5.4 Marking all figures

To mark all the drawn figures together, proceed as follows:

- **Icon: "Hand" (Keyboard: <H>)**
- The last drawn graphic figure is marked.

- **<A>**
- All graphic figures are now framed together within a single marking box with 8 handles (four in the corners and four on the middle of the sides).
  In addition, each separate figure is framed by a dotted-line rectangle (without handles).

11.5.5 Combining figures

Co-marked graphic figures lose their common marking as soon as another figure is marked or drawn. Should the marked figures have to be united permanently with a single new figure, they must be combined.

However, it will not be possible to change the line width or the colour on the new figure.

Mark the desired graphic figures together (see under "Marking")

- **Icon: "2 facing arrows"**
  (Keyboard: <G>)

11.5.6 Breaking apart

A combined figure can be broken apart at any time into the original individual figures:

Mark the combined figure

- **Icon: "2 opposing arrows"**
  (Keyboard: <U>)

To remove the common marking:

- "in thin air"
11.5.7 Superimposing

Superimposition involves the following actions:
Place the figure(s) in the foreground (<F>) or the background (<B>).

Mark the figure(s)

Icon: "2 overlapping rectangles"
(Keyboard: <F> <B>)
The left icon places to the front, the right one to the rear.

11.5.8 Line width selection

The "sample box" above the "line width" icons shows the current line width in red.

Adjusting the line width to already drawn figures:

- Mark the figure(s)
- Select the line width (see below)

Selecting the line width for the next figures to be drawn:
(The selection can be made before or after the next figure has been chosen)

At first remove any existing markings:

"in thin air"
then select the line width (see below)

Choice of line width:

Icon: "Desired line width"
The line width icon changes in colour from black to red, the new line width is indicated at the "sample box," and the line widths on any marked figures are changed appropriately.
If the line width of a marked figure cannot be changed, the figure in question must be a symbol or be part of a grouped figure.

To change the line width of a symbol, break its connection to the symbol library. Details are given under "Symbols."

The line widths of combined figures can only be changed when the figures are separated (broken apart) again.

"Maximum Line Width" influences the "Text" operation: With this setting, texts T1 to T4 are written in bold script.

11.5.9 Colour selection

The basic colours for the foreground (lines, texts) and the background (filling colours, text background) appear for checking purposes in the "sample box" above the "Line Width" icons.

The active foreground colour is indicated in the colour palette additionally by a thin rectangle.

The X indicates the "transparent" "colour."

Selecting the colours of already drawn figures:
- Mark the graphic figure
- Choose the colour (see below)

Selecting the colours of figures to be drawn:
(The colours can be selected before or after the next figures are chosen.)

First remove any existing markings:

"in thin air" (i.e. away from all graphic figures)

Then select the colour (see the following)
Choice of background colour: The background colour is understood to be the colour used to fill rectangles, polygons, circles, etc., and the background colour of texts.

_inside the "Sample box"

_Desired colour field_

The inside of the sample box and any marked figures take on the chosen colour.

Choice of foreground colour: The foreground colour is understood to be the line colour of rectangles, polygons, circles, etc., and the colour of text characters.

_Desired colour field_

The border of the sample box and any marked figures, as well as the characters of marked texts, assume the chosen colour. The corresponding colour field in the colour palette is marked by a thin rectangle.

If the colour of a marked figure cannot be changed, the figure in question must be a symbol or be part of a grouped figure.

To change the colour of a symbol, break its connection to the symbol library. Details are under "Symbols."

The colours of combined figures can only be changed when the figures are separated (broken apart) again.
11.5.10 Cutting (Deleting) figures

When “cutting,” the graphic figures involved are cleared from the screen and put into a “basket” until the next “Cut” or “Copy” operation.

From there, they can be used as often as required (even if the second "Editor" window is open) by using the "Paste" operation.

Mark the graphic figure, then:

```
"Picture Editor" window
<Del> or
Select "Edit"
Select "Cut"
```

11.5.11 Copying figures

When copying, the figures involved are left on the screen and filed in the internal archive until the next "Cut" or "Copy" operation.

From there, they can be used as often as required (even if the second "Editor" window is open) by using the "Paste" operation.

Mark the graphic figure, then:

```
"Picture Editor" window
Select "Edit"
Select "Copy"
```

11.5.12 Pasting figures

With this operation the figures which had been put into the internal archive by the last "Cut" or "Copy" operation can be inserted back into the picture (even if the second "Editor" window is open).

```
"Picture Editor" window
Select "Edit"
Select "Paste"
Marking Box
```
Position the marking box

The directional keys can be used for fine positioning

The procedure can be repeated as often as desired.

If the <Shift> key is pressed simultaneously with the mouse click, the figure involved can be inserted into the picture once again (instead of the indirect way, via the "Paste" operation).

11.5.13 Moving graphic figures

This operation permits figures to be moved around freely within a picture.

Mark the figure

Inside the marking box

Position the marking box.

The directional keys can be used for fine positioning

11.5.14 Enlarging and shrinking figures

The "Enlarge" or Shrink" operation does not change the form of the selected figure.
That is: the initial and final figures are proportional.

Mark the graphic figure

At one of the corner handles

The pointer changes into a double-arrow.
Select the desired size

The directional keys can be used for fine positioning

The corner handle opposite to the chosen handle remains anchored in the picture.

Texts cannot be enlarged or shrunk.

11.5.15 Compressing and expanding figures

These functions change the width of the marked graphic figure while keeping the height constant, or vice versa.

Mark the graphic figure.

At one of the mid-side handles

⇒ The pointer changes into a double-arrow.

Select the desired size

The directional keys can be used for fine positioning

The side opposite the chosen handle retains its original position and length.

Texts cannot be compressed or expanded.
11.5.16 Hiding and unhiding figures

Figures can be made temporarily invisible with the "Hide" operation. The hidden figures can be made visible again any time with the "Unhide" function.

Mark the graphic figures

"Picture Editor" window
<-> or <+> or
Select "Operations"
Select "Hide" or "Unhide"

11.5.17 Centering and alignment of figures

Centering: The commonly marked graphic figures are centered horizontally or vertically.

"Picture Editor" window
<Shift X> or <Shift Y> (for horizontal or vertical) or
Select "Operations"
Select "Centre..."

The following drawing illustrates the two operations:

Centre vertical

Centre horizontal
Alignment

With the "Top," "Bottom," "Right" and "Left" alignment functions, the figures are justified with the respective limiting line.

Mark the graphic figures, then

"Picture Editor" window
Select "Operations"
Select "Align..."

11.5.18 Mirror-imaging (Flipping) figures

The marked figures are mirror-imaged about the common horizontal or vertical middle axis.

The drawings below illustrate the operation "Mirror-image about the Y-Axis" or "Vertical Flip":

1 Object

Several Objects

Mark the graphic figure, then

"Picture Editor" window
<X> or <Y> or
Select "Operations"
Select "Flip Horizontal" or "Flip Vertical"

Texts cannot be flipped.
11.5.19 Rotating figures

The marked figures are rotated counter-clockwise by 90 degrees about the common mid-point:

1 Object

Several Objects

Mark the graphic figure, then

"Picture Editor" window
<Z> or
Select "Operations"
Select "Rotate 90"

Texts cannot be rotated.
The "Rotate" operation only functions correctly if there is enough space for rotation within the drawing area. Sometimes it is also not possible to rotate close to the edge.
11.6 Auxiliary Tools

In addition to details about the sample box, the following provides a description of the following functions:

- Zooming in/Zooming out
- Snap
- Grid
- Coordinate display
- Clear screen
- Screen colour selection
- Whole-picture moving, expansion or compression.

11.6.1 Sample box

The sample box shows the current settings for the foreground, background and line width.

The filling colour corresponds to the current background colour (for texts) or the filling colour (for rectangles, circles, etc.).

The edge colour and width correspond to the current settings for the foreground, i.e. the text or line colour and the line width.

When an individual figure is marked, its settings are indicated.
There is no change in the marking box when several figures are marked.
11.6.2 Zooming in a section of a picture

The "Zoom in" function causes a section of the picture to be magnified by a factor of 2.

Three zoom-in operations can be initiated consecutively, resulting in section magnifications of 2:1, 4:1 and 8:1. The currently active magnification is indicated below the colour icon.

Icon: "Zoom in"
(4 facing arrows) (Keyboard: < < >)

Position the displayed section box.

The directional keys can be used for fine positioning

The selected picture section now occupies the entire Picture Editor window.

A switched-on grid will not be zoomed in with the section. Thus, in the zoomed-in condition it has a correspondingly smaller grid than in the zoomed-out condition. The same holds good for the distances between the grid points. Texts do not change in size with the zoom-in function.

Shifting the picture section: It is possible to shift the picture section in any direction by half a screen side within the zoomed-in picture:

<Shift <->  <Shift ↑>  <Shift →>  <Shift ↓>
11.6.3 Zooming out

Icon: "Zoom out"
(4 opposing arrows) (Keyboard: < > >)

A picture which has not been zoomed in cannot be
zoomed out.
In other words: A diminution (1:2) of the original picture
(1:1), is not possible.

11.6.4 Expansion/Compression/Moving of a picture

This functions described below expand, shrink or move the
whole picture by a small factor.

Horizontal expansion: <Ctrl X>
Vertical expansion: <Ctrl Y>
Horizontal shrinking <Ctrl Shift X>
Vertical shrinking <Ctrl Shift Y>
Moving in one direction <Ctrl > <Ctrl > <Ctrl > <Ctrl >

Before executing this function, switch off the Snap mode
(see below).

11.6.5 Snap mode

When the snap mode is switched in, all the corner, starting
and ending points of graphic figures, as well as text starts
are latched in to snap points.

Switching the snap mode on and off:

Icon: "Grid" (Keyboard: < . >)
If the snap mode is used in a zoomed-in picture, the snap spacing is finer than in the original picture. The following relationships hold:

<table>
<thead>
<tr>
<th>Zoom stage</th>
<th>Snap spacing (relative to the original picture)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1</td>
<td>100 % (5 mm)</td>
</tr>
<tr>
<td>2:1</td>
<td>50 % (2.5 mm)</td>
</tr>
<tr>
<td>4:1</td>
<td>25 % (1.25 mm)</td>
</tr>
<tr>
<td>8:1</td>
<td>12.5 % (0.625 mm)</td>
</tr>
</tbody>
</table>

11.6.6 Grid lines

The grid is intended merely as aid to drawing, and functions regardless of the "Snap" mode.

Making the grid lines visible or invisible:

```
Picture Editor window
<V> or
Select "Options"
Select "Grid On/Off"
```

If the grid is used in a zoomed-in picture, the grid spacing is finer than in the original picture. The following relationships hold:

<table>
<thead>
<tr>
<th>Zoom stage</th>
<th>Grid spacing (relative to the original picture)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1</td>
<td>100 % (5 mm)</td>
</tr>
<tr>
<td>2:1</td>
<td>50 % (2.5 mm)</td>
</tr>
<tr>
<td>4:1</td>
<td>25 % (1.25 mm)</td>
</tr>
<tr>
<td>8:1</td>
<td>12.5 % (0.625 mm)</td>
</tr>
</tbody>
</table>
11.6.7 Coordinates display

If desired, the position of the cursor can be displayed to the left of the "Picture Editor" title bar:

\[ X = 145 \quad Y = 34 \]

First number (X): Horizontal position in mm from the left.
Second number (Y): Vertical position in mm from the top.

Coordinates display, yes or no:

"Picture Editor" window
<> or
Select "Options"
Select "Coordinates"

11.6.8 Clearing the screen

To be precise, it is not the screen but only the drawing surface of the Picture Editor that is cleared.

"Picture Editor" window
Select "Edit"
Select "Clear Screen"

If the picture had been changed since the last save operation, the following safeguard prompt is displayed:
"Are you sure ?"

If the above question is answered with "Yes," the contents of the screen are not yet lost. Insight saves the screen contents automatically:
File: RECOVERY.OLD
Directory: ...\UVI\PTF
11.6.9 Indicating the picture size

This option indicates the current size and the maximum size of the picture in bytes:

```
"Picture Editor" window
Select "Options"
Select "Picture Size in Bytes"
```

A pop-up window appears with the desired information.

11.6.10 Selecting the screen colour

When the "Picture Editor" is newly called up, the background colour of the window and the symbol library is white.

There are two ways to change this.

Any background colour:

With the method described below, the background colour of the Editor window (but not the symbol library) can be chosen at random.

```

Sample box

Desired background colour
```

then:

```
"Picture Editor" window
Select "Draw"
Select "Screen Colour"
```

If a background colour had already been chosen, it is removed when "Screen Colour" is selected. Only when "Screen Colour" is selected again does the desired screen colour appear.

Example:
The background colour is yellow. A change to blue is made at the sample box.
- First initiation of "Screen Colour":
  The screen becomes white (or black)
- Second initiation of "Screen Colour":
  The screen now becomes blue.
Changing the background from black to white and vice versa:  

<Ctrl B>

<Ctrl B> changes the default background colour (white) in the Editor window and in the symbol library to black, or back again to white. In the Editor window, the function only works if no particular screen colour has been selected using the method described above.

11.6.11 White - Black inversion

<%> changes white to black and vice versa in the following cases:
- Foreground and background colours of graphic figures.
- Foreground and background colours of texts.
- Foreground and background colours of symbols (in the Editor window and in the symbol library).
- A white or black background colour chosen with "Screen Colour."

<%> does not work on the default (white) or on the black window (selected with <Ctrl b>) background colour.

<%> has no effect on the picture and reaction picture presentations. The pictures are presented in the colours in which the picture was effectively drawn.

11.6.12 Redrawing

<Space>
Redraws the picture.
11.7 Symbols

The symbol library consists of 5 separate libraries:

No. 1 (LIB1.PTF): DIN symbols (later EG-Standard symbols).
No. 2 (LIB2.PTF): L&G symbols
No. 3 (LIB3.PTF): ISC symbols (the symbols in this library are needed for displaying pictures which were drawn on ISC units).
No. 4 (LIB4.PTF): MA-specific symbols (e.g. a pump symbol which differs from the ones in library No.1).
No. 5 (LIB5.PTF): Project-specific symbols.

Note: When editing libraries 4 and 5, please take into account that their maximum size is limited to 60,000 bytes (for files LIB4.PTF and LIB5.PTF).

Never, under any circumstances, make changes to symbol libraries No. 1, 2 and 3.

The appendix "List of Symbols" lists all the symbols contained in the libraries 1, 2 and 3.

General remarks:
Depending on the chosen picture background, the symbols drawn in white on black or in black on white are not visible.
<%>, however, inverts the colour display: White becomes black and vice versa.

Concerning library No. 3:
The ISC macros are numbered from 0 to 255. In "Insight," on the other hand, the numbering in all libraries runs from 1 to 256.
The ISC characters, from which the ISC macros are composed, occupy, in the 8:1 zoomed Picture Editor, 5 grid points horizontally and about 6,5 grid points vertically.
11.7.1 Changing to the symbol library

Icon: "Heating Register" (Keyboard: <S>)

"System Library" window

The picture shows the place in the symbol library (library number and page) last used at the current session:

The selection button for the library number used appears with a black spot. The current page number is shown in the middle of the "Picture Editor" title bar. "4/7" means page 4 of a total of 7 pages of this library.

If, at the current session, this is the first entry to the symbol library, page 1 of library No. 1 is displayed.
11.7.2 Changing libraries

Changing from one library to another:

 Desired selection button (1 to 5)

The selection button of the now active library will be shown black, all the others remain white.

At the same time, the display in the title bar of the "Picture Editor" window changes: 5/9 means page 5 of a total of 9 pages of the library concerned. (This is the last-used page of this library at the current session.)

At the first change to a library at the current session, page 1 is displayed.

11.7.3 Scrolling in a library

Forward:

[>]  
The display in the title bar of the "Picture Editor" window changes, for example, from 3/7 to 4/7, or from 7/7 to 1/7.

Backward:

[<]  
The display in the title bar of the "Picture Editor" window changes, for example, from 5/9 to 4/9, or from 1/9 to 9/9.

11.7.4 Exiting from the library

Here, only exiting from the library is described, without the simultaneous insertion of a symbol into the edited picture:

[Cancel]

or:

 Any icon of the "Tool bar"
11.7.5 Defining a symbol

(= adding a symbol to a library.)

Mark in the Picture Editor the graphic figures which together should form a symbol, then:

Icon: "Heating Register" (Keyboard: <S>)

Desired library selection button (1 to 5)

[Insert]

In the procedure described above, the symbol is allocated automatically to the last place of the chosen library and given the lowest number which has never been used. Numbers made free by delete procedures are not used.

If, however, the new symbol has to be allocated to a particular place, for example inserted before the symbol having the number 27, the following procedure must be carried out after library has been chosen:

Symbol No. 27

Symbol No. 27 is now framed by a marking box.

[Insert]

The newly introduced symbol does not receive the number 27, but, as described above, the lowest number not yet used.

The operation "Assign Name" can be used to allocate any free number to a symbol at a later date.

A graphic figure which has been added as a symbol to the library, can be used to carry out the following operations in the Picture Editor:
Moving, enlarging/shrinking, compression/expansion, mirror-imaging and rotation.
On the other hand, its line width and colour can no longer be changed.

If this is desired, the connection to the symbol library must be broken.
In order to be able to use newly added symbols also in the future and on other "Insight" stations for drawing and displaying pictures, the following procedures are necessary:

- Save the symbol library.
- Distribute the symbol library on diskettes or via networks to the various "Insight" stations.

11.7.6 Removing a symbol

(= removing a symbol from the library.)

Symbol to be removed

The symbol in question is now framed with a marking box.

[Delete]

The number of the deleted symbol remains unassigned, i.e. there is no automatic renumbering.

It is possible that existing pictures (also on other "Insight" stations) will access deleted symbols.

As such, symbols should only be deleted when a new library (library Nos. 4 and 5) is being set up.
11.7.7 Assigning a symbol name

This function can be used to assign names and numbers to new symbols, or change the names and numbers of existing symbols.

Mark the respective symbol

[Name]

"Editor: Symbol Name": window

Enter symbol name and free number.

<Enter>

The length of the name must not exceed 8 characters.

If an already occupied number is entered, the old number is retained.

It is possible that existing pictures (also on other "Insight" stations) will access deleted symbols.

As such, symbols should only be deleted and a new symbol allocated to the freed number when a new library (library Nos. 4 and 5) is being set up.
11.7.8 Using a symbol

(= Inserting a symbol into the edited drawing)

 Desired symbol

 ➔ Automatic change in the Picture Editor
 ➔ Marking box

 Position the marking box

 The directional keys can be used for fine positioning

11.7.9 Multi-symbol

This function is required for the updating mode "Symbol Change."

 Desired symbols in the correct order

 Last symbol

 ➔ Automatic change in the Picture Editor
 ➔ Marking box

 Position the marking box

 The directional keys can be used for fine positioning
11.7.10 Breaking a connection

A graphic figure which has been added as a symbol to the symbol library, or a symbol which has been inserted into a picture can be moved, enlarged/shrunk, mirror-imaged, rotated and compressed/expanded. However, it is not possible to change its line width and colour, or to change only parts of the symbol.
If the latter is mandatory, the connection to the symbol library must be broken:

Mark the symbol in the Picture Editor, then

"Picture Editor" window
Select "Symbols"
Select "Break Apart"

The figure in question now no longer has a connection to the symbol library and, as such, cannot be used for the updating mode "Symbol Change."

11.7.11 Changing symbols

To change a symbol from the symbol library, proceed as follows:

- Insert the symbol into a picture.
- Delete the symbol in the library.
- Interrupt the symbol library connection (see above).
  (The symbol has now been broken apart into a number of "normal" graphic figures.)
- Make the desired changes.
- Regroup the graphic figures.
- Add the newly combined graphic figure again to the symbol library.
It is possible that pictures which already exist (even those on other "Insight" stations) will access the symbols in a library.

As such, the removal of symbols and the subsequent reintroduction of a changed symbol should be carried out only when a new library (library Nos. 4 and 5) is being set up. However, if this must be done at a later time, proceed as follows:

- The changed symbol must be assigned the same number as the deleted one (Function: "Assign a name to the symbol")
- Save the symbol library.
- Distribute the symbol library on diskettes or via networks to the various "Insight" stations.

11.7.12 Numbering

When <#> is pressed, the momentarily active symbol library will be newly numbered right through with the currently valid item numbers of the symbols which it contains.

It is possible that pictures which already exist (even those on other "Insight" stations) will access the symbols in a library.

As such, the renumbering of libraries should basically be carried out only when a new library (library Nos. 4 and 5) is being set up.
11.7.13 Loading the library

This function loads the current symbol library from the local hard disk (files LIB1.PTF to LIB5.PTF in the ...\UVI\LIB directory) and thereby revokes all changes which have been made.

"Picture Editor" window
Click on the "Heating Register" icon (<S>)
Select "Symbols"
Select "Load Library"
⇒ Safeguard prompt:

"Are you sure?"

Attention:
If [OK] is actuated, all the changes which had been made in the symbol library will be lost.

11.7.14 Saving the library

This function saves the currently active library to the local hard disk (files LIB1.PTF to LIB5.PTF in the ...\UVI\LIB directory).

"Picture Editor" window
Select "Symbol"
Select "Save Library"
Safeguard prompt:

"Are you sure?"

Attention:
It is possible that pictures which already exist (even those on other "Insight" stations) will access the symbols in a library.

As such, the changing and subsequent saving of libraries should basically be carried out only when a new library (library Nos. 4 and 5) is being set up.

The changed library files must then be distributed on diskettes or via networks to all "Insight" stations.
11.8 Updating

By connecting graphic figures with updating channels, one can "breathe life" into the pictures (into the Picture Reaction Picture layout). The following possibilities are typical examples:

- Displaying the current values operative in the plant, with the aid of texts, changing colours and symbols or changeable bars.
- Selecting support pictures by clicking figures intended for this purpose.
- Starting and stopping tasks.
- Displaying user names.
- Displaying language-dependent texts.

To accomplish updating, certain procedures must be carried out in the "Insight" Picture Editor, and corresponding entries must be made in the COS, ACT DCS dialogue.

This chapter mainly describes the preparation for updating in the "Insight" Picture Editor. Some instructions for operating the VISONIK COS, ACT dialogue are given under "Examples." More detailed descriptions are given in the respective manual.

11.8.1 Channel display

To display all the updating channels or to cancel the display again:

"Picture Editor" window
<Ctrl A> or
Select "Options"
Select "Channel Display"
11.8.2 Assigning channel numbers

Mark the graphic figure concerned, then

Icon: "Bar" (Keyboard <I>)
➡
"Update" window

Entering a channel number, e.g.
"14"
[OK]

If the graphic figure concerned is already connected with an updating channel, its number is displayed in the input field "Channel Number."
Otherwise, the lowest free number is proposed.

Several graphic figures can be updated with a single channel, e.g.:
The updating channel to a positioning command is used simultaneously for updating two bars.

Maximum number of channels:
There are 70 updating channels (No. 1 to 70) available per picture. You can determine the actual number in the COS, ACT dialogue ("Channel Number" question).
11.8.3 Updating supplementary texts

In the VISONIK COS, ACT dialogue, texts can be defined at various places, and be available, irrespective of the selected updating mode:

- Extended parameter information.
- PST
- "Parameter Name"
- "Parameter Long Name"
- Language-dependent supplementary text

COS, ACT:
- Act.Type: "Point"
- Txtlnth: >0 (corresponds to the text definition)

Picture Editor:
These texts appear, left justified, below the updated graphic figure in the "T1" font. As such, no more actions need to be taken in the Picture Editor.

If the updating mode "Text Only" is chosen, procedures to be followed in the Picture Editor are the same as those described under "Language-dependent Text" or "Operator Name."

11.8.4 Language-dependent Text/Operator Name

COS, ACT:
- Act.Type: "Text" or "OperName"
- Txtlnth: >0 (corresponds to the chosen text)
- Text catalogue, possibly Text Number
- Foreground colour, flashing mode

Picture Editor:
- Enter short text or only <Space> with the desired font size and background colour.
- Connect with the updating channel.

The updated text is appended to the (static) text entered in the Editor. The updated text and the static text take over in the Picture window the attributes defined in the COS dialogue for the drawing colour and the flashing mode.
11.8.5 Macro/CB task/Support Picture

**COS, ACT:**
- Act.Type: Macro, CB task or support picture
- Text number from the macrotext catalogue, task number and task command, support picture type and, if necessary, picture number.
- Colour, flashing mode

**Picture Editor:**
- Draw graphic figure
- Connect with the updating channel.

The graphic figure takes over in the Picture window the attributes defined in the COS dialogue for the colour (foreground and background) and the flashing mode. An exception is the "Button" figure, which retains its (grey) colour.

The updating colour sent compulsively by the DCS, covers the entire connected graphic symbol. If this consists of several colours in the static picture, or if it concerns a combined figure (text, flag, entrance doors), a trick must be used:
- Near the figure, draw an equally large back-up area (of any colour).
- Connect the back-up area with the updating channel.
- Move the back-up area to the figure.
- Place the back-up area in the background.

11.8.6 Bars/Markers

(For pool variables or point parameters.)

**COS, ACT:**
- Act'mode: CB pool or point.
- Point address and point parameter or pool variable number.
- Act'mode: Bar
- Start and end of bar.
- Colour and flashing mode.
- TxtInth: >0 if the accompanying text defined in the dialogue must (also) be updated.
Picture Editor:
- Draw the bar or marker (see later in this chapter).
- Connect up with the updating channel.

The bar and the marker take over the flashing attribute from the DCS. Colour is taken on as follows:
Bar: The updated part of the bar takes on the colour.
Marker: The straight line and the foreground of the marker take on the colour.

11.8.7 Colour

(For pool variables or point parameters.)

COS, ACT:
- Act.Type: CB pool or point
- Point address and point parameter or pool variable number.
- Act.Type: Colour
- Colour and flashing mode for the different ranges (for pool variables, parameters with continuous values, and bitset parameters, there is only one range).
- TxtInth: >0 if the accompanying text defined in the dialogue must (also) be updated.

Picture Editor:
- Draw the graphic figure or insert the symbol.
- Connect up with the updating channel.

The graphic figures take on the background colour and the flashing attribute from the DCS. Symbols and texts take on the foreground colour.

Colour change also functions with symbols which have been changed in size, flipped or rotated.
11.8.8 Changing symbols

(For point parameters)

**COS, ACT:**
- Act'mode: Point
- Point address and point parameter.
- Act'mode: Symbol
- Colour and flashing mode for the different ranges (for bitset parameters and parameters with continuous values, there is only one range).
- Txtlnth: >0 if the accompanying text defined in the dialogue must (also) be updated.

**Symbol library:**
- `<M>` ("Multiselect" function)
- At the desired symbols (with the exception of the last) in the correct sequence
- At the last symbol

**Picture Editor:**
- Insert the Multi-Symbol.
- Connect up with the updating channel.

The symbols take on the foreground colour and also the flashing attribute from the DCS.

This updating mode also functions with rotated or flipped symbols. However, it does not function with symbols which have been changed in size.
12. Additional Functions
12.1 Dialogue (Ctrl P)

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Dialogue"

Icon:

Only one dialogue window can be opened at any one time.

"Dialogue" window
<F3> or
Select "Command"
Select "Exit"

Most DCS functions can be carried out in the Dialogue window (Ctrl P-Mode).
Exceptions:
- Output of a Trendplot
- Output of a Data Processing Graph
- Ctrl V-Mode (This is available in the form of the "Point Operation" function.)

Dialogue Files:
Insight creates a Daily file in the directory ...\UVI for each day of the week. This contains all interactions that are carried out during the particular day in the dialogue window, irrespective of how often it is opened and closed.

- Monday: DLGHIST.TX1
- Tuesday: DLGHIST.TX2
  etc.
- Sunday: DLGHIST.TX7

The existing files are overwritten on each of the same days in the following week.
Opening a copy of DLGHIST.TXn:

"Dialogue" window
Select "Command"
Select "Open File"
➡ Window: "SysEdit - ...\UVI\dialogue\dlghist.tmn"

The opened DLGHIST.TMn file is an exact reproduction of the current contents of DLGHIST.TXn.

The window is one of the OS/2 program "System-Editor" windows.
This permits, among other things:
- The viewing of the whole existing dialogue, including long protocols of the day in question.
- Changing and saving to any directory under any name.
- The callup of other text files, especially the dialogue files of previous days.

Never open the file DLGHIST.TXn of the current day with the System Editor.

12.2 Messages

Icon: "Messages" (Envelope)

or

"UNIGYR-VISONIK Insight" window
Select "Function"
Select "Messages"
➡ Window: "Messages"

Icon:

Only one message window can be opened at any one time.
"Messages" window
<F3> or
Select "Command"
Select "Minimize"

Each message with an MPR higher or equal to the Insight beep level, and which arrives when the Message window is closed, sets off an acoustic warning beep. (See under "Installation - Warning Beep" to set the acoustic signal.)

The lines in the Message window have different colours:

**Red:**
Incoming fault messages with a Message Priority (MPR parameter) higher or equal to the set beep level. (See under "Options - Warning Beep")

**Green:**
Acknowledged active fault messages.

**Blue:**
- Incoming fault messages with a Message Priority (MPR parameter) lower than the set beep level. (See under "Options - Warning Beep")
- Outgoing fault messages.
- All other messages.

**Message Files:**
Insight creates a Daily file in the directory ...\UVI for each day of the week. This contains all messages of the particular day, irrespective of how often the Message window had been opened and closed.

- Monday: MSGHIST.TX1
- Tuesday: MSGHIST.TX2
  etc.
- Sunday: MSGHIST.TX7

The existing files are overwritten on each of the same days in the following week.

Opening a copy of MSGHIST.TXn:

"Messages" window
Select "Command"
Select "Open File"
⇒ "SysEdit - msghist.tmn" window
The opened MSGHIST.TMn file is an exact reproduction of the current contents of MSGHIST.TXn.

The window has to do with the "System-Editor" OS/2 program.
This permits, among other things:
- The viewing of all messages on the day in question.
- Changing and saving to any directory under any name.
- The callup of other text files, especially the dialogue files of previous days.

Never open the file MSGHIST.TXn of the current day with the System Editor.

12.3 DILO

In order to change to "DILO," proceed as follows:

"UNIGYR-VISONIK Insight" window
Select "Service"
Select "DILO (BOO,D)"

The following question appears:
"Do you really want to boot the DCS?"

For more detailed instructions on operating DILO, consult the "VISONIK System Tuning" manual.
13. Appendix: Hardware and Software
13.1 Units

The PC model used with "UNIGYR-VISONIK Insight" must at least satisfy the following requirements:

- CPU: 80386
- Frequency: 25 MHz
- Hard disk: 80 MBytes
- Diskette drive: 3.5”, 1.44 MBytes
- Memory: 12 MBytes
- Screen: Super VGA 800x600, 1024x768
- Ports: Centronics (for printer connection and/or Sentinel), V.24 (for direct DCS connection or modem)
- Mouse: Serial or Bus-Mouse
- Printer: With parallel port

13.2 The Sentinel

To operate "UNIGYR-VISONIK Insight," the supplied application-protection plug (Sentinel) must be plugged in at the parallel-port LPT 1. The printer functions are not affected by the Sentinel.

If an attempt is made to start "UNIGYR-VISONIK Insight" without the Sentinel, the relevant information window appears.
Plug in the Sentinel as shown in the above illustration and restart "UNIGYR-VISONIK Insight."

The version number of the Sentinel must agree with that of the "UNIGYR-VISONIK Insight" software. This means that when a new version of "UNIGYR-VISONIK Insight" is installed, a new version of the Sentinel must also be used.

If this is not the case, the following message is displayed: "Wrong Sentinel Version"

Plug in the correct Sentinel and restart "UNIGYR-VISONIK Insight."

### 13.3 Software

**PC operating system:**
IBM OS/2, Version 2.0 or higher.

**VISONIK:**
Version 10.16 or higher.

**UNIGYR-VISONIK Insight:**
Version 04.60.nn
13.4 Cabling

13.4.1 Direct connection

For a direct connection between the DCS and "UNIGYR-VISONIK Insight," the following cables could, for example, be used depending on the type of connectors on both units:

<table>
<thead>
<tr>
<th>Connector at DCS:</th>
<th>Connector at PC:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>25-pole male</td>
</tr>
<tr>
<td>25-pole male</td>
<td>LVE1.2001</td>
</tr>
<tr>
<td>9-pole male</td>
<td>LVE1.2022</td>
</tr>
<tr>
<td></td>
<td>9-pole male</td>
</tr>
<tr>
<td></td>
<td>LVE1.2023</td>
</tr>
<tr>
<td></td>
<td>25-pole female</td>
</tr>
<tr>
<td></td>
<td>LVE1.2023</td>
</tr>
</tbody>
</table>

*** No cable is available for this combination. The connection can be made, for example, with a LVE1.2022 cable and a suitable adapter.
13.4.2 Modem connection

A connection between Insight and a modem can be made as follows:

**PC Port, 25 pole, male:**
Type of cable: LVE1.2009

**PC Port, 25 pole, female:**
Type of cable: LVE1.2008

**PC Port, 9 pole, male:**
An adapter cable with the following pin-to-pin connections must be used:

<table>
<thead>
<tr>
<th>Pin No. of the modem</th>
<th>Pin No. of the Insight PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>5</td>
</tr>
<tr>
<td>8</td>
<td>1</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>22</td>
<td>22</td>
</tr>
</tbody>
</table>
14. Appendix: Installation
14.1 Software Installation

14.1.1 Prerequisites:

The OS/2 operating system has been properly installed and started.

The Super-VGA screen has been installed correctly on the hardware and software sides. (Consult the OS/2 handbook and the instructions of the monitor and graphic card manufactures.)

The drive on which the installation is to be made, has at least 20 MB of free memory available.

OS/2 has been started.

14.1.2 Making a backup copy

If your computer already has an older version of "UNIGYR-VISONIK" installed, make backup copies of all files that you will again need, e.g.:
  - Locally saved pictures.
  - Changed symbol libraries.
  - Data processing files (graphs, tables).
  - Dialogue and message files.

14.1.3 Deleting the old Insight version

Deleting the Insight directory: If your computer already has an older Insight version installed, delete the Insight main directory including all its sub-directories and files.

Delete group and program object: Delete the Insight program object form the "UNIGYR-VISONIK Insight" group. Then delete the group.

Modify CONFIG.SYS: Open the "CONFIG.SYS" file (e.g., with the EPM editor) and find the lines "LIBPATH," "SETPATH" and "DEVICE" according to the directory reference of the deleted version and delete these.

In the following examples, delete the boldface type:

LIBPATH=D:...\UVI\DLL;C:PATHWORKS\BIN;C:...
SETPATH=E:...\VDI2923;C:IBMLAN\NETPROG;C:...
DEVICE=F:INSIGHT4\DLL;OS2SNTNL.SYS
14.1.4 Installing Insight

Insight is installed with the "SW installer." The installation is essentially self-explanatory; help can be requested in each dialogue window.

Be sure to observe the information in the README file in diskette 1.

Proceed as follows:

Insert the "UNIGYR-VISONIK Insight" No. 1 disk into the appropriate drive, then:

Open OS/2 workplace shell "System"
Open "Command Line"
Start "OS/2 Screen"

Before starting the installation program, change to the drive containing the diskette.

Enter the following after the system prompt appears:
"x:"  
<Enter>  
"install" <Enter>

x: stands for the startup drive (a: or b:), in which the "UNIGYR-VISONIK Insight" disk is inserted.

In the first phase of the installation procedure, the program requests some information:

"Install directories" dialogue window:
- Write the desired installation path into the "Executable directory" entry field.
  e.g., E:\INS460
- Using <TAB>, change to the "DLL directory."
  As a result, the entry needed for the above example occurs automatically:
  E:\INS460\DLL
  Do not change this proposal.
"Install" dialogue window:

Answer in the affirmative to the "Update CONFOG.SYS " option, but not to the "Overwrite files" option.

Following confirmation of this window, the installation program independently executes all needed tasks. You will, however, be occasionally requested to change the diskette.

- Setup of the program directory and the necessary sub-directories
- Copying all files to the correct directories.
- Setup of the "UNIGYR-VISONIK" group.
- Setup of "UNIGYR-VISONIK Insight" program object in the above group.
- Carrying out the following adaptations in the "CONFIG.SYS" file.

```
LIBPATH=.;.;.
PATHWORKS\BIN;C:\... 
DEVICE=F:\UINSIGHT4\OS2SNTNL.SYS
```

(in accordance with the path defined above)

Booting OS/2: After successful installation, OS/2 must be booted again.

## 14.2 Configuration Data Take Over

Starting with Insight version 4.33, the configuration data has been stored in the UVI.PRF file. The file was previously named VISONIK.PRF.

**Configuration data take over from VISONIK versions up to and including V4.2:**

- Before newly installing, make a backup copy of VISONIK.PRF.
- Copy this file to the Insight program directory.
- Start the takeover program in an OS/2 window:

```
...\UVI\TAKEOVER.EXE visonik.prf uvi.prf 420 460
```

**Configuration data take over from VISONIK versions from V4.33:**

- Before newly installing, make a backup copy of UVI.PRF.
- Copy this file to the Insight program directory.
14.3 VISONIK network

In order to operate Insight in the system network, you have to create a "SYS.INI" file and enter into it its own system as well as all partner systems with the system prompt and the octal system number.

Example:

Man / $202
Gra / $204
Gub / $220

Note: A space exists before and after the slash mark (/).

14.4 Startup

OS/2 workplace shell
Open "UNIGYR-VISONIK" object
Start "UNIGYR-VISONIK Insight" program
⇒ "UNIGYR-VISONIK Insight window"

14.5 Choice of language

With the procedure described below, only the "UNIGYR-VISONIK Insight" language is changed. To change the language in the DCS too, the function XX must be invoked in the dialogue.

"UNIGYR-VISONIK Insight" window
Select "Options"
Start "Language"
⇒ "Language" pop-up window:
14.6 Choice of character set

"UNIGYR-VISONIK Insight can be operated with character sets for different keyboards:
- ASCII
- Neutral
- Swedish/Finnish
- Norwegian/Danish

Note: The Swedish/Finnish and Norwegian/Danish settings are only needed if you are operating a version V10 of VISONIK. In this case, you have to activate these settings with a manual entry into the "UVI.PRF" file:

```
[UVI_OPTION]
NORDIC_7BIT=yes
```

Procedure for initiating changes in or replacing the character set:

"UNIGYR-VISONIK Insight" window
Select "Options"
Start "Character Conversion"
➡ "Character Conversion" pop-up window:
Select "Desired Character Set"

**ASCII:**
This is the normally used default character set.

**Neutral:**
There is no character conversion. (This option is needed, for example, for Japan.)
The relevant pop-up window appears when S/SF or N/DK is selected:

**S/SF:**

```
<table>
<thead>
<tr>
<th>Character</th>
<th>ASCII</th>
<th>S/Fin</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>[</td>
<td>Å</td>
</tr>
<tr>
<td></td>
<td>\</td>
<td>ö</td>
</tr>
<tr>
<td></td>
<td>{</td>
<td>ä</td>
</tr>
<tr>
<td></td>
<td>91</td>
<td>142</td>
</tr>
<tr>
<td></td>
<td>92</td>
<td>153</td>
</tr>
<tr>
<td></td>
<td>93</td>
<td>143</td>
</tr>
<tr>
<td></td>
<td>123</td>
<td>132</td>
</tr>
<tr>
<td></td>
<td>124</td>
<td>148</td>
</tr>
<tr>
<td></td>
<td>125</td>
<td>134</td>
</tr>
</tbody>
</table>
```
N/DK:

The special characters in the line "S/SF" and "N/DK" can be overwritten (first click at the respective character).

[Default] always restores the original status.

If the contents of the table are correct:
[OK]
14.7 Warning beep

"UNIGYR-VISONIK Insight" window
Select "Options"
Start "Warning Beep"
⇒ "Warning Beep" pop-up window:

![Warning Beep window]

Make the desired selection, then
[OK]

"Beep Level" defines the colour of incoming and outgoing fault messages in the Message window, or when printing with conjunction with the MPR parameter (see below).

"Beep Duration" influences the duration of the beep signal. This always sounds when communications arrive (COMM function); for the other messages, only if the Message window has been minimized.

Parameter MPR is higher or equal to the "Beep Level":
- Incoming fault: Red
- Outgoing fault: Green

Parameter MPR is lower than the "Beep Level":
- Incoming fault: Blue
- Outgoing fault: Blue

The effects are caused solely by entries in the "Warning Beep" window, and not by the value of the parameter "PIPT" in the corresponding V.24-Point ($Tn).
14.8 Colour conversion

"UNIGYR-VISONIK Insight" window
Select "Options"
Select "Colour Conversion"

The selection of "Colour Conversion" influences the colour when printing:

YES: The black colour is printed in white, and vice versa.
NO: The print is made in the original screen colours.

14.9 Background setup

The background colour of UNIGYR-VISONIK is normally white. You can, however, change this:
Proceed as follows:

"UNIGYR-VISONIK Insight" window
Select "Options"
Select "Background"

A window holding a list of the possible colours appears together with two additional options, "Reset" and "Bitmap."

Reset: Returns the background colour to the default setting.
Bitmap: Allows you to select the desired background bitmap in the "Open Bitmapfile" window.

14.10 Automatic loading of a picture when starting Insight

If you wish to have a particular picture appear when you start Insight, then you have to make the relevant entry into the "UVI:PRF file by hand:

[UVI_AUTOSTARTUP]
PIC_AUTOLOAD=YES
PIC_NUMBER=#10
15. Appendix: Printer Installation and Settings
15.1 Printer installation

When installing the printer, also refer to the instructions in the OS/2 handbook.

Instructions follow for installing the two printers which should be used in conjunction with "UNIGYR-VISONIK Insight":
- HP DeskJet 500C, 550C and 560C

Step 1:
Open the "Templates" in the OS/2 workspace:

At "Templates" icon

Step 2:
Drag the "Printer" icon from the "Templates" window to the workspace:

At "Printer object" icon

➡ at the desired location

➡ Window: "Create a Printer Object"

Step 3:
Install the printer driver:

At the desired port
Enter a name for the printer, e.g. "500C," then:

[Install new Printer Driver ...]

⇒ Window: "Install New Printer Driver"

Bring the printer driver to be installed into the window, and mark it:

emies At HP Deskjet 500C ......

[Install]

⇒ Window: "HPDJPM.HP ....."

Insert the required disk, enter the correct drive, then [OK]

Confirm also in the next message window, with [OK]

You are now in the "Create a Printer" window

[Create]

15.2 Printer Settings

15.2.1 Changing the default printer

In order to define a printer as the default printer, proceed as follows:

emies At any printer icon

emies Standard

emies At the desired printer
15.2.2 Changing the printer settings

You can change the settings for your printer as follows:

- At printer icon
- At arrow behind "Open"
- At "Settings"
- "Printer Name Settings" window:
- At "Printer Driver" page
- "HP 550C Settings" window

[Job Properties ...]
- "HP DeskJet Job Properties" window
Enter the desired settings into this screen mask.

[OK]

Close the window above the system control.
16. Appendix: Communication Configuration
The connection with the DCS is always made via a serial port, optionally via a direct link or via a modem. Only one connection is possible at any one time.

In order to secure a connection with the DCS, the correct settings must be made both in the DCS and in "UNIGYR-VISONIK Insight."

In the DCS, these are settings for the following points: (For telephony, see "TIB 53" under "Teleterminal.")

$Tn: TERX, OPTO, BAUD, MCAT, DSEQ, DTYP

$nnn'CO: LSS, MCAT, DSEQ

$nnn'TY: OPTO, TERX

16.1 Configuring a direct connection

Port configuration:

"UNIGYR-VISONIK Insight" window
Select "Communication"
Select "Settings"
⇒ "Port" window

Select the desired port (e.g. "COM2").
[OK]
⇒ "Communication Parameter: COM2" window
Appendix: Communication Configuration

**Communication Parameters: COM2**

<table>
<thead>
<tr>
<th>Connection</th>
<th>Baud Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct</td>
<td>38400</td>
</tr>
<tr>
<td></td>
<td>19200</td>
</tr>
<tr>
<td></td>
<td>9600</td>
</tr>
<tr>
<td></td>
<td>4000</td>
</tr>
<tr>
<td></td>
<td>2400</td>
</tr>
<tr>
<td></td>
<td>1200</td>
</tr>
<tr>
<td></td>
<td>600</td>
</tr>
<tr>
<td></td>
<td>300</td>
</tr>
</tbody>
</table>

**DSEQ**

- **Coupling**: Direct
- **Baud rate**: As defined in $Tn$ of the DCS, e.g. 19200
- **Modem sequence**: Leave empty

![OK]

[OK] attempts to make immediate connection with the involved DCS. If you do not wish to have this, interrupt the connection procedure with [STOP].

**Partner configuration/modification:**

"UNIGYR-VISONIK Insight" window
Select "Communication"
Select "Connect"
=> "VISONIK Connection Startup" window
Appendix: Communication Configuration

Make Connection to VISONIK

ADMINISTRATION
CHEMISTRY
GYMNASIUM
PHYSICS

OK  Cancel  Change  New  Delete

[New] or mark existing entry, then [Change]
⇒ window: "Partner Station"

Partner Station

Name  Physics
Tel. No.
SS No.  128

Port              Max. Wait Time  3  Min
NULL  COM1  COM2
COM3  COM4

Max. Connection Time  60  Min

DSEQ

OK  Cancel
Appendix: Communication Configuration

Name
Enter any name, e.g. "Documentation Center"

Tel. No.
Leave empty

SS No.
Decimal SS number (in-house system number) as defined in SYS,PROJ, e.g.:
"0" for System 0
"130" for System 2 202 (octal)

If you have to operate with "Insight" in a system network, a "SYS.INI" file with entries relating to the connected computer must be available. You will find further information in the "Read me" file.

Port
Port used, e.g. COM2

Max. operation timeout/Max. timeout for data
These entries are not required in the case of direct connection - leave empty.

DSEQ
Leave empty.

[OK]

[OK] causes a return to the last window. From there, the newly defined or modified connection can be established with another [OK].

In this window, it is also possible to define a computer which was not to be connected at the beginning. For this, "NULL" must be marked for the "Port."
16.2 Configuring a modem connection

Port configuration:

"UNIGYR-VISONIK Insight" window
Select "Communication"
Select "Settings"
➡ "Port" window

Select the desired port (e.g. "COM3").
➡ Window: "Communication Parameter: COM3"
Coupling

Baud rate

As desired, e.g. 2400; if necessary, this value is taken over automatically into the "Modemsequence" field.

DSEQ

All modem-specific data required for starting up a connection must be entered here. You can find more details on this under the DSEQ parameter description in the DCS operation manual, and in the following document:
"Phone Software Documentation" dated 22nd October, 1992.

[OK]

A modem initialising now takes place.

Modem configuration:
The modem being used should be configured as follows:

- Command Echo: enabled
- Modem Result Code: enabled (type "words")
- DCD: On only with carrier present
- DTR: Modem should disconnect if it detects an on-to-off transition on DTR
- DSR: on
- Xon/Xoff: Disabled

Partner configuration/modification:

"UNIGYR-VISONIK Insight" window
Select "Communication"
Select "Connect"
⇒ "VISONIK Connection Startup" window
[New] or mark existing entry, then [Change]

⇒ "Partner Station" Window
## Appendix: Communication Configuration

<table>
<thead>
<tr>
<th>Name</th>
<th>Enter any name, e.g. &quot;Production&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tel. No.</td>
<td>Enter the partner's telephone number. The character &quot;:&quot; is the waiting time. Example: 0:041 34 35 36</td>
</tr>
</tbody>
</table>
| SS No.        | Decimal SS number (in-house system number) as defined in S.PROJ, e.g.:
   - "0" for System 0 (octal 300)
   - "130" for System 202 (octal) |
| If you are working in a network, "Insight" must have a "SYS.INI" file with entries relating to the connected computer. You will find further information in the file "Read me." |
| Port          | Port used, e.g. COM3 |
| Max. wait time| Elapsed time until a modem connection break, if this is not used (i.e., if no data exchange is taking place). A warning appears after this elapsed time. If it is not acknowledged, the connection is broken. Otherwise, the wait time is reset. Default wait time: 3 minutes. (0 means no monitoring.) |
| Max. connection time | Maximum duration of a modem connection. When this time has elapsed, a warning appears. If it is not acknowledged, the connection is broken 30 seconds later. Otherwise, the maximum connection time is reset. Default time: 60 minutes. (0 means no monitoring.) |
| DSEQ          | Entry of partner-specific data, for example the decimal number of the connection substation involved (also see the Server Handbook, "Point Types and Parameters”): 2: ;mu=168. |

The DCS can make a call via a modem-connected "Insight," and transmit alarm messages (no pictures, reports, etc.). These alarms go to the "Messages" window.

To allow "Insight" to receive calls from the DCS, the following points must be observed:

- The modem must be configured such that "Auto answer" is switched on. For example, "ATSO=2" must be present in the DSEQ of the appropriate port.
- The parameter MUS must be entered in the file "UVI.PRF" (enter the SS number of "Insight"). The default "0" is not permitted for incoming calls.
16.3 Communications status

Icon:

To find out the communication status, open the relevant icon at the bottom edge of the screen.

➡ Communication Status window

<table>
<thead>
<tr>
<th>Communication Status</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Port</td>
<td>COM2 [9600]</td>
</tr>
<tr>
<td>Partner</td>
<td>Pegasus</td>
</tr>
<tr>
<td>Status</td>
<td>Connection Ok</td>
</tr>
<tr>
<td>No. of Frames</td>
<td>269</td>
</tr>
<tr>
<td>No. of Errors</td>
<td>1</td>
</tr>
<tr>
<td>Time</td>
<td>0 Hrs 54 Min 15 Sec</td>
</tr>
<tr>
<td>Connection Time remaining</td>
<td></td>
</tr>
<tr>
<td>Wait Time remaining</td>
<td></td>
</tr>
</tbody>
</table>

Active port

Indication of the port which is being currently used (COM1, COM2, ...) with the configured baud rate. "NULL" means that there is no port active at the present time.

In the case of connections via modem, the effectively used baud rate can be lower than that specified for the active port.

Partner

Indication of the name of the partner with whom a connection already exists, or will be established.

Status

Current status of the connection:
- No connection:
  Only local work possible.
- Transparent connection:
  Only the "Dialogue" function can communicate, because the computer is currently in DILO.
- Connection OK:
  There is connection with the DCS.
<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of frames</td>
<td>Sum of the received and transmitted dataframes (data packets) since the start of the current connection.</td>
</tr>
<tr>
<td>Number of errors</td>
<td>Number of dataframes which have had a communication error since the start of the current connection.</td>
</tr>
<tr>
<td>Time</td>
<td>Duration of the current connection.</td>
</tr>
<tr>
<td>Remaining connection time</td>
<td>Indicates (for a modem connection) how much time still remains until the maximum connection time is reached.</td>
</tr>
<tr>
<td>Remaining wait time</td>
<td>Indicates (for a modem connection) how much time still remains until the maximum wait time is reached.</td>
</tr>
</tbody>
</table>
17. Appendix: Translation Tools
The three tools described below allow correcting or translating "Insight" system texts.

17.1 Translation tool "EDIVMC"

This is the actual text translation tool. It makes possible the translation of "Insight" system texts into other languages, and the correction of texts.

For the system texts, "UNIGYR-VISONIK Insight" exclusively uses the following three files from the \UVI directory:

- TEXT0.VMC (for language 0)
- TEXT1.VMC (for language 1)
- TEXT2.VMC (for language 2)

The program must not run in the language being translated, i.e. the "UNIGYR-VISONIK Insight" program must not be active.

Furthermore, a file cannot be translated into itself, i.e. the same file cannot simultaneously be the source file and the destination file.

17.1.1 Creating new language files

For example, in order to create a new language file TEXT2.VMC based on TEXT1.VMC, proceed as follows:

Assumptions:
- \UVI is the currently valid directory.
- The file TEXT1.VMC is not in use, i.e. it is not being used by "UNIGYR-VISONIK Insight."

First session:
Translation of
Source file TEXT1.VMC to destination file TEXTA.VMC
Second session:
Translation of
Source file TEXTA.VMC to destination file TEXTB.VMC etc.

When the translation has been completed:
In an OS/2 window:
"COPY TEXTX.VMC TEXT2.VMC"

17.1.2 Correcting language files

For example, some slight corrections must be made to the TEXT0.VMC file.

Assumptions:
- ...
- The file TEXT0.VMC is not in use, i.e. it is not being used by "UNIGYR-VISONIK Insight."

First step:
"Translation" of the source file TEXT0.VMC to the destination file CORR.VMC

Second step:
In an "OS/2 window:
"COPY KORR.VMC TEXT0.VMC"

17.1.3 Starting the translation program

The translation tool "EDIVMC.EXE" was copied to the ...
directory when "UNIGYR-VISONIK Insight" was installed. To start up, proceed as follows.

In the OS/2 full screen:
Change to the directory on which "UNIGYR-VISONIK Insight" is installed:
"Y:"
<Enter>
Change to directory ...
"CD ...
<Enter>
Start the program:
"EDIVMC"
<Enter>
After a few seconds the "EDIVMC" screen appears with
the prompt:
"Please enter text source file:" 
"TEXT2" (source file) 
<Enter>

⇒ "Please enter text destination file:" 
"TRANS1" (destination file) 
<Enter>

While the source file is being loaded, a [W] for "Wait" is displayed on the right hand side of the header bar.

The translation/correction can then begin.

The program extends the file names automatically with the extension .VMC when the above entries are executed.

However, it is quite possible to use your own extensions.
17.1.4 Translating

After startup, three lines appear for the first system text:
1st. line: Text in the source file (Src Text).
2nd. line: New text for the destination file (New Text).

The text displayed in the third line can now be taken over, or a new text entered, e.g.:
"SU"
<Enter>
(Do not use ‘ ’)

The directional keys and <Back Space>, <Del>, <Home> and <End> can be used for editing.

<Esc> Deletes the whole line.

<Ins> Switches the mode from overwrite to paste. The paste mode is indicated in the header bar by [INS].

To mark terms in the OS/2 action bars and menus with underlined letters which allow quick access via the keyboard, the tilde mark must be placed before the desired letter in the text: ~ = <Alt 126>

17.1.5 Commands

The blue bar at the bottom edge of the screen contains the available commands.

<Alt C> Change Mode:
<Alt C> switches from "Skip" translated texts to "Do not skip" and vice versa.

"Do not skip" is indicated in the header bar with [C]. This is also the case when the program is started.

In the case of "Skip," the already translated texts are displayed as follows:
Skip Text <21,4,2> = 'Wednesday'
<Alt A>  Set Address:
Jumps to a particular text address.
<Alt A>

➡
SET = 21: enter new value if desired, then
<Enter>

➡
MSG = 1: enter new value if desired, then
<Enter>

➡
INDEX = 2: enter new value if desired, then
<Enter>

If the entered address exists, it is reached; if not, the next available address is reached.

<Alt S>  Search Text:
Search for a particular text.
<Alt S>

➡
Search of <xx,x,x>: Entry of a search text, then
<Enter>

The program searches from the current address onwards (from "low" address numbers to "high" ones).

If the string is found as a complete or partial string of a text, the program jumps to this address. If, for example, the text "Friday" is not found, the following green message is displayed:

**Text not found "Friday" string**

If a string is not found, although the user is very sure that it must exist somewhere, the reason can be that the text contains a tilde mark (~ = <Alt 126>) which was not entered with the search string.

If it is not known at which point in the text the tilde mark was used, it could help to search for a partial string.

<Alt N>  Next search:
<Alt N> repeats the previous search.

<Alt X>  Exit/Save:
<Alt X> is used to exit from the translation program and to save the modified destination file.
17.2 Text comparison tool UPDVMC

This tool enables texts which have already been translated for older versions of "Insight" to be taken over.

In order to carry out a text comparison, proceed as follows:

During the installation of "UNIGYR-VISONIK Insight," the comparison tool "UPDVMC.EXE" was copied into the directory ...\UVI. To start:

Change to the directory on which the old version of "UNIGYR-VISONIK Insight" had been installed, e.g.:
"Y:"<Enter>
Change to the directory \OLD:
"CD OLD"<Enter>
Copy the old source and destination text files with temporary filenames to the new "Insight" directory, e.g.:
"COPY TEXT0.VMC ...\UVI\GERMOLD.VMC" <Enter>
"COPY TEXT1.VMC ...\UVI\ITALOLD.VMC" <Enter>
Change to the directory on which the new version of "UNIGYR-VISONIK Insight" is installed, e.g.:
"Y:"<Enter>
Change to directory ...\UVI:
"CD UVI"<Enter>
Create a backup copy of the new German text file:
"COPY TEXT0.VMC GERMNEW.VMC" <Enter>
Start the program:
"UPDVMC"
<Enter>

After the start, the program demands the following entries:
Oldgerman Old German text file
Newgerman New German text file
Oldcountry Old file with translated texts
Newcountry Output file
For the above example, enter:
Oldgerman: GERMOLD
Newgerman: GERMNEW
Oldcountry: ITALOLD
Newcountry: ITALNEW

<ENTER>

The tool now attempts to transfer as many translated texts as possible directly to the file "ITALNEW." When this file is translated, only the new texts must be considered.

17.3 Text output tool OUTTEXT

This tool outputs the texts of an "Insight" text file, optionally
- to the screen
- to an ASCII file
- to the printer.

During the installation of "UNIGYR-VISONIK Insight," the output tool "OUTTEXT.EXE" was copied into the ...\UVI directory. To start, proceed as follows:

Change to the directory on which the "UNIGYR-VISONIK Insight" is installed, e.g.:
"Y:" <Enter>
Change to the directory ...\UVI:
"CD UVI" <Enter>

Start the program:
Screen: "OUTTEXT TEXT1.VMC" <Enter>
ASCII file: "OUTTEXT TEXT1.VMC>TEST.TMP <Enter>
Printer: "OUTTEXT TEXT1.VMC>LPT1 <Enter>
18. Appendix: List of Symbols
## 18.1 DIN Symbols  Pages 1/7 and 2/7

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>A0</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>B0</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>C0</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>D0</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>E0</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>F0</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>A1</td>
</tr>
<tr>
<td><img src="image8.png" alt="Image" /></td>
<td>B1</td>
</tr>
<tr>
<td><img src="image9.png" alt="Image" /></td>
<td>C1</td>
</tr>
<tr>
<td><img src="image10.png" alt="Image" /></td>
<td>D1</td>
</tr>
<tr>
<td><img src="image11.png" alt="Image" /></td>
<td>E1</td>
</tr>
<tr>
<td><img src="image12.png" alt="Image" /></td>
<td>F1</td>
</tr>
<tr>
<td><img src="image13.png" alt="Image" /></td>
<td>A2</td>
</tr>
<tr>
<td><img src="image14.png" alt="Image" /></td>
<td>B2</td>
</tr>
<tr>
<td><img src="image15.png" alt="Image" /></td>
<td>C2</td>
</tr>
<tr>
<td><img src="image16.png" alt="Image" /></td>
<td>D2</td>
</tr>
<tr>
<td><img src="image17.png" alt="Image" /></td>
<td>E2</td>
</tr>
<tr>
<td><img src="image18.png" alt="Image" /></td>
<td>F2</td>
</tr>
<tr>
<td><img src="image19.png" alt="Image" /></td>
<td>A3</td>
</tr>
<tr>
<td><img src="image20.png" alt="Image" /></td>
<td>B3</td>
</tr>
<tr>
<td><img src="image21.png" alt="Image" /></td>
<td>C3</td>
</tr>
<tr>
<td><img src="image22.png" alt="Image" /></td>
<td>D3</td>
</tr>
<tr>
<td><img src="image23.png" alt="Image" /></td>
<td>E3</td>
</tr>
<tr>
<td><img src="image24.png" alt="Image" /></td>
<td>F3</td>
</tr>
<tr>
<td><img src="image25.png" alt="Image" /></td>
<td>A4</td>
</tr>
<tr>
<td><img src="image26.png" alt="Image" /></td>
<td>B4</td>
</tr>
<tr>
<td><img src="image27.png" alt="Image" /></td>
<td>C4</td>
</tr>
<tr>
<td><img src="image28.png" alt="Image" /></td>
<td>D4</td>
</tr>
<tr>
<td><img src="image29.png" alt="Image" /></td>
<td>E4</td>
</tr>
<tr>
<td><img src="image30.png" alt="Image" /></td>
<td>F4</td>
</tr>
<tr>
<td><img src="image31.png" alt="Image" /></td>
<td>A5</td>
</tr>
<tr>
<td><img src="image32.png" alt="Image" /></td>
<td>B5</td>
</tr>
<tr>
<td><img src="image33.png" alt="Image" /></td>
<td>C5</td>
</tr>
<tr>
<td><img src="image34.png" alt="Image" /></td>
<td>D5</td>
</tr>
<tr>
<td><img src="image35.png" alt="Image" /></td>
<td>E5</td>
</tr>
<tr>
<td><img src="image36.png" alt="Image" /></td>
<td>F5</td>
</tr>
<tr>
<td><img src="image37.png" alt="Image" /></td>
<td>A6</td>
</tr>
<tr>
<td><img src="image38.png" alt="Image" /></td>
<td>B6</td>
</tr>
<tr>
<td><img src="image39.png" alt="Image" /></td>
<td>C6</td>
</tr>
<tr>
<td><img src="image40.png" alt="Image" /></td>
<td>D6</td>
</tr>
<tr>
<td><img src="image41.png" alt="Image" /></td>
<td>E6</td>
</tr>
<tr>
<td><img src="image42.png" alt="Image" /></td>
<td>F6</td>
</tr>
</tbody>
</table>
DIN Symbols  Pages 3/7 and 4/7
Appendix:
List of Symbols

DIN Symbols  Pages 5/7 and 6/7

8522OF5

8522OF6
18.2 L&G Symbols
Appendix:
List of Symbols

18.3 ISC Symbols  Pages 1/9 and 2/9

8522OG1

CM2B8523E  UNIGYR VISONIK Insight  March 1995
## ISC Symbols

### Pages 3/9 and 4/9

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Symbol 1" /></td>
<td>44</td>
</tr>
<tr>
<td><img src="image2" alt="Symbol 2" /></td>
<td>45</td>
</tr>
<tr>
<td><img src="image3" alt="Symbol 3" /></td>
<td>46</td>
</tr>
<tr>
<td><img src="image4" alt="Symbol 4" /></td>
<td>47</td>
</tr>
<tr>
<td><img src="image5" alt="Symbol 5" /></td>
<td>48</td>
</tr>
<tr>
<td><img src="image6" alt="Symbol 6" /></td>
<td>49</td>
</tr>
<tr>
<td><img src="image7" alt="Symbol 7" /></td>
<td>50</td>
</tr>
<tr>
<td><img src="image8" alt="Symbol 8" /></td>
<td>51</td>
</tr>
<tr>
<td><img src="image9" alt="Symbol 9" /></td>
<td>52</td>
</tr>
<tr>
<td><img src="image10" alt="Symbol 10" /></td>
<td>53</td>
</tr>
<tr>
<td><img src="image11" alt="Symbol 11" /></td>
<td>54</td>
</tr>
<tr>
<td><img src="image12" alt="Symbol 12" /></td>
<td>55</td>
</tr>
<tr>
<td><img src="image13" alt="Symbol 13" /></td>
<td>56</td>
</tr>
<tr>
<td><img src="image14" alt="Symbol 14" /></td>
<td>57</td>
</tr>
<tr>
<td><img src="image15" alt="Symbol 15" /></td>
<td>58</td>
</tr>
<tr>
<td><img src="image16" alt="Symbol 16" /></td>
<td>59</td>
</tr>
<tr>
<td><img src="image17" alt="Symbol 17" /></td>
<td>60</td>
</tr>
<tr>
<td><img src="image18" alt="Symbol 18" /></td>
<td>61</td>
</tr>
<tr>
<td><img src="image19" alt="Symbol 19" /></td>
<td>62</td>
</tr>
<tr>
<td><img src="image20" alt="Symbol 20" /></td>
<td>63</td>
</tr>
<tr>
<td><img src="image21" alt="Symbol 21" /></td>
<td>64</td>
</tr>
<tr>
<td><img src="image22" alt="Symbol 22" /></td>
<td>65</td>
</tr>
<tr>
<td><img src="image23" alt="Symbol 23" /></td>
<td>66</td>
</tr>
<tr>
<td><img src="image24" alt="Symbol 24" /></td>
<td>67</td>
</tr>
<tr>
<td><img src="image25" alt="Symbol 25" /></td>
<td>68</td>
</tr>
<tr>
<td><img src="image26" alt="Symbol 26" /></td>
<td>69</td>
</tr>
<tr>
<td><img src="image27" alt="Symbol 27" /></td>
<td>70</td>
</tr>
<tr>
<td><img src="image28" alt="Symbol 28" /></td>
<td>71</td>
</tr>
<tr>
<td><img src="image29" alt="Symbol 29" /></td>
<td>72</td>
</tr>
<tr>
<td><img src="image30" alt="Symbol 30" /></td>
<td>73</td>
</tr>
<tr>
<td><img src="image31" alt="Symbol 31" /></td>
<td>74</td>
</tr>
<tr>
<td><img src="image32" alt="Symbol 32" /></td>
<td>75</td>
</tr>
<tr>
<td><img src="image33" alt="Symbol 33" /></td>
<td>76</td>
</tr>
<tr>
<td><img src="image34" alt="Symbol 34" /></td>
<td>77</td>
</tr>
<tr>
<td><img src="image35" alt="Symbol 35" /></td>
<td>78</td>
</tr>
<tr>
<td><img src="image36" alt="Symbol 36" /></td>
<td>79</td>
</tr>
<tr>
<td><img src="image37" alt="Symbol 37" /></td>
<td>80</td>
</tr>
<tr>
<td><img src="image38" alt="Symbol 38" /></td>
<td>81</td>
</tr>
<tr>
<td><img src="image39" alt="Symbol 39" /></td>
<td>82</td>
</tr>
<tr>
<td><img src="image40" alt="Symbol 40" /></td>
<td>83</td>
</tr>
<tr>
<td><img src="image41" alt="Symbol 41" /></td>
<td>84</td>
</tr>
<tr>
<td><img src="image42" alt="Symbol 42" /></td>
<td>85</td>
</tr>
<tr>
<td><img src="image43" alt="Symbol 43" /></td>
<td>86</td>
</tr>
<tr>
<td><img src="image44" alt="Symbol 44" /></td>
<td>87</td>
</tr>
<tr>
<td><img src="image45" alt="Symbol 45" /></td>
<td>88</td>
</tr>
<tr>
<td><img src="image46" alt="Symbol 46" /></td>
<td>89</td>
</tr>
<tr>
<td><img src="image47" alt="Symbol 47" /></td>
<td>90</td>
</tr>
<tr>
<td><img src="image48" alt="Symbol 48" /></td>
<td>91</td>
</tr>
<tr>
<td><img src="image49" alt="Symbol 49" /></td>
<td>92</td>
</tr>
<tr>
<td><img src="image50" alt="Symbol 50" /></td>
<td>93</td>
</tr>
<tr>
<td><img src="image51" alt="Symbol 51" /></td>
<td>94</td>
</tr>
<tr>
<td><img src="image52" alt="Symbol 52" /></td>
<td>95</td>
</tr>
<tr>
<td><img src="image53" alt="Symbol 53" /></td>
<td>96</td>
</tr>
<tr>
<td><img src="image54" alt="Symbol 54" /></td>
<td>97</td>
</tr>
</tbody>
</table>
ISC Symbols  Pages 5/9 and 6/9
ISC Symbols   Pages 7/9 and 8/9
### ISC Symbols

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>201</td>
<td>202</td>
<td>203</td>
<td>204</td>
</tr>
<tr>
<td>205</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>206</td>
<td>207</td>
<td>208</td>
<td>209</td>
<td>210</td>
</tr>
<tr>
<td>211</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>212</td>
<td>213</td>
<td>214</td>
<td>215</td>
<td>216</td>
</tr>
<tr>
<td>217</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>218</td>
<td>219</td>
<td>220</td>
<td>221</td>
<td>222</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>223</td>
</tr>
</tbody>
</table>

8522OG9
19. Appendix: Insight System Messages
19.1 Communication

During the modem initialisation and the making and breaking of a connection, a window with the following contents appears:

Active port: A connection is made or broken on this port.
Maximum wait time: This indicates the maximum time that the status in question continues to exist. "0" means that there is no time limit.
Status texts: These texts are not fault messages but only information about the progress of the making and breaking of a connection. If Insight really does detect a fault, a message is subsequently communicated.

[STOP] key: When this key is pressed, the currently ongoing making and breaking of a connection is interrupted. However, an interruption in breaking a connection does not disable the connection break, but only the renewal of the modem initialisation process. The making of a connection on the other hand is always interrupted. In the case of a modem coupling, the port remains active.

19.1.1 Status texts

**Power up**
The port has not yet been initialized.

**No connection**
The modem is ready but there is no connection.

**Modem initialisation 1...6**
The modem initialisation takes place in several steps.

**Sending dial sequence**
The dial sequence is sent.

**Waiting for line...**
Dialling and waiting for connection.

**Line here**
The partner has responded.
Modem failure
A fault has been discovered in the modem.

Incoming call?
A call has possibly arrived.
(The modem signals an incoming call)

Termination steps 1...4
The termination takes place in several steps.

Identification request
The identification is exchanged. This can take up to 30 seconds.

Protocol switches 1 and 2
The change in the protocol mode takes place in two steps.

Substation number request
Waiting for SS number
Invalid SS number
No Tele SS
SS busy
These five statuses arise only when there are configuration errors.

19.1.2 Fault messages

When the communication software detects a fault, an appropriate message appears. This must be acknowledged.

Carrier Signal (DCD) Lost/Connection Dropped
The carrier signal has vanished.
Causes:
- The partner has hung up.
- The telephone line is interrupted.
- The modem was switched off.

Carrier Signal (DCD) Still High
The carrier signal does not vanish in spite of the drop attempt.
➡ Check if the connection could really be dropped.
Causes:
- Defective modem
- Incorrect configuration of the modem.
Modem Signal (CTS) Missing
The CTS signal is missing.
Causes:
- No modem
- Defective modem
- Modem not switched on.
- Wrong cable for link to the modem.

Partner Modem doesn’t Answer
The partner station does not respond, or the dialling did not function.
Causes:
- The partner modem is not configured correctly. (Auto-Answer is not switched on.)
- The partner modem and/or the partner is not switched on.
- The maximum wait time 'wc' was configured too short in DSEQ; the wait time elapses before the partner responds. (The default is 45 seconds.)
- A wrong telephone number has been programmed.
- The dialled number is disabled on the local modem (DIAL LOCKED)

No Valid Identification Received
The partner has not sent a valid configuration.
Causes:
- The partner is not a VISONIK System.
- Configuration error
- The connection is improper, preventing communication (e.g. differing baud rates).

Invalid Address (configuration error)
The address which the partner sends does not correspond to his own SS number (MUS).
Causes:
- Incorrect configuration of the communication. (MUS in UVI.PRF and 'mu' in DSEQ of the partner configuration.)
- The DCS is incorrectly configured.

Invalid Sender (configuration error)
The sender sent by the partner does not correspond to the expected value (SS number of the partner).
Causes:
- Incorrect configuration of the communication. (SS number in partner configuration)
- The partner entry is missing.
Unknown Type of Partner
The partner is not a DCS.
Cause:
- Incorrect configuration

Invalid Substation Number
The partner responds with an invalid SS number.
Cause:
- The partner is not configured.

Partner Modem Busy
The modem has discerned the busy signal.

No Dialtone
The modem discerns no dial tone after response.
Cause:
- The modem is not connected to a telephone socket.

Incompatible Baud Rate
The two modems cannot agree on a common baud rate.
Cause:
- Incompatible modems
- Incorrectly configured modems
- Bad telephone line (try again)

Line Disturbed
The telegrams are no longer acknowledged.
Causes:
- The telephone line has been interrupted.
- The partner no longer answers.
- Not all of the characters are transmitted (e.g. Xon/Xoff is switched on).

Modem Not Ready
The modem is not ready for a making a connection.
Causes:
- The modem initialisation is still proceeding (try again).
- The incoming call is being processed (try again)
- The modem is defective, switched off or not connected.

Incompatible Protocol
The partners cannot agree on a common data protocol.
Cause:
- The partner is not a DCS.

Crossed line
Simultaneously incoming and outgoing call.
Invalid Configuration
The telephony software has detected an invalid configuration.
Cause:
- The partner, which is coupled by a modem, has no telephone number.

Drop a Connection During Startup
A connection was dropped by the user.
Cause:
- The [STOP] key was pressed in the "Make a Connection" window.

No Answer from Direct Partner
The directly coupled partner does not answer.
Causes:
- The connection to the DCS is broken.
- The DCS is in DILO.
- The DCS is switched off.

Transparent Connection
The directly coupled partner has not communicated; a transparent connection was made.
Cause:
- See under "No Answer from Direct Partner."

End of Transparent Connection
The DCS has made a communication during the transparent connection. There is now a normal connection.
Causes:
- The connection to the DCS was made.
- The DCS was booted.

Communication Port cannot be Initialised
The communication software cannot access to the port.
Causes:
- The port does not exist.
- The port is being used by another program.
- The computer no longer has enough memory capacity.

DCS Does Not Answer
BOO,D cannot be sent.

Communication Protocol Switched Off
Only a simple ASCII operation is possible.
Causes:
- Someone has executed BOO,D.
- A telephone communication is carried out manually.
Communications System is Not Active
Error in the communication software. Restart “Insight.” If message is repeated, inform LG Support (error message).

19.2 Error messages relating to functions

General note:
If you cannot not be able to find an error message in this catalogue, consult the operator manual for the DCS.

19.2.1 Picture Editor

Invalid Text Operation
An attempt was made to flip or rotate text figures or figures which contain text.

Picture has less than 4000 bytes reserve
The maximum picture size of 65kB for the local save operation will soon be reached.
(There are only 2900 bytes available for saving to the DCS.)

Picture too big, cannot be loaded.
You have attempted to save a picture locally, the size of which exceeds 65kB.

19.2.2 Data processing

Error in file operation
A file cannot be opened or closed. This is an OS/2 or “Insight” problem.

Memory used up
There is too little memory capacity in the RAM.
19.2.3 Dialogue/Messages

Communication not installed
or
Message Window/Message File/VISONIK Dialogue cannot be opened
or
Message Window/Message File/VISONIK Dialogue cannot be installed
It was not possible to allocate RAM here.
Start UVI anew.

Invalid Operation Name
or
Invalid Operation Type
Program error in the Insight code.
Inform LG Support (error message).

Invalid Data Packet
Program error in the DCS or Insight code.
Inform LG Support (error message).

An Emergency Message File has been made
The requested directory does not exist or is not accessible. The desired text file cannot be found.

Please exit the Operator Task properly first.
With a DSS, you have not exited properly (<Ctrl E>) from the operator task.

No data source
The history files (DLGHIST.TXn and MSGHIST.TXn) are missing. Inform LG Support (error message).

This file cannot be copied
The PC operating system cannot copy a file.

.... cannot be opened
An OS/2 command cannot be executed. Check the OS/2 installation.
19.2.4 Point Operation

Please check or reselect input
You have made a syntax error when entering the address or have entered a non-existent parameter name with "GoTo." Check your input.

ASL Protocol error
An error has occurred during transport from the DCS. Repeat the last operation.

Invalid function access
The access level of the registered user is too low for the selected function.

Command cannot be carried out
The previous command was not completed correctly. Wait till the hour-glass disappears.

19.2.5 Timeswitch Catalogue/Calendar

Error during loading/saving ....
A transport error has occurred. Repeat the function.

Error in File Operation ....
The given file could not be found because you have entered a wrong filename or a non-existent directory.

File overflow
The memory in the DCS is used up. Provide capacity by linking files (Dialogue, EDI, LINK)

No data source
or
No file access
The given file is not in the DCS or the relevant SS is not configured.
19.2.6 General error messages

Invalid Function/Option
or
Program/Structure error
Programming error in the DCS or Insight Code. Inform LG Support (error message).

Unknown event
Programming error in the DCS, SS or Insight Code. Inform LG Support (error message).
20. Appendix: Index
Index

A
Acknowledgement of Alarms ........................................... 148
Activate BPS Destination ............................................ 71
Activating Trend Plot .................................................. 121
Activating Updating Channels ......................................... 42
Address Selection for Point Operation ............................... 53
Alarm List, Data Creation ............................................. 144
Alarm List, Layout Types ............................................... 145
Alarm List, Printing .................................................... 149
Alarm List, Selection .................................................. 146
Alarm List, Sorting .................................................... 147
Alarm Operation, Updating ............................................ 143
Alarm Operation, Exiting .............................................. 142
Alarm Operation, Overview ............................................ 21
Alarm Operation, Point Information ................................. 150
Alarm Operation, Starting ............................................. 142
Aligning the DCS .......................................................... 151
Alarms, Acknowledgement .............................................. 148
Aligning Graphic Figures ............................................... 188
All Figures, Marking .................................................... 181
Arc, Drawing .................................................................. 174
ASCII Character Set ...................................................... 232
Assigning a Symbol Name .............................................. 203
Assigning Updating Channel Number ............................... 209
Automatic picture loading .............................................. 236
Auxiliary tools, Picture Editor ......................................... 191

B
Background Colour, Changing .......................................... 37
Background colours ...................................................... 236
Background, Selection ................................................... 184
Backup File .................................................................. 166
Bar, Drawing .................................................................. 175
Bars, Updating ............................................................. 211
Beep Duration .............................................................. 235
Beep Level .................................................................. 235
Booking the DCS .......................................................... 219
BPS Changed Operating Time .......................................... 72
BPS Default Value, Change ............................................. 82
BPS Default Values, Change ............................................ 94
BPS Destination, Activate ............................................... 71
BPS Destination, Configure ............................................. 70
BPS Destination Cyclic Output ......................................... 71
BPS Destination, Define ................................................ 70
BPS Destination Type .................................................... 71
Breaking a Symbol Connection ......................................... 205
Breaking Graphic Figures ............................................... 181
Breaking the Connection ............................................... 16
Buffer Size, Trend Plot .................................................. 126
Button, Drawing ........................................................... 176

C
Cable ............................................................................ 224
Calendar, Exiting .......................................................... 102
Calendar Groups .......................................................... 103
Calendar in Timeswitch Catalogue .................................... 99
Calendar, Jumping ....................................................... 108
Calendar, Loading ........................................................ 104
Calendar, Overview ...................................................... 26
Calendar, Scrolling ....................................................... 108
Calendar, Starting ....................................................... 102

Calendars, Distributing .................................................. 103
Calendar, storing .......................................................... 106
Call up OVC/EXC .......................................................... 86
Call up, plant description ................................................. 40a
Call up WDC ............................................................... 73
Calling up reaction pictures ............................................. 45
CB Task Commands, Updating ........................................ 211
Cell Pairs for OVC, Marking ........................................... 90
Cell Pairs WDC, Marking ............................................... 77
Centering Graphic Figures .............................................. 188
Change Default Values, BPS .......................................... 94
Change Defaults BPS ..................................................... 82
Change plant description ................................................ 168a
Change Times and values, EXC BPS ................................. 95
Change Times and Values, OVC PRV1 ................................ 91
Change Times and values, WDC BPS ............................... 82
Change Times EXC BPS ................................................ 97
Change Times WDC BPS ............................................... 84
Changed Operating Time* ............................................... 72
Changing a Symbol ........................................................ 205
Changing Parameter Values, Picture Display ...................... 43
Changing Point Operation Parameter Values ..................... 56
Changing PRV1 Default Values ....................................... 91
Changing the Background Colour .................................... 37
Changing the Symbol Library ......................................... 200
Changing Times and Values of WDC PRV1 ....................... 79
Changing Times for WDC PRV1 ....................................... 81
Changing Times, OVC PRV1 ........................................... 93
Changing to the Symbol Library ..................................... 199
Channel Definition, Trend Plot ....................................... 125
Channel Display, Picture Editor ....................................... 208
Channel Number, Assigning .......................................... 209
Channels, activating ..................................................... 42
Channels, marking ........................................................ 41
Channels, unhiding ....................................................... 41
Character Set, Selection ................................................ 232
Choice of Character Set ................................................ 232
Choice of Language ..................................................... 231
Circle, Drawing ............................................................ 172
Clearing the Screen ..................................................... 195
Clock, Drawing ............................................................ 174
Colour Conversion, Setting ............................................ 236
Colour Updating ........................................................... 212
Colours for Drawing, Selection ....................................... 183
Combining Graphic Figures ............................................ 181
Communication Status .................................................. 252
Compressing Graphic Figures ......................................... 187
Compression, Picture Editor .......................................... 193
Configuration, Partner .................................................. 245
Configuration, partner modem ........................................ 249
Configure BPS Destination ............................................. 70
Configure Destination .................................................... 70
Configuring a direct Connection ...................................... 244
Configuring a modem Port ............................................. 248
Conflicting Entries, OVC ............................................... 87
Conflicting WDC entries ............................................... 74
Connect ................................................................. 15
Connecting Cable ........................................................ 224
Connection, Breaking ................................................... 16
Connection, direct, Configuring ....................................... 244
Connection Time, Maximum ........................................... 251
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection to a Symbol, Breaking</td>
<td>205</td>
</tr>
<tr>
<td>Connection via Modern, Configuring</td>
<td>248</td>
</tr>
<tr>
<td>Conversion into a Clock</td>
<td>174</td>
</tr>
<tr>
<td>Coordinates Display</td>
<td>195</td>
</tr>
<tr>
<td>Copying Graphic Figures</td>
<td>185</td>
</tr>
<tr>
<td>Copying Picture Editor</td>
<td>167</td>
</tr>
<tr>
<td>Copying WDC Entries</td>
<td>85</td>
</tr>
<tr>
<td>Create plant description</td>
<td>168a</td>
</tr>
<tr>
<td>Cutting Graphic Figures</td>
<td>185</td>
</tr>
<tr>
<td>Cyclic Output</td>
<td>71</td>
</tr>
<tr>
<td>Danish/Norwegian Character Set</td>
<td>232</td>
</tr>
<tr>
<td>Data Creation, Alarm List</td>
<td>144</td>
</tr>
<tr>
<td>Dataprocessing, Exiting</td>
<td>130</td>
</tr>
<tr>
<td>Dataprocessing Graphs, Loading</td>
<td>131</td>
</tr>
<tr>
<td>Dataprocessing Graphs, Modification</td>
<td>134</td>
</tr>
<tr>
<td>Dataprocessing Graphs, Saving</td>
<td>135</td>
</tr>
<tr>
<td>Dataprocessing, Legends</td>
<td>135</td>
</tr>
<tr>
<td>Dataprocessing, Overview</td>
<td>24</td>
</tr>
<tr>
<td>Dataprocessing, Printing</td>
<td>136</td>
</tr>
<tr>
<td>Dataprocessing, Scale Lengths</td>
<td>134</td>
</tr>
<tr>
<td>Dataprocessing, Settings</td>
<td>138</td>
</tr>
<tr>
<td>Dataprocessing, Starting</td>
<td>130</td>
</tr>
<tr>
<td>Dataprocessing, Table</td>
<td>135</td>
</tr>
<tr>
<td>Dataprocessing, Table, Font,</td>
<td>137</td>
</tr>
<tr>
<td>Dataprocessing, Table Saving</td>
<td>137</td>
</tr>
<tr>
<td>Days, Identification</td>
<td>76</td>
</tr>
<tr>
<td>DCS, Booting</td>
<td>219</td>
</tr>
<tr>
<td>Deactivate BPS Destination</td>
<td>71</td>
</tr>
<tr>
<td>Default value change BPS</td>
<td>82</td>
</tr>
<tr>
<td>Default Values, Change BPS</td>
<td>94</td>
</tr>
<tr>
<td>Default Values for PRV1, Changing</td>
<td>91</td>
</tr>
<tr>
<td>Defaults, Change BPS</td>
<td>82</td>
</tr>
<tr>
<td>Define BPS Destination</td>
<td>70</td>
</tr>
<tr>
<td>Defining a Destination</td>
<td>69</td>
</tr>
<tr>
<td>Defining a Symbol</td>
<td>201</td>
</tr>
<tr>
<td>Defining PRV1 Destination</td>
<td>69</td>
</tr>
<tr>
<td>Defining Special Days</td>
<td>108</td>
</tr>
<tr>
<td>Delete EXC Entries</td>
<td>98</td>
</tr>
<tr>
<td>Delete WDC Entries</td>
<td>85</td>
</tr>
<tr>
<td>Deleting a Symbol</td>
<td>202</td>
</tr>
<tr>
<td>Deleting Graphic Figures</td>
<td>185</td>
</tr>
<tr>
<td>Deleting Picture Editor</td>
<td>168a</td>
</tr>
<tr>
<td>Deleting Reaction Pictures</td>
<td>47</td>
</tr>
<tr>
<td>Deleting Special Days</td>
<td>108</td>
</tr>
<tr>
<td>Depiction, Trend Plot</td>
<td>126</td>
</tr>
<tr>
<td>Description protection</td>
<td>168b</td>
</tr>
<tr>
<td>Destination, activate</td>
<td>71</td>
</tr>
<tr>
<td>Destination, Cyclic Output</td>
<td>71</td>
</tr>
<tr>
<td>Destination, Defining</td>
<td>69</td>
</tr>
<tr>
<td>Destination Function, Navigation</td>
<td>155</td>
</tr>
<tr>
<td>Destination, Selection</td>
<td>69</td>
</tr>
<tr>
<td>Destination Type</td>
<td>71</td>
</tr>
<tr>
<td>Dialogue, exiting</td>
<td>216</td>
</tr>
<tr>
<td>Dialogue Files</td>
<td>216</td>
</tr>
<tr>
<td>Dialogue, Overview</td>
<td>25</td>
</tr>
<tr>
<td>Dialogue, Starting</td>
<td>216</td>
</tr>
<tr>
<td>DILO</td>
<td>219</td>
</tr>
<tr>
<td>DIN Symbols</td>
<td>264</td>
</tr>
<tr>
<td>Direct connection</td>
<td>16</td>
</tr>
<tr>
<td>Direct Connection, Configuring</td>
<td>244</td>
</tr>
<tr>
<td>Display of Coordinates</td>
<td>195</td>
</tr>
<tr>
<td>Display Period, Trend Plot</td>
<td>124</td>
</tr>
<tr>
<td>Displaying Updating Channel in Picture Editor</td>
<td>208</td>
</tr>
<tr>
<td>Distributing Calendars</td>
<td>103</td>
</tr>
<tr>
<td>DLGHIST.TXT</td>
<td>216</td>
</tr>
<tr>
<td>Downloading locally saved pictures</td>
<td>40</td>
</tr>
<tr>
<td>Downloading locally, Timeswitch Catalogue</td>
<td>65</td>
</tr>
<tr>
<td>Downloading, Timeswitch Catalogue</td>
<td>63</td>
</tr>
<tr>
<td>Draw, Text</td>
<td>172</td>
</tr>
<tr>
<td>Drawing</td>
<td>168b</td>
</tr>
<tr>
<td>Drawing a Bar</td>
<td>175</td>
</tr>
<tr>
<td>Drawing a Button</td>
<td>176</td>
</tr>
<tr>
<td>Drawing a Circle</td>
<td>172</td>
</tr>
<tr>
<td>Drawing a Clock</td>
<td>174</td>
</tr>
<tr>
<td>Drawing a Marker</td>
<td>176</td>
</tr>
<tr>
<td>Drawing a Polygon</td>
<td>170</td>
</tr>
<tr>
<td>Drawing a Polyline</td>
<td>170</td>
</tr>
<tr>
<td>Drawing a Rectangle</td>
<td>171</td>
</tr>
<tr>
<td>Drawing a Rounded Rectangle</td>
<td>171</td>
</tr>
<tr>
<td>Drawing a Sector</td>
<td>174</td>
</tr>
<tr>
<td>Drawing a Straight Line</td>
<td>169</td>
</tr>
<tr>
<td>Drawing an Arc</td>
<td>174</td>
</tr>
<tr>
<td>Drawing an Ellipse</td>
<td>172</td>
</tr>
<tr>
<td>Drawing an Open Polygon</td>
<td>170</td>
</tr>
<tr>
<td>Drawing an Oval</td>
<td>171</td>
</tr>
<tr>
<td>Drawing Colour, Selection</td>
<td>183</td>
</tr>
<tr>
<td>DSEQ modem</td>
<td>249</td>
</tr>
<tr>
<td>DSEQ partner</td>
<td>251</td>
</tr>
<tr>
<td>Dynamic Scale</td>
<td>134</td>
</tr>
<tr>
<td>Days, Identification</td>
<td>76</td>
</tr>
<tr>
<td>Dialog, starting</td>
<td>216</td>
</tr>
<tr>
<td>Delete EXC Entries</td>
<td>98</td>
</tr>
<tr>
<td>Delete WDC Entries</td>
<td>85</td>
</tr>
<tr>
<td>Deleting a Symbol</td>
<td>202</td>
</tr>
<tr>
<td>Deleting Graphic Figures</td>
<td>185</td>
</tr>
<tr>
<td>Deleting Picture Editor</td>
<td>168a</td>
</tr>
<tr>
<td>Deleting Reaction Pictures</td>
<td>47</td>
</tr>
<tr>
<td>Deleting Special Days</td>
<td>108</td>
</tr>
<tr>
<td>Depiction, Trend Plot</td>
<td>126</td>
</tr>
<tr>
<td>Description protection</td>
<td>168b</td>
</tr>
<tr>
<td>Destination, activate</td>
<td>71</td>
</tr>
<tr>
<td>Destination, Cyclic Output</td>
<td>71</td>
</tr>
<tr>
<td>Destination, Defining</td>
<td>69</td>
</tr>
<tr>
<td>Destination Function, Navigation</td>
<td>155</td>
</tr>
<tr>
<td>Destination, Selection</td>
<td>69</td>
</tr>
<tr>
<td>Destination Type</td>
<td>71</td>
</tr>
<tr>
<td>Dialogue, exiting</td>
<td>216</td>
</tr>
<tr>
<td>Dialogue Files</td>
<td>216</td>
</tr>
<tr>
<td>Dialogue, Overview</td>
<td>25</td>
</tr>
<tr>
<td>Dialogue, Starting</td>
<td>216</td>
</tr>
<tr>
<td>DILO</td>
<td>219</td>
</tr>
<tr>
<td>DIN Symbols</td>
<td>264</td>
</tr>
<tr>
<td>Direct connection</td>
<td>16</td>
</tr>
<tr>
<td>Direct Connection, Configuring</td>
<td>244</td>
</tr>
<tr>
<td>Display of Coordinates</td>
<td>195</td>
</tr>
<tr>
<td>Display Period, Trend Plot</td>
<td>124</td>
</tr>
</tbody>
</table>
Exiting from Trend Plot ........................................ 114
Exiting from WDC ............................................ 74
Expanding Graphic Figures .................................... 187
Expansion, Picture Editor ..................................... 193
Export File, Trend Plot ....................................... 118

Graphic Figures, Superimposing ............................ 182
Graphic Figures, Unite ....................................... 181
Grid Lines ..................................................... 194

H
Hardware Requirements ...................................... 222
Hiding Graphic Figures ....................................... 188

I
Icons .................................................................. 2
Identification of Days ......................................... 76
Indicating the Picture Size .................................... 196
Individual Calendars .......................................... 103
Information on Software ...................................... 20
Initialising the Modem ......................................... 17
Initiate Navigation ............................................. 155
Input, Password ................................................ 18
Input, User Code ................................................ 18
Insight, Exiting .................................................. 14
Insight, Starting ................................................ 14
Installation Program, Starting .............................. 229
Installing the Printer .......................................... 238
Inversion, White/Black ......................................... 197
ISC Symbols ..................................................... 269

J
Jumping the Calendar .......................................... 108
Jumping the SDC List .......................................... 110

L
L&G Symbols .................................................... 268
Language, Choice .............................................. 231
Language-dependent Text, Display ....................... 210
Lasso Method .................................................... 178
Last Reaction Picture .......................................... 46
Layout Types, Alarm List ...................................... 145
Legends, Dataprocessing ...................................... 135
Library, Changing .............................................. 200
Library, Exiting ................................................ 200
Library, Loading ............................................... 207
Library, Numbering .......................................... 206
Library, Saving ................................................ 207
Library, Scrolling .............................................. 200
Line Width, Selecting .......................................... 182
List, SDC ......................................................... 109
Loading Dataprocessing Graphs ............................ 131
Loading picture automatically .............................. 236
Loading Picture, Picture Editor ............................. 163
Loading the Calendar ......................................... 104
Loading the Symbol Library ................................. 207
Loading the Trend Plot Graph ............................... 117
Loading Trend Set ............................................. 115
Locally saved pictures, downloading ..................... 40
Login ................................................................ 18
Logout ................................................................ 19

M
Macro keys ......................................................... 32
Macro-Start, Updating ......................................... 211
Make Connection ............................................... 15
Marker, Drawing ............................................... 176
Markers, Updating ............................................. 211
Marking a Graphic Figure .................................... 177
Marking all Figures ............................................. 181
<table>
<thead>
<tr>
<th>Marking Box</th>
<th>178</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marking OVC Cell Pairs</td>
<td>90</td>
</tr>
<tr>
<td>Marking Updating Channels</td>
<td>41</td>
</tr>
<tr>
<td>Marking WDC Cell Pairs</td>
<td>77</td>
</tr>
<tr>
<td>Marking with the &lt;Shift&gt; key</td>
<td>180</td>
</tr>
<tr>
<td>Maximum Connection Time</td>
<td>251</td>
</tr>
<tr>
<td>Maximum Wait Time</td>
<td>251</td>
</tr>
<tr>
<td>Message Files</td>
<td>218</td>
</tr>
<tr>
<td>Message Priority</td>
<td>218</td>
</tr>
<tr>
<td>Messages, Exiting</td>
<td>218</td>
</tr>
<tr>
<td>Messages, fault, system</td>
<td>275</td>
</tr>
<tr>
<td>Messages, Overview</td>
<td>27</td>
</tr>
<tr>
<td>Messages, Selecting</td>
<td>217</td>
</tr>
<tr>
<td>Metric Scale</td>
<td>134</td>
</tr>
<tr>
<td>Modem connection</td>
<td>16</td>
</tr>
<tr>
<td>Modem, Initialising</td>
<td>17</td>
</tr>
<tr>
<td>Modem-Connection, Configuring</td>
<td>248</td>
</tr>
<tr>
<td>Modification, Dataprocessing Graphs</td>
<td>134</td>
</tr>
<tr>
<td>Modify Times EXC BPS</td>
<td>97</td>
</tr>
<tr>
<td>Modify Times WDC BPS</td>
<td>84</td>
</tr>
<tr>
<td>Moving Graphic Figures</td>
<td>186</td>
</tr>
<tr>
<td>Moving, Picture Editor</td>
<td>193</td>
</tr>
<tr>
<td>MSGHIST.TXn</td>
<td>218</td>
</tr>
<tr>
<td>Multi-Symbol</td>
<td>204</td>
</tr>
</tbody>
</table>

**N**
- Name-assigning, Symbol | 203
- Navigation Destination Function | 155
- Navigation, Initiation | 155
- Navigation, Overview | 28
- Navigation, Preparation | 154
- Network | 231
- Neutral Character Set | 232
- Next Reaction Picture | 46
- Norwegian/Danish Character Set | 232
- Numbering, Symbol Library | 206

**O**
- Open Polygon, Drawing | 170
- Operating Time Change | 72
- Operations with Graphic Figures | 177
- Operator Name, Display | 210
- OS/2 Operation | 5
- OUTTEXT | 262
- Oval, Drawing | 171
- OVC, Call up | 86
- OVC, Conflicting Entries | 87
- OVC, Exiting | 88
- OVC PRV1, Editing Times | 93
- OVC PRV1 Times and Values, Change | 91
- OVC, Starting | 86
- OVC/EXC, Printing Table | 100
- Overview of Alarm Operation | 21
- Overview of Calendar | 26
- Overview of Dataprocessing | 24
- Overview of Dialogue | 25
- Overview of Functions | 33
- Overview of Messages | 27
- Overview of Navigation | 28
- Overview of Picture Display | 22
- Overview of Picture Editor | 158
- Overview of Pictures | 22
- Overview of Point Operation | 29
- Overview of Special Day Calendar | 26

**P**
- Parameter Display, Printing | 59
- Parameter Values Picture Display, changing | 43
- Partner direct configuration | 245
- Partner modem configuration | 249
- Password | 18
- Pasting Graphic Figures | 185
- PC Requirements | 222
- Period, Trend Plot | 124
- Picture, automatic loading | 236
- Picture compression, Picture Editor | 193
- Picture Copying, Picture Editor | 167
- Picture Display, Exiting, 37
- Picture Display, Overview | 22
- Picture Display, Printing | 49
- Picture Display, Starting | 36
- Picture Display, Zooming in | 48
- Picture Editor, Auxiliary tools | 191
- Picture Editor, Compression | 193
- Picture Editor, Deleting Screen | 168
- Picture Editor, Exiting | 159
- Picture Editor, Expansion | 193
- Picture Editor, Function Keys | 160
- Picture Editor, Moving | 193
- Picture Editor, Overview | 158
- Picture Editor, Picture Copying | 167
- Picture Editor, Picture Loading | 163
- Picture Editor, Picture Saving | 165
- Picture Editor, Printing | 168
- Picture Editor, Starting | 159
- Picture Editor, Zooming in | 192
- Picture Expansion, Picture Editor | 193
- Picture Loading, Picture Editor | 163
- Picture Moving, Picture Editor | 193
- Picture, Redrawing | 197
- Picture Saving, Picture Editor | 165
- Picture Selection by address | 37
- Picture Selection by number | 39
- Picture Size, Indicating | 196
- Plant description, picture display | 40a
- Plant description, picture editor | 168a
- Plant description protection | 168b
- Point Information, Alarm Operation | 150
- Point Information File, Create | 150
- Point Operation, Address Selection | 53
- Point Operation, Exiting | 52
- Point Operation, Fixed Mode | 54
- Point Operation, Free Mode | 54
- Point Operation, Overview | 29
- Point Operation Parameter, Changing | 56
- Point Operation, Printing | 59
- Point Operation, Starting | 52
- Point Operation, TRR Display | 58
- Point Setup, Trend Plot | 125
- Polygon, Drawing | 170
- Polyline Drawing | 170
- Port (direct), Configuring | 244
- Port for modem Configuration | 248
- Preparing for Navigation | 154
- Previous Reaction Picture | 46
- Print, Screen | 33

**Index**

Overview of Timeswitch Catalogue | 31
Overview of Trendplot | 30

CM2B8523E UNIGYR VISONIK Insight October 1995
Appendix:
Index

Print, Window ........................................... 33
Printer, Installing ..................................... 238
Printer Settings ......................................... 239
Printing a Picture Display .............................. 49
Printing Dataprocessing ................................. 136
Printing, OVC/EXC Table ............................... 100
Printing, Parameter Display ......................... 59
Printing, Picture Editor ................................ 168
Printing, Point Operation .............................. 59
Printing, Reaction Pictures ............................ 49
Printing, SDC ........................................... 100
Printing, Snapshot ...................................... 128
Printing the Alarm List ................................. 149
Printing, Timeswitch Catalogue ....................... 100
Printing, Trend Plot ................................... 128
Printing, TRR Display .................................. 59
Printing, WDC Table .................................... 100
PRV1 Default Values, Changing ..................... 91
PRV1 Destination, Defining ............................ 69
Q
Quitting Insight .......................................... 14
R
Reaction Pictures, Deleting .......................... 47
Reaction Pictures, Exiting ............................ 37
Reaction Pictures, Overview .......................... 22
Reaction Pictures, Printing ............................ 49
Reaction Pictures, Selecting ......................... 45
Reaction Pictures, Starting ......................... 36
Recording Messages .................................... 218
Recording the Dialogue ............................... 216
Recovery-Files .......................................... 169
Rectangle, Drawing ..................................... 171
Redrawing ................................................ 197
Requirements, Hardware .............................. 222
Requirements, Software ................................ 223
Rotating Graphic Figures ............................. 190
Rounded Rectangle, Drawing ......................... 171
Rubber Band Method ................................... 178
S
Sample Box .............................................. 191
Saving Dataprocessing Graphs ........................ 135
Saving Dataprocessing Table ......................... 137
Saving Picture Editor .................................. 165
Saving the Calendar .................................... 106
Saving the Symbol Library ............................ 207
Saving the Timeswitch Catalogue locally .......... 67
Saving the Trend Plot Export File ................... 118
Saving the Trend Plot Graph .......................... 117
Saving Timeswitch Catalogue DCS/SS ............... 66
Saving Trend Set ........................................ 116
Scale Lengths, Dataprocessing ...................... 134
Scales for Trend Plot, Indication ..................... 123
Screen, Clearing ........................................ 195
Screen Colour, Selecting ............................. 196
Screen, Deleting Picture Editor ..................... 168
Screen Printing ......................................... 33
Scrolling by number ................................... 40
Scrolling in a Symbol Library ....................... 200
Scrolling in the Picture Catalogue ................... 40
Scrolling the Calendar ................................ 108
SDC List ................................................ 109
SDC List, Jumping ...................................... 110
SDC, Printing .......................................... 100
Sector, Drawing ........................................ 174
Selecting locally saved pictures .................... 40
Selecting reaction pictures ........................... 45
Selecting the Colour Conversion ..................... 236
Selecting the Drawing Colour ....................... 183
Selecting the Line Width ............................. 182
Selecting the Screen Colour ......................... 196
Selecting the Warning beep ......................... 235
Selection, Alarm List ................................ 146
Selection by address ................................... 37
Selection by number ................................... 39
Selection of Destination ............................... 69
Sentinel .................................................. 222
Separating Graphic Figures ......................... 181
Setting the Warning Beep ............................. 235
Settings, Dataprocessing ............................. 138
Settings for Colour Conversion ...................... 236
Settings, Printer ....................................... 239
Settings, Trend Plot .................................... 124
Shrinking Graphic Figures ............................ 186
Snap Mode ............................................. 193
Snapshot of Trend Plot ................................ 110
Snapshot, Printing ...................................... 128
Software Requirements ............................... 223
Sorting, Alarm List .................................... 147
Special Day Calendar, Overview ..................... 26
Special Day Catalogue, Exiting ...................... 102
Special Day Catalogue, Starting ..................... 102
Special Day List ........................................ 109
Special Day List, Jumping ........................... 110
Special Days, Defining ............................... 108
Special Days, Deleting ............................... 108
Special keys ........................................... 3
Standard Calendars .................................... 103
Start, Macro, Updating ............................... 211
Start Navigation ........................................ 155
Starting Dataprocessing .............................. 130
Starting Insight ........................................ 14
Starting Picture Display ............................. 36
Starting Picture Editor ............................... 159
Starting Point Operation ............................. 52
Starting Reaction Pictures ........................... 36
Starting the Alarm Operation ....................... 142
Starting the Calendar ................................ 102
Starting the Dialogue ................................. 216
Starting the Installation Program ................... 229
Starting the Timeswitch Catalogue ................. 62
Starting the Translation Program .................... 257
Starting Trend Plot .................................... 114
Statistics, Alarm Operation ......................... 151
Status, Communication ............................... 252
STO ....................................................... 218
Stopping Trend Plot ................................... 121
Straight Line, Drawing ................................ 169
Superimposing Graphic Figures ..................... 182
Supplementary Texts, Display ....................... 210
Support Picture, Updating ............................ 211
Swedish/Finnish Character Set ...................... 232
Symbol Change, Updating ............................ 213
| Symbol, Changing                                      | 205 |
| Symbol Connection, Breaking                          | 205 |
| Symbol, Defining                                     | 201 |
| Symbol, Deleting                                     | 202 |
| Symbol Library                                       | 198 |
| Symbol Library, Changing                             | 200 |
| Symbol Library, Exiting                              | 200 |
| Symbol Library, Saving                               | 207 |
| Symbol Library, Numbering                            | 206 |
| Symbol Library, Saving                               | 207 |
| Symbol Library, Scrolling                            | 200 |
| Symbol, Multi-                                       | 204 |
| Symbol Name, Assigning                               | 203 |
| Symbol, Using                                        | 204 |
| SYS.INI                                              | 231 |
| System Graphs, Trend Plot                            | 118 |
| System messages                                      | 275 |
| System network                                       | 231 |

<table>
<thead>
<tr>
<th>T</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table, Dataprocessing</td>
<td>136</td>
</tr>
<tr>
<td>Table, Dataprocessing Font</td>
<td>137</td>
</tr>
<tr>
<td>Table-saving, Dataprocessing</td>
<td>137</td>
</tr>
<tr>
<td>Task Commands, Updating</td>
<td>211</td>
</tr>
<tr>
<td>Text Comparison Tool</td>
<td>261</td>
</tr>
<tr>
<td>Text Correction</td>
<td>256</td>
</tr>
<tr>
<td>Text Translation</td>
<td>256</td>
</tr>
<tr>
<td>Text Writing</td>
<td>172</td>
</tr>
<tr>
<td>Time Changes EXC BPS</td>
<td>97</td>
</tr>
<tr>
<td>Time Changes WDC BPS</td>
<td>84</td>
</tr>
<tr>
<td>Time Difference, OVC PRV1</td>
<td>93</td>
</tr>
<tr>
<td>Time Differences EXC BPS</td>
<td>97</td>
</tr>
<tr>
<td>Time Differences WDC BPS</td>
<td>84</td>
</tr>
<tr>
<td>Time Differences, WDC PRV1</td>
<td>81</td>
</tr>
<tr>
<td>Time Layout, OVC</td>
<td>89</td>
</tr>
<tr>
<td>Time Layout, WDC</td>
<td>76</td>
</tr>
<tr>
<td>Time Reaction Catalogue, Point Operation</td>
<td>58</td>
</tr>
<tr>
<td>Time Scale, Trend Plot</td>
<td>124</td>
</tr>
<tr>
<td>Times and Values, Change, OVC PRV1</td>
<td>91</td>
</tr>
<tr>
<td>Times and values Changes, EXC BPS</td>
<td>95</td>
</tr>
<tr>
<td>Times and values Changes, WDC BPS</td>
<td>82</td>
</tr>
<tr>
<td>Times and Values, WDC PRV1 Changing</td>
<td>79</td>
</tr>
<tr>
<td>Times, Changing for WDC PRV1</td>
<td>81</td>
</tr>
<tr>
<td>Times, Changing, OVC PRV1</td>
<td>93</td>
</tr>
<tr>
<td>Timeswitch Catalogue, Calendar</td>
<td>99</td>
</tr>
<tr>
<td>Timeswitch Catalogue, DCS/SS Saving</td>
<td>66</td>
</tr>
<tr>
<td>Timeswitch Catalogue, Downloading</td>
<td>63</td>
</tr>
<tr>
<td>Timeswitch Catalogue, Downloading locally</td>
<td>65</td>
</tr>
<tr>
<td>Timeswitch Catalogue, Exiting</td>
<td>62</td>
</tr>
<tr>
<td>Timeswitch Catalogue, Overview</td>
<td>31</td>
</tr>
<tr>
<td>Timeswitch Catalogue, Print</td>
<td>100</td>
</tr>
<tr>
<td>Timeswitch Catalogue, Saving locally</td>
<td>67</td>
</tr>
<tr>
<td>Timeswitch Catalogue, Starting</td>
<td>62</td>
</tr>
<tr>
<td>Timeswitch Catalogue, Zooming</td>
<td>69</td>
</tr>
<tr>
<td>Toolbar</td>
<td>13</td>
</tr>
<tr>
<td>Translation Program, Starting</td>
<td>257</td>
</tr>
<tr>
<td>Translation Tool</td>
<td>256</td>
</tr>
<tr>
<td>Trend Plot, Buffer Size</td>
<td>126</td>
</tr>
<tr>
<td>Trend Plot, Channel Definition</td>
<td>125</td>
</tr>
<tr>
<td>Trend Plot, Depiction</td>
<td>126</td>
</tr>
<tr>
<td>Trend Plot, Display Period</td>
<td>124</td>
</tr>
<tr>
<td>Trend Plot, Exiting</td>
<td>114</td>
</tr>
<tr>
<td>Trend Plot Export File, Saving</td>
<td>118</td>
</tr>
<tr>
<td>Trend Plot Graph, Loading</td>
<td>117</td>
</tr>
<tr>
<td>Trend Plot Graph, Saving</td>
<td>117</td>
</tr>
<tr>
<td>Trend Plot, Point Setup</td>
<td>125</td>
</tr>
<tr>
<td>Trend Plot, Printing</td>
<td>128</td>
</tr>
<tr>
<td>Trend Plot Scales, Indication</td>
<td>123</td>
</tr>
<tr>
<td>Trend Plot, Settings</td>
<td>124</td>
</tr>
<tr>
<td>Trend Plot, Snapshot</td>
<td>123</td>
</tr>
<tr>
<td>Trend Plot, Starting</td>
<td>114</td>
</tr>
<tr>
<td>Trend Plot System Graphs</td>
<td>118</td>
</tr>
<tr>
<td>Trend Plot, Time Scale</td>
<td>124</td>
</tr>
<tr>
<td>Trend Plot, zooming</td>
<td>122</td>
</tr>
<tr>
<td>Trend Set, Loading</td>
<td>115</td>
</tr>
<tr>
<td>Trend Set, Saving</td>
<td>116</td>
</tr>
<tr>
<td>Trendplot, Activating</td>
<td>121</td>
</tr>
<tr>
<td>Trendplot, Overview</td>
<td>30</td>
</tr>
<tr>
<td>Trendplot, Stopping</td>
<td>121</td>
</tr>
<tr>
<td>TRR Display, Point Operation</td>
<td>58</td>
</tr>
<tr>
<td>TRR Display, Printing</td>
<td>59</td>
</tr>
<tr>
<td>Type, BPS Destination</td>
<td>71</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>U</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Unhiding Graphic Figures</td>
<td>188</td>
</tr>
<tr>
<td>Unhiding Updating Channels</td>
<td>41</td>
</tr>
<tr>
<td>Uniting Graphic Figures</td>
<td>181</td>
</tr>
<tr>
<td>Updating, Alarm List</td>
<td>143</td>
</tr>
<tr>
<td>Updating Bars</td>
<td>211</td>
</tr>
<tr>
<td>Updating CB Task Commands</td>
<td>211</td>
</tr>
<tr>
<td>Updating Channel Display, Picture Editor</td>
<td>208</td>
</tr>
<tr>
<td>Updating Channel Number, Assigning</td>
<td>209</td>
</tr>
<tr>
<td>Updating Channels, activating</td>
<td>42</td>
</tr>
<tr>
<td>Updating Channels, marking</td>
<td>41</td>
</tr>
<tr>
<td>Updating Channels, Picture Editor</td>
<td>208</td>
</tr>
<tr>
<td>Updating Channels, unhiding</td>
<td>41</td>
</tr>
<tr>
<td>Updating, Colour</td>
<td>212</td>
</tr>
<tr>
<td>Updating Language-dependent Text</td>
<td>210</td>
</tr>
<tr>
<td>Updating Macro</td>
<td>211</td>
</tr>
<tr>
<td>Updating Markers</td>
<td>211</td>
</tr>
<tr>
<td>Updating Operator Name</td>
<td>210</td>
</tr>
<tr>
<td>Updating Supplementary Texts</td>
<td>210</td>
</tr>
<tr>
<td>Updating Support Picture</td>
<td>211</td>
</tr>
<tr>
<td>Updating the Symbol Change</td>
<td>213</td>
</tr>
<tr>
<td>UPDVMC</td>
<td>261</td>
</tr>
<tr>
<td>User Code</td>
<td>18</td>
</tr>
<tr>
<td>Using a Symbol</td>
<td>204</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>V</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>VISONIK network</td>
<td>231</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>W</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait Time, Maximum</td>
<td>251</td>
</tr>
<tr>
<td>Warning Beep, Setting</td>
<td>235</td>
</tr>
<tr>
<td>WDC BPS Modify Times</td>
<td>84</td>
</tr>
<tr>
<td>WDC BPS Times and values Change</td>
<td>82</td>
</tr>
<tr>
<td>WDC, call up</td>
<td>73</td>
</tr>
<tr>
<td>WDC, Conflicting entries</td>
<td>74</td>
</tr>
<tr>
<td>WDC Entries, Copying</td>
<td>85</td>
</tr>
<tr>
<td>WDC Entries, Delete</td>
<td>85</td>
</tr>
<tr>
<td>WDC, Exiting</td>
<td>74</td>
</tr>
<tr>
<td>WDC, Printing Table</td>
<td>100</td>
</tr>
<tr>
<td>WDC PRV1 Changing Times and Values</td>
<td>79</td>
</tr>
<tr>
<td>WDC PRV1 Editing Times</td>
<td>81</td>
</tr>
<tr>
<td>WDC, Start</td>
<td>73</td>
</tr>
<tr>
<td>White/Black Inversion</td>
<td>197</td>
</tr>
<tr>
<td>Window Printing</td>
<td>33</td>
</tr>
<tr>
<td>Writing a Text</td>
<td>172</td>
</tr>
</tbody>
</table>
Appendix: Index

Z
Zooming in a Picture Display . . . . . . . . . . . . . . . . . . . 48
Zooming in a Picture Editor . . . . . . . . . . . . . . . . . . 192
Zooming the Timeswitch Catalogue . . . . . . . . . . . . . 69
Zooming the Trend Plot . . . . . . . . . . . . . . . . . . . . . . 122